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CHAPTER 1

Introduction

This chapter includes the following topics:
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About this document
This product guide provides information and instructions for installing and configuring
EMC® Storage Integrator (ESI) for Windows Suite. It also provides information and
procedures for using ESI to provision and manage storage arrays.

The guide also provides instructions for setting up and configuring ESI system adapters,
ESI application adapters, replication adapters, ESI Service, the ESI Powershell Toolkit,
and the ESI Service PowerShell Toolkit.

Audience
ESI for Windows Suite is designed for Microsoft applications administrators who manage
storage and application provisioning and monitor storage health.

This software enables administrators to view, provision, and manage block and file
storage for Microsoft Windows, Microsoft Exchange, Microsoft SQL Server, and Microsoft
SharePoint sites on supported EMC storage systems. Microsoft System Center Operations
Manager (SCOM) integration with ESI provides administrators with a dashboard view of
storage entities to monitor health and performance.

Administrators can manage their environment using either the ESI graphical user
interface (GUI) or the PowerShell command line interface (CLI).

Scope
This document describes how to install, configure, and use EMC Storage Integrator for
Windows Suite.

Related documentation
The following EMC documents, available at EMC Online Support, contain additional
information about ESI and related products.

l EMC Storage Integrator for Windows Suite Release Notes provides the latest information
about new and changed features, known issues, and environment and system
requirements.

l EMC storage system documentation.

Product Overview
ESI for Windows Suite is a set of tools for Microsoft Windows and Microsoft applications
administrators. The suite includes: ESI for Windows and the ESI PowerShell Toolkit, ESI
hypervisor support and system adapters, application and replication adapters, ESI
Service and ESI Service PowerShell Toolkit, and ESI SCOM Management Packs.

ESI for Windows, ESI PowerShell Toolkit, and ESI system adapters
The ESI for Windows GUI is based on Microsoft Management Console (MMC). You can run
ESI as a stand-alone tool or as part of an MMC snap-in on a Windows computer.

ESI for Windows enables you to view, provision, and manage block storage for Microsoft
Windows, SQL Server, and SharePoint sites and to manage existing Exchange systems.

The ESI PowerShell Toolkit provides ESI storage provisioning and discovery capabilities
with corresponding PowerShell cmdlets.

Introduction
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Install the corresponding system adapters for specific system and application support.
The EMC Simple Support Matrix provides supported environment and software
requirements. Prerequisites for ESI system and adapters are listed in this product guide.

ESI supports the following products:

l EMC Unity™ and UnityVSA™

l EMC VMAX®, VMAX3™, and VMAX All Flash families

l EMC VNX® series

l EMC VNXe® series

l EMC VPLEX®

l EMC XtremIO®

l EMC AppSync®

l EMC RecoverPoint®

l Windows and Linux hosts

l ESX and Microsoft Hyper-V hypervisors

ESI hypervisor support
In addition to supporting physical environments, ESI supports storage provisioning and
discovery for Windows virtual machines that are running on Microsoft Hyper-V or VMware
vSphere. Install the corresponding adapters for specific hypervisor support.

Storage options in ESI vary depending on the hypervisor:

l For Hyper-V virtual machines, you can create virtual hard disk (VHD and VHDX) files
and pass-through SCSI disks. You can also create host disks and cluster shared
volumes.

l For vSphere ESXi virtual machines, you can create virtual machine disk (VMDK) files
and raw device mapping (RDM) disks without virtual compatibility mode. You can
also create SCSI disks and view datastores. SCSI disks require the use of existing
SCSI controllers.

ESI Service and ESI Service PowerShell Toolkit

ESI Service is the communications link between ESI and the ESI System Center
Operations Manager (SCOM) Management Packs. You can use ESI Service to view and
report on registered EMC storage systems and storage-system components that are
connected to the ESI host system. SCOM then pulls this data from ESI Service. You can
also use the ESI Service as a stand-alone tool without SCOM to collect, view, and report
this same system data.

When you install the ESI Service as part of the ESI installation, both the ESI Service and
the ESI Service PowerShell Toolkit are installed on the ESI host system. Use the
PowerShell Toolkit to set up the ESI Service to communicate with the storage systems
and ESI SCOM Management Packs.

ESI SCOM Management Packs
The ESI SCOM Management Packs enable you to manage EMC storage systems with
SCOM by providing consolidated and simplified dashboard views of storage entities.

The ESI SCOM Management Packs support the same EMC storage systems that ESI
supports.

The ESI SCOM Management Packs enable you to do the following:

Introduction
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l Discover and monitor the health status and health events of EMC storage systems
and system components in SCOM.

l Receive alerts in SCOM for possible problems with disk drives, power supplies,
storage pools, and other types of physical and logical components.

EMC Unity Adapter overview
The EMC Unity Adapter enables storage administrators to create, provision, and manage
Unity and UnityVSA storage with ESI. This adapter supports all Unity storage systems that
are supported in ESI.

You can use the ESI GUI to view Unity and UnityVSA storage systems as well as
consistency groups and unified snapshots.

You must use the ESI PowerShell Toolkit to:

l Create and delete consistency groups

l Manage, add, and remove LUNs in consistency groups

l Create and delete unified snapshots of LUNs in consistency groups

l Restore snapshots to LUNs in consistency groups

EMC VMAX Adapter overview
The EMC VMAX Adapter enables storage administrators to create, provision, and manage
VMAX storage with ESI. This VMAX adapter is based on the Solutions Enabler Storage
Management Initiative Specification (SMI-S) provider. This adapter:

l Supports all VMAX storage systems that are supported in ESI.

l Supports the VMAX3 service level objectives (SLO) feature.

l Replaces the EMC Symmetrix Adapter that was based on the Storage Pool Manager
(SPM) from previous versions.

Limitations
The EMC VMAX Adapter has the following limitations:

l Using FAST VP on page 37 lists the limitations associated with EMC Fully Automated
Storage Tiering for Virtual Pool (FAST® VP).

l Managing metas on page 37 lists the limitations associated with managing metas
or composite LUNs.

l This adapter cannot provision storage on host systems that are provisioned with
Virtualization Domains or with the Storage Pool Manager (SPM) from previous
releases of the ESI VMAX Adapter.

EMC VNX Adapter overview
The EMC VNX Adapter enables storage administrators to create, provision, and manage
VNX storage arrays with ESI. This adapter supports all VNX storage systems that are
supported in ESI.

You can view and manage advanced VNX snapshots in both the ESI GUI and ESI
PowerShell Toolkit.

Introduction
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EMC VNXe Adapter overview
The EMC VNXe Adapter enables storage administrators to create, provision, and manage
VNXe storage arrays with ESI. This adapter supports all VNXe storage systems that are
supported in ESI.

You can use the ESI GUI to view VNX1600 storage systems as well as VNXe3200 LUN
groups and unified snapshots.

You must use the ESI PowerShell Toolkit to:

l Create and delete LUN groups

l Manage, add, and remove LUNs in LUN groups

l Create and delete unified snapshots of LUNs in LUN groups

l Restore snapshots to LUNs in LUN groups

EMC VPLEX Adapter overview
The EMC VPLEX Adapter enables storage administrators to create, provision, and manage
VPLEX storage with ESI.

Use the ESI GUI to:

l View storage system components

l Manage virtual volumes

l Manage host disks and hypervisor disks

l Manage consistency groups

l Support Microsoft SQL Server 2016 and Microsoft SharePoint 2016

The EMC VPLEX Adapter enables you to use the ESI SCOM Management Packs and ESI
Service to monitor the operational status of VPLEX system components in SCOM. You can
use SCOM to monitor the health of both physical and logical VPLEX system components.
You can view the health of individual LUNs and if failures occur, the failures roll up to the
affected virtual volumes and corresponding VPLEX systems.

EMC XtremIO Adapter overview
The EMC XtremIO Adapter enables you to create, provision, and manage EMC XtremIO
storage systems with ESI.

This adapter enables:

l Support for XtremIO snapshots, snapshot sets, and consistency groups

l Support for setting host best practice settings for XtremIO

l Support for associating tags to XtremIO object types for easier management

l Support for managing and monitoring XtremIO clusters and arrays using IPv6

The ESI PowerShell Toolkit includes cmdlets specifically for XtremIO systems. For more
information, refer to Powershell cmdlet storage system operations on page 167.

EMC XtremIO Adapter considerations include:

l For XtremIO entities, ESI manages XtremIO volumes as LUNs and manages volume
mappings as masking views.

l You can view, but cannot modify, create, or delete XtremIO folders in ESI.

l You cannot provision XtremIO storage for Exchange applications in ESI.

Introduction
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l XtremIO systems do not use service nodes.

l XtremIO does not require host registration.

ESI SharePoint Adapter overview
Use the ESI SharePoint Adapter to perform the following functions with Microsoft
SharePoint farms:

l View SharePoint storage, farms, sites, and content databases

l Connect to existing SharePoint farms and enumerate farm information, including
servers, web applications, site collections, and content databases

l Create content databases and storage for the databases, and map content databases
to the storage

l Provision storage on the SharePoint server by partitioning, formatting, and assigning
it a drive letter, and provisioning the storage to the SharePoint site

l Support the File Stream Remote BLOB Store

l Create a web application and map it to a content database

l Provision a web application and the associated content database

Note

For provisioning SharePoint storage, ESI requires that SQL Server and SharePoint be
installed in the same Windows domain as the ESI host controller.

The ESI SharePoint adapter includes these limitations:

l SharePoint Foundation Client is not supported.

l Domain-based SharePoint farm deployment is supported; however, clustered and
stand-alone installations and web applications for remote farms are not supported.

Note

If you create a database without a web application on a remote farm, you cannot view
the new database in ESI.

ESI Exchange Adapter overview
ESI Exchange Adapter enables you to view Microsoft Exchange databases and map the
databases to EMC storage.

To add, view, and remove Exchange forests, use the ESI GUI or use the Exchange
cmdlets on page 175 in the ESI PowerShell Toolkit.

The ESI Exchange Adapter includes these limitations:

l The adapter does not support XtremIO storage systems.

l You can view, but cannot modify, create, delete, or provision Exchange storage in ESI.
Use the Exchange Management Tools for these tasks.

ESI Microsoft SQL Server Adapter overview
The ESI SQL Server Adapter enables you to view local and remote Microsoft SQL Server
instances and databases and to map the databases to EMC storage. ESI supports the
Always On feature in SQL Server 2012 and SQL Server 2014, so you can view the primary
SQL Server replica and up to four secondary replicas.

You can use SQL Scripts to create and configure SQL Server databases from an ESI host.

Introduction
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Supported versions
This adapter supports the following versions of SQL Server on Windows 2012 Server and
Windows 2012 R2 Server (full, 64-bit installations):

l SQL Server 2008 R2

l SQL Server 2012

l SQL Server 2012 SP1

l SQL Server 2014

ESI AppSync Adapter overview
The ESI AppSync Adapter enables simple, self-service application protection with tiered
protection options and proven recoverability. This adapter supports multiple SQL Server
instances on the same host.

With this adapter, perform the following tasks in ESI for supported SQL Server and
Exchange databases:

l View AppSync Application Server instances and databases, including database files,
copies, subscribed service plans, service plan events, registered storage, registered
hosts, and registered RecoverPoint systems.

l Subscribe and unsubscribe databases to AppSync service plans.

l Protect databases with AppSync service plans or protection policies.

l Mount and unmount database copies on VNX or RecoverPoint target hosts.

l Expire and restore database copies.

The ESI AppSync Adapter includes these limitations:

l SQL Server system databases are not supported.

l SQL Server database snapshots are not discovered.

ESI RecoverPoint Adapter overview
The ESI RecoverPoint Adapter provides local and remote data protection. If a disaster
occurs, RecoverPoint can recover lost data from any point in time. Use this adapter to
connect to existing RecoverPoint/SE or RecoverPoint/EX systems to manage and view
replication service clusters for replication.

Use the RecoverPoint Adapter to:

l Connect to existing RecoverPoint/SE or RecoverPoint/EX systems.

l Manage and view replication service clusters, which are groups of RecoverPoint sites
and appliances working together to perform replication for storage and applications
that are managed in ESI.

l Add RecoverPoint consistency groups, which are groups of one or more RecoverPoint
replica sets.

l Add replica copies, which can be either local or remote copies of a LUN.

l Add replica sets, which are a source LUN and the local and remote copies for that
LUN.

l Seamlessly provision journal and replica LUNs when creating replica copies and sets.

l View underlying storage details for volumes used by RecoverPoint.

Introduction
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CHAPTER 2

Installing ESI

This chapter includes the following topics:

l Installation overview............................................................................................. 18
l ESI system prerequisites....................................................................................... 19
l ESI system adapter prerequisites.......................................................................... 19
l ESI system adapter installation............................................................................. 22
l Performing a new installation of ESI...................................................................... 22
l Additional adapter setup.......................................................................................23
l Reinstalling ESI..................................................................................................... 23
l Upgrading from ESI version 3.x or later.................................................................. 24
l Uninstalling ESI.....................................................................................................24
l ESI home window..................................................................................................24
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Installation overview
For an ESI environment, you install ESI on the host system. You can then install ESI
adapters and the ESI Service and ESI SCOM Management Packs.

ESI installation files
The ESI Zip file includes:

l The EMC Storage Integrator for Windows Suite Release Notes.

l The ESI installer for the core ESI setup and other options.

l The ESI SCOM Management Packs installer—If you select to install the ESI Service,
the installer also installs the ESI Service PowerShell Toolkit.

ESI installation options
You can install ESI in one of the following ways:

l Installing ESI on page 22: New installation of ESI with all available options. During
the installation, you can select which adapters and other options are installed with
ESI. During the installation you can select to use Active Directory Domain Services (AD
DS) or Active Directory Lightweight Directory Services (AD LDS)  on page 28 for
persisting connection settings in a central store.

l Reinstalling ESI on page 23: Reinstallation of the same adapters and options as
selected during your last ESI installation.

l Upgrading from ESI version 3.1 or later on page 24: Upgrade to the latest version
from an earlier version of ESI.

Note

You must uninstall the previous version of ESI and then install the new version. 
Uninstalling ESI on page 24 provides information about uninstalling ESI.

ESI system adapter installation
To ensure that the ESI system adapters work correctly with ESI, ensure that your system
meets the prerequisites and perform additional setup.

l ESI system prerequisites on page 19

l ESI system adapter prerequisites on page 19

l Additional adapter setup on page 23

ESI Service and ESI SCOM Management Packs installation

l You can use and install the ESI Service and ESI SCOM Management Packs separately
or together with ESI. The following provide installation and setup instructions:

l Installing the ESI Service on page 136 and Setting up ESI Service for SCOM on page
136.

l Installing the ESI SCOM Management Packs on page 143 and Setting up ESI SCOM
Management Packs on page 144

Installing ESI
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ESI system prerequisites
For ESI 4.1 to function properly, ensure that your environment meets these minimum
system requirements.

Procedure

1. Install a supported version of .NET Framework on the ESI controller (the host on which
ESI runs).

2. Ensure that Windows Server is installed on the ESI controller (Windows Server Core
installations are not supported).

3. Ensure that a supported version of MMC is installed. Otherwise, the ESI installer
prompts you to upgrade before installing ESI. If MMC is not installed, download and
install it from the Microsoft website.

4. Enable the following firewall exceptions on the ESI controllers and ESI controllees
(hosts on which ESI provisions storage):

l Remote Volume Management-Virtual Disk Service (RPC) (vds.exe)

l Remote Volume Management-Virtual Disk Service Loader (RPC) (vdsldr.exe)

l Remote Volume Management (RPC-EPMAP) (svchost.exe)

l Windows Management Instrumentation

5. Ensure that Microsoft PowerShell is installed on all hosts. If PowerShell is not
installed, download and install it from the Microsoft website.

6. Enable the remote PowerShell on ESI controllee hosts by running the following
command on the controllee host: Enable-PSRemoting -force

7. If you use iSCSI or FC transport for SAN connectivity:

l Use the iSCSI initiator to log in to the storage systems.

l Configure zoning for the FC initiator and use that initiator to log in to the storage
system.

8. Install the latest version of EMC PowerPath or Microsoft Multipath I/O (MPIO) with the
Microsoft Device Specific Module (MSDSM) on the controllee host.

9. Ensure that ESI is installed and runs in a domain user login session with
administrative privileges for the controller host. The controller and controllee hosts
must be members of the same Windows domain or in trusted domains.

10. To use AD DS with ESI, confirm that Windows Server Active Directory is installed. To
use AD LDS, confirm an AD LDS instance is installed on the Windows Server.

ESI system adapter prerequisites
For ESI system adapters to function correctly with ESI, ensure your environment meets the
prerequisites.

Note

You can perform these prerequisites before or after you install ESI. However, they must be
in place before you start the ESI application or the ESI service.
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Table 1 System adapter prerequisites

Adapter Prerequisites

Unity Install the latest version of the EMC Unisphere® Unity Command Line Interface for
your specific environment on the ESI controller host. The latest versions of the
Unity CLIs are available for download on EMC Online Support.

VMAX l Download and install the latest applicable version of SMI-S that is available
for your VMAX model from EMC Online Support. Supported versions of
Enginuity and EMC Solutions Enabler for this release are listed in the EMC
Simple Support Matrix.

l Install and run SMI-S on a management server that is separate from all ESI
hosts and storage systems. The VMAX Adapter cannot provision storage on a
server that is running SMI-S.

l After installing the latest version of EMC SMI-S Provider, use VMAX to create
two or more gatekeeper devices and unmask the gatekeepers to the SMI-S
server that is hosting the SMI-S provider. Gatekeepers are required for
accessing and issuing management commands. EMC VMAX documentation
has more details.

l Refer to the EMC Simple Support Matrix to install a supported version of
Oracle Java SE Runtime Environment (JRE), which is required for VMAX3.

VNX Enable Access Logix on the storage array before connecting a host disk on a
Windows host.

VNXe Install the latest version of the EMC Unisphere VNXe CLI for your specific
environment on the ESI controller host. The latest versions of the VNXe CLIs are
available for download on EMC Online Support.

VPLEX l Ensure that a supported version of GeoSynchrony is installed on the VPLEX
systems. Supported software versions are listed in the EMC Simple Support
Matrix.

l This adapter uses the standard SSH network connection to communicate with
VPLEX. Confirm that the SSH port 443 is open on the ESI host. If it is not open,
the connection fails.

XtremIO l Requires a supported version of XtremIO.

l VMware-vSphere-CLI must be installed using the default installation path.

SharePoint Supported versions of the following are installed:

l Windows Server (Windows Server Core installations are not supported)

l SQL Server

l SharePoint Server or SharePoint Foundation

Exchange l A supported version of Microsoft Exchange is installed on the Exchange
servers.

l A full supported version of Windows Server is installed on the Exchange
servers. (Windows Server Core installations are not supported.)

l On each Exchange Server, the Internet Information Services (IIS) Manager for

Windows PowerShell must have PSLanguageMode set to FullLanguage in

the Application settings for Windows PowerShell.
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Table 1 System adapter prerequisites (continued)

Adapter Prerequisites

SQL Server l Ensure that your version of SQL Server is supported on your Windows version.

l ESI and SQL Server must be connected to the same domain controller and you
must have SQL Server Administrator login credentials.

Appsync l A supported version of EMC AppSync is installed on the Windows server.

l When installing the adapter as part of the ESI installation, you must use the
same service name and port information that you used when installing
Windows Server.

l Your system must meet the following to use this adapter with Exchange
databases:

n Your system meets the Exchange Adapter prerequisites.

n Mount and production hosts must have the same version of Windows
installed.

l Your system must meet the following to use this adapter with SQL Server
databases:

n Your system meets the SQL Server Adapter prerequisites.

n SQL Server databases and transaction logs must be stored on disks in the
same storage system.

n SQL Server databases must be online during replication.

n EMC recommends you use the same version of SQL Server on the
production and mount hosts.

n Mount hosts must have SQL Server installed to recover databases from
mounted copies.

RecoverPoint l A supported version of Windows Server is installed. (Windows Server Core
installations are not supported.)

l A supported version of EMC RecoverPoint/SE or EMC RecoverPoint/EX is
installed.

l System.net.http.formatting DLL is installed on the ESI host controller. When
you select to install the RecoverPoint Adapter as part of the ESI installation,
this DLL is installed for you.

l ESI RecoverPoint Adapter is installed on the ESI controller and a supported
version of EMC RecoverPoint/SE or RecoverPoint/EX and the applicable
splitters are set up for each supported EMC storage system.

EMC RecoverPoint Release Notes on EMC Online Support provide more details about
EMC RecoverPoint/SE and EMC RecoverPoint/EX.
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ESI system adapter installation
All ESI system adapters, other than the Unity and VNXe adapters, are installed by default
with ESI. For the Unity and VNXe Adapters, you must select to install them during the
installation of ESI.

If you changed the default during your installation of ESI or you did not select the Unity
and VNXe Adapters, then reinstall ESI and confirm that the adapters are selected in the
InstallShield Wizard Setup window.

Performing a new installation of ESI
Use these instructions if ESI has never been installed on your system.

Before you begin

Ensure that you have met all the requirements in ESI system prerequisites on page 19
and ESI system adapter prerequisites on page 19.

Procedure

1. Locate and double-click the latest version of ESI.4.*.Setup.exe.

2. In the ESI InstallShield Wizard, click Next.

3. Read and accept the EMC Software License Agreement, and then click Next.

4. In the Prerequisites window, confirm that your system meets the prerequisites, and
then click Next.

5. In the Setup window, confirm or change the options to install, and then click Next.

Note

Some options, such as the ESI Service, are not selected by default. In the main Setup
window or for each option, you can click Change to change the default installation
paths.

6. In the Publish Connection Information window, select a connection service, and then
click Next:

l Active Directory—Uses Active Directory to persist connection settings.

l Active Directory Lightweight Directory Service—Persists connection settings in a
central location. For this option, type the Service Name and Service Port for
connecting to the AD LDS instance.

l Local Server—Connection settings will be stored locally (same as earlier versions
of ESI). For example, MMC and PowerShell use the Windows user profile folder and
ESI Service uses SQLCE to persist settings locally.

7. Do one of the following:

l If you are not using Active Directory, skip to the next step.

l If you are using Active Directory, in the Configure Active Directory window, specify
the username and password of the Active Directory user account for ESI. The ESI
installer uses this account to configure Windows Active Directory for ESI. The ESI
username must include (that is, be qualified with) the domain name, as follows:
DOMAIN\Username.
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8. Click Install.

Note

If the installer detects that a later version of a redistributable file is already installed,
it will not install the earlier version that is included with ESI and will prompt you with
an error message that it failed. If you get this message, click Yes.

9. Click Finish.

10. If you are using Active Directory Services, you must configure AD DS or AD LDS for ESI
supported applications. For more details, see Setting up Directory Service integration
for ESI applications on page 28.

Note

The ESI installer attempts to add a firewall exception rule to enable Remote Volume
Management on the host where ESI is being installed. The installer also attempts to
enable the remote PowerShell (PS Remoting) on the same host. If the installer
encounters a problem during these steps, ESI instructs you to perform these steps
manually after the installation is complete.

Additional adapter setup
Most ESI system adapters require no additional setup for use with ESI.

However, the following ESI system adapters do require some additional setup.

Table 2 Adapter setup

Adapter Additional steps

AppSync 1. Install the AppSync Server and connect it to ESI.

2. Add the AppSync system as a replication service.

3. In the AppSync console, add all ESI supported applications
to AppSync Server, including Exchange database availability
groups (DAGs), SQL Server instances, SQL AlwaysOn
Availability Groups (AAGs), EMC storage systems, and EMC
RecoverPoint appliances.

RecoverPoint Use the instructions in the EMC RecoverPoint Release Notes,
available on EMC Online Support, to install and set up EMC
RecoverPoint/SE and EMC RecoverPoint/EX.

Reinstalling ESI
This procedure enables you to reinstall the current version of ESI to the same installation
path to repair the installation or modify the options that are installed.

Procedure

1. If you plan to select either of the Active Directory options to publish connection
information, remove all system connection settings before installing ESI:
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a. Remove all systems from ESI. Removing systems from ESI on page 34 provides
instructions.

b. Delete the following ESI settings file: system drive:\Users\user name
\AppData\Local\EMC\ESI\EMC Storage Integrator.settings.

2. Follow the instructions in Performing a new installation of ESI on page 22.

Upgrading from ESI version 3.x or later
Occasionally, upgrading to a newer version of ESI causes ESI to fail. If this happens,
uninstall the previous version of ESI, and then install the newer version.

Procedure

1. If you plan to select either of the Active Directory options to publish connection
information, you must remove all system connection settings before installing ESI as
follows:

a. If you are using ESI Service, unpublish all systems from the ESI Service. See 
Unpublishing systems on page 35.

b. Remove all systems from ESI. See Removing systems from ESI on page 34.

c. Delete the following ESI settings file: system drive:\Users\user name
\AppData\Local\EMC\ESI\EMC Storage Integrator.settings.

2. Follow the instructions in Performing a new installation of ESI on page 22.

Uninstalling ESI
In some cases, you must uninstall ESI before upgrading to a newer version.

Procedure

1. Close all ESI applications, including ESI and the ESI PowerShell Toolkits.

2. In Windows Control Panel, open Programs and Features.

3. Select the EMC Storage Integrator program and click Uninstall. If you are upgrading
from version 1.2, repeat this step until you remove all EMC Storage Integrator
adapters and programs from the list.

Note

The uninstaller does not remove either the local store file or the Active Directory user
container.

ESI home window
The main ESI GUI window provides a one-stop view of the storage systems, hosts, host
clusters, and applications added to ESI.

The ESI interface has three panes:

l The left pane is the navigation pane.

l The center pane shows the details of the items selected in the navigation pane.

l The right pane is the Actions pane, which lists the possible actions based on the
items selected in the navigation pane or the center pane.
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Customize view settings
To show or hide items in the ESI home window, select View > Customize from the menu
bar. The Customize view dialog box appears. Select or clear these check boxes to
customize your view.

Table 3 Customize view options

Check box View displayed if selected

Console tree Left navigation pane.

Standard menus (Action
and View)

Top menu bar: Action and View.

Standard toolbar Icons in the second row of the menu bar: Back and Forward
arrows, Up One Level in the Console Tree, Show/Hide Console
Tree, Help, and Show/Hide Action Pane.

Status bar Status bar at the bottom of the Home window.

Description bar Description at the top of a pane. For example, if a VMAX storage
system is selected, VMAX and the size and ID of the storage
system are displayed.

Taskpad navigation tabs ESI does not use MMC taskpad navigation tabs, so this
selection does not provide any additional choices.

Action pane Right Actions pane.

Menus ESI does not have additional menu views.

Toolbar ESI does not have additional toolbar views.

l To customize the center pane, such as to remove or add columns for a custom view,
right-click a column and select actions from the menu. By default, not all of the
information is displayed for some lists due to space limitations.

l A plus (+) or minus (-) symbol displayed next to a list item enables you to expand or
reduce the information displayed.

l Use your mouse to adjust column width sizes.
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CHAPTER 3

Setting up connections

This chapter includes the following topics:

l Setting up Directory Services integration for ESI applications................................ 28

Setting up connections     27



Setting up Directory Services integration for ESI applications
ESI can store connection settings locally or persist connection settings in a central
location by integrating with Microsoft Active Directory Domain Services (AD DS) or
Microsoft Active Directory Lightweight Directory Services (AD LDS). The Microsoft Active
Directory Services use the Lightweight Directory Access Protocol (LDAP) for both AD DS
and AD LDS. You can use AD DS or AD LDS for all supported applications and systems,
such as ESI, MMC, ESI Service, and SQL Server.

Microsoft TechNet provides instructions on how to install and set up AD DS and AD LDS.

Setting up AD DS
Before you begin

To use AD DS with ESI, confirm that Windows Server (2012 R2, 2012, or 2008 R2) Active
Directory is installed on the Domain Controller of the AD domain.
Procedure

1. Confirm that you selected Active Directory in the Publish Connection Information
window during the ESI installation.

2. Log in to the domain controller with domain administrator credentials.

3. Perform one of these procedures:

l Configuring Directory Services for ESI Service connections on page 29

l Configuring Directory Services for ESI, MMC, and PowerShell connections on page
29

Setting up AD LDS
Before you begin

To use AD LDS with ESI, confirm that Windows Server (2012 R2, 2012, or 2008 R2) Active
Directory is installed on the Domain Controller of the AD domain. Confirm that an AD LDS
instance is installed on the Windows Server.

Procedure

1. Log in to the domain controller with domain administrator credentials.

2. During the AD LDS installation, set up the following application directory partition for
ESI: DC=EMC, DC=Storage, DC=Integrator, DC-COM.

3. Confirm that you selected AD LDS in the Publish Connection Information window
during the ESI installation.

4. Confirm that the AD LDS instance schema has definitions for msDS-App-Configuration
and msDS-Settings. If not, extend the AD LDS schema to get them by generating an
LDIF file with ADSchemaAnalyzer.exe. Refer to Microsoft TechNet for instructions.

5. Perform one of these procedures:

l Configuring Directory Services for ESI Service connections on page 29

l Configuring Directory Services for ESI, MMC, and PowerShell connections on page
29
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Configuring AD DS and AD LDS for ESI Service connections
Procedure

1. Use ADSI Edit to create an ESI Service container in the ESI AD store. Use the name of
the computer that is running ESI Service, such as CN=ESIService1.

This new container enables ESI Service to store persistence settings in the ESI AD
store.

2. Perform one of these steps:

l If ESI Service is running on a remote computer, grant full control permissions to the
computer account.

l If the directory service and ESI Service are running on the same computer, grant
full control permissions to the network service account.

ESI Service runs as a network service.

Configuring AD DS and AD LDS for ESI, MMC, and PowerShell connections
Procedure

1. Use ADSI Edit (adsiedit.msc) to connect to the domain controller active directory
and create a container for this ESI store.

For example, for mydomain.corp.com, create CN=ESI Object Connection
Store,DC=mydomain, DC=corp, DC=com Distinguished Name.

2. Create a container in the ESI store container with the domain user name for each user.

For example, for User 1, create a CN=User1 Distinguished Name.

3. Grant full control permissions for the users that own the ESI AD store.
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CHAPTER 4

Managing storage systems

This chapter contains the following topics:

l Adding storage systems........................................................................................ 32
l Removing systems from ESI...................................................................................34
l Publishing connections......................................................................................... 34
l Using the PowerShell scripting tool....................................................................... 36
l Managing VMAX storage systems.......................................................................... 37
l Managing Block storage........................................................................................ 38
l Managing File storage........................................................................................... 53
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Adding storage systems
Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator > Storage Systems.

2. In the Actions pane, click Add Storage System.

3. In the Add System dialog box, specify the following for the storage system.

Option Description

System Type Type of storage system to add

Friendly Name Short name for the storage system that is unique across different
storage systems

Note

The credentials required for each storage system are different. Fields marked with an
asterisk (*) in the ESI UI are required. The following tables list the storage system
parameters for supported storage systems.

For Unity, VNXe, or VPLEX storage systems, specify the following.

Option Description

Username Username for the storage system.

Password Password for the storage system.

Management Server IP
Address

IP address for the storage system management server.

(VPLEX only) Port number The default port number is automatically set. If the field
is empty, you can leave it empty to use the default port.

For VNX-F or VNX-Block storage systems, specify the following.

Option Description

Username Username for the storage system.

Password Password for the storage system.

SPA's IP Address IP address of SP A.

SPB's IP Address IP address of SP B.

Port Number The default port number is automatically set. If the field is empty,
you can leave it empty to use the default port. For VNX-Block, this
is the control station port number.

For VMAX storage systems, specify the following.
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Note

In the System Type field, the VMAX selection represents the group of VMAX storage
systems supported with this release of ESI. Supported VMAX systems are listed in the 
EMC Simple Support Matrix.

Option Description

Array serial number Serial number of the array.

SMI provider host Hostname or IP address of the SMI-S provider.

SMI provider port IP port of the SMI-S provider. You can accept the
default port 5988 for HTTP or 5989 for HTTPS.

Use secured connection Use a secure connection to the SMI-S provider.

Use Windows Authentication Use Microsoft Windows authentication.

Username and Password The username and password for the SMI-S provider.
Not used and can be omitted.

Connection timeout
(seconds)

Time limit for a connection to connect to the SMI-S
provider.

Operation timeout (seconds) Time limit for an operation to be completed.

Ignore server certificate
name validation

Bypass security certificate name validation.

For XtremIO storage systems, specify the following.

Option Description

Username Username for the storage system.

Password Password for the storage system .

Array serial
number

Serial number of the array (optional)

l Specify the array serial number to add a specific cluster.

l Leave blank to add all clusters that belong to the XtremIO
Management Server.

XMS IP Address IP address of the XtremIO management server.

Port Number The default port number is automatically set. If the field is
empty, leave it empty to use the default port.

4. Click Test Connection to test the connection before adding it.

5. Click Add.

The storage system appears under Available Systems in the center pane.

6. For VPLEX systems only, select the VPLEX system, and in the Actions pane click
Connect.

The VplexClusters tab appears and shows the VPLEX cluster. Expand the VPLEX node
under Storage Systems and select a cluster to show information for that particular
VPLEX cluster.
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Removing systems from ESI
Use the Remove System action to remove storage systems, applications, appliances, and
other supported systems from ESI.

Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Storage Systems.

2. In the center pane, select the storage system.

3. In the Actions pane, click Remove System.

4. Click Yes.

Publishing connections
Use the Publish Connection option to reuse the parameters required to add storage
systems. This option enters the parameters automatically.

You can choose to publish storage system creation information to the following locations:

l Another User: Give a specified storage administrator or ESI user access to a specific
set of supported EMC storage systems and related EMC RecoverPoint replication
systems. Publish systems to a remote storage administrator.

l The ESI Service: Publish or register the supported storage systems so that the ESI
Service and the ESI SCOM Management Packs can discover and monitor them.

Note

Because the ESI Service does not monitor replication systems, they cannot be
published to the ESI Service.

Note

You can also use the Add-EmcSystem cmdlet in the ESI Service PowerShell Toolkit

to publish supported storage systems.

Publishing storage systems
Publish one or more systems to a specified ESI user or to the ESI service.

Before you begin

If you are publishing a storage system to the ESI Service, ensure that the ESI Service is
installed.

Procedure

1. In the left pane of the ESI window on the ESI host controller system, select EMC
Storage Integrator.

2. In the Actions pane, click Publish Connection.

3. In the Publish Connection Information dialog box, set the following parameters.

Option Description

Publish To Target Select Another User or ESI Service.
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Option Description

User If you selected Another User, type the username for access to the
published systems.

Password If you selected Another User, type a password for the specified
user.

Target Host If you selected ESI Service, type the IP address or name of the
host system that is running the extension or service.

Default Port If you selected ESI Service, clear to specify a different port
number.

Port If you selected ESI Service and cleared the Default Port check
box, type a new port number.

4. Click Refresh for a list of available systems.

5. In the Local – Storage and Replication Systems pane, select the systems that you
want to publish, and then click Add.

6. Click Publish to accept the list of systems to publish in the Target – Storage and
Replication Systems pane.

Note

This pane also lists systems that were previously published or registered with the ESI
Service by using the ESI Service PowerShell Toolkit, the ESI PowerShell Toolkit, or this
procedure.

After you finish

If you published storage systems to the ESI service, set up the security policy. See 
Viewing and setting up the security policy on page 141

Unpublishing storage systems
Unpublish or remove the connection information for selected systems from the ESI
Service.

Before upgrading ESI, you must unpublish all systems from the ESI Service. You can use
either:

l The Publish Connection action in the ESI GUI

l The Get-EmcSystem and Remove-EmcSystem cmdlets that are part of the ESI
Service PowerShell Toolkit

Note

You cannot unpublish a system from another user after publishing it with the Publish
Connection action or with the ESI PowerShell Toolkit. However, you can remove the
systems by running ESI under the user's session and removing the system with the ESI
Remove System action or the ESI PowerShell Toolkit.

Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Storage Systems.

2. In the Actions pane, click Publish Connection.

Managing storage systems

Unpublishing storage systems     35



3. In the Publish Connection Information dialog box, set the following for the Service.

Option Description

IP Address/Name Type the IP address or name of the host system that is running
the service.

Publish To Select ESI Service as the connection information for the systems.

Default Port Accept the default port or clear the checkbox to specify a
different port number.

Port If you clear the Default Port checkbox, type the port number for
the service.

4. Click Refresh for a list of published systems.

5. In the Target – Storage and Replication Systems pane, select the systems that you
want to unpublish, and then click Remove.

6. Click Publish to accept the list of systems to unpublish.

Note

This pane also lists systems that were previously published or registered with the ESI
Service by using the ESI Service PowerShell Toolkit or this procedure.

7. Click Close to close the dialog box.

Using the PowerShell scripting tool
Use the PowerShell scripting tool to manage VNX, VNXe, Unity, and XtremIO block and file
systems.

The PowerShell scripting tool enables you to create a partial PowerShell script that can be
modified to repeat an action using different parameters.

Procedure

1. Select the storage system or host, and select an action.

l For storage systems, select Create Shared Folder or Create Shared Folder Pool.

l For hosts, select Create Shared Folder, Create Disk, Disconnect Disk, or Delete
Disk. For Unity and XtremIO systems, you can also select Connect Disk.

Note

Use the create disk operation only for an online disk.

2. Continue through the wizard selecting the required parameters until the Review input
parameters screen appears.

3. Do one of the following:

l Select Script to clipboard to copy the partial script for pasting into PowerShell.

l Select Script to file to create a PowerShell file that you can save and modify.

4. Click Cancel to exit the wizard.

5. Paste the script into PowerShell and run the script.
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The disk or shared folder is created.

Managing VMAX storage systems
Creating thin pools
With the VMAX Adapter, ESI only supports provisioning disks from thin pools for VMAX
systems. Before creating, provisioning, and managing disks in ESI, you must create the
thin pools with other EMC tools, such as the EMC Solutions Enabler SYMCLI or Unisphere
for VMAX.

Creating and connecting disks
The VMAX Adapter enables you to use ESI to create disks for a VMAX host or cluster. You
can change the drive letter and the path after the disk is created. To provision a LUN for a
VMAX host or cluster, the VMAX system must be either locally connected to the host or to
the cluster member nodes.

Adding hosts on page 60 provides instructions for creating and connecting VMAX host
disks with ESI.

Using FAST VP
The ESI VMAX Adapter supports EMC Fully Automated Storage Tiering for Virtual Pool
(FAST

®
 VP) policies for the VMAX family. FAST VP is a VMAX feature that combines virtual

provisioning of thin pools with automated data movement between tiers, which is based
on performance measurements and user-defined policies.

Each FAST VP policy can contain different tiers, including FC tiers, SATA tiers, and so on. A
storage group represents a set of LUNs, storage volumes, or devices that you can apply to
a FAST VP policy.

Use the ESI PowerShell FAST VP cmdlets to do the following tasks:

l Add and remove FAST VP policies to storage groups.

l Manage and remove storage groups.

l Add LUNs to and remove LUNs from storage groups.

ESI has the following limitations for FAST VP and VMAX systems:

l You must create storage pools, FAST VP policies, and tiers with other EMC tools, such
as the EMC Solutions Enabler SYMCLI or Unisphere for VMAX.

l If LUNs in a storage group are not bound to at least one pool that is part of the policy
tier, you cannot associate a FAST VP policy to the storage group.

l You cannot rebind LUNs to different storage pools for FAST VP.

Managing metas
The VMAX Adapter enables you to use ESI to expand and extend existing LUNs into metas
and create new metas or meta volumes for a VMAX host or cluster. Metas are combined
storage devices that can be grouped together to create a larger meta.

Metas represent meta volumes, composite LUNs, metadevices, meta LUNs, composite
volumes, and metaheads. Meta members represent meta volume members, constituent
LUNs, and composite LUN members.

To create and manage metas, use the ESI PowerShell Toolkit meta cmdlets.

ESI has the following limitations for expanding LUNs into metas and for creating and
managing metas:

Managing storage systems

Managing VMAX storage systems     37



l Expanding a bound stripe meta volume results in the creation of a Business
Continuity Volume (BCV), which has the same meta configuration to preserve data.
During the expansion, the system creates a mirror relationship between the meta and
the BCV, which means the meta and the BCV contain the same data. After the
expansion, the storage system detaches the BCV from the meta and by default, ESI
does not delete the device. You can manually delete the devices with EMC tools, such
as EMC Solutions Enabler SYMCLI or Unisphere for VMAX, to manage disk space.

l The Expand-EmcLun cmdlet expands meta volumes, but does not expand thin meta
LUNs.

l You cannot expand meta volumes that involve a clone, remote data facility (RDF), or
snap session. However, you can expand existing bound  LUNs by forming new metas
with the New-EmcCompositeLun cmdlet.

l You cannot compress or shrink meta volumes.

Managing Block storage

Creating LUNs
Procedure

1. In the left pane of the ESI window, select the storage system.

2. In the Actions pane, click Create LUN.

The Create LUN wizard appears.

3. Select a storage pool, and then click Next.

4. On the New LUN page, set details for the new LUN or LUNs, and then click Next.

Option Description

LUN Count Number of LUNs to be created

Sequence Number First number to append to the name for the first LUN.
Note: For example, to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and
type 15 in the Sequence Number field.

Name Name of the LUN or LUNs

Description Description of the LUN or LUNs

Size Size and unit of measurement for each LUN

Service Node Storage processor that hosts the LUN or LUNs

Provision Type Select either Thick or Thin

Stop provisioning new
LUNs when error occurs

Stop creating new LUNs if an error occurs during the
process

5. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Results

The new LUN or LUNs appear in the LUNs list for the specific storage system.

Viewing LUNs
View LUNs or the initiators to which each LUN is unmasked.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click LUNs in the center pane.

3. Select the LUN from the list.

4. Click the plus (+) symbol to expand the LUN and view the initiators to which the LUN is
unmasked.

Expanding LUNs
For VMAX3 and VNX block systems, expand both thin and thick pool LUNs with the ESI
GUI. ESI supports expanding LUNs connected to a RAID group with the Managing metas
cmdlets in the ESI PowerShell Toolkit.

Note

You cannot expand LUNs (volumes) for XtremIO storage systems in ESI.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click LUNs in the center pane.

3. Select the LUN that you want to expand.

4. In the Actions pane, click Expand LUN

The Expand LUN wizard appears.

5. On the New LUN Capacity page, type an increased capacity for the LUN and select a
unit of measurement.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.
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Results

The expanded storage capacity is listed for the LUN in the LUNs tab.

Deleting LUNs
Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click LUNs in the center pane, and then select one or more LUNs to delete from the
list.

Note

To select multiple LUNs, press and hold Ctrl and click the LUNs to delete. Each LUN is
highlighted as it is selected.

3. In the Actions pane, click Delete LUN.

The Delete LUN wizard appears.

4. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing LUN groups
Use the ESI GUI to view LUN groups for VNXe3200 systems only.

For each LUN group, you can view total capacity, total current allocation, thin provisioning
setting, member LUNs, snapshots, hosts with LUN access, and hosts with snapshot
access.

Procedure

1. In the left pane of the ESI window, select a VNXe3200 system.

2. Click LUN Groups in the center pane.

3. Select a LUN group from the list.

4. Click the plus (+) symbol to expand and view group details.

Creating volumes
In ESI, volumes are LUNs. The Create LUN wizard enables you to create the new volumes
as LUNs.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. In the Actions pane, click Create Volume.

The Create LUN wizard appears.
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3. Select a storage pool, and then click Next.

4. On the New LUN page, set details for the new volume or volumes, and then click Next.

Option Description

LUN Count Number of LUNs (volumes) to be created

Sequence Number First number to append to the name for the first LUN (XtremIO
volume).
Note: For example, to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and type
15 in the Sequence Number field.

Name Name of the volume or volumes

Description Description of the volume or volume group or select Not
Applicable if no description is required

Size Size and unit of measurement for each volume

Service Node
(grayed out)

Not applicable for XtremIO volumes

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The new volume or volumes appear in the Volumes tab for the selected XtremIO
storage system.

Viewing XtremIO volumes
Use the ESI GUI to view volume storage information for XtremIO systems. The Volumes
tab includes volume name and ID, user (total) capacity, available capacity, parity type of
XtremIO data protection (XDP), provision type, parent storage pool, Network Address
Authority (NAA, required bits in the World Wide Name), and host name and IP address.

Procedure

1. In the left pane of the ESI window, select the XtremIO storage system.

2. Click Volumes in the center pane.

3. Select a volume from the list.

4. Click the plus (+) symbol to expand the volume and view the initiators to which the
volume is unmasked.

Deleting volumes
Procedure

1. In the left pane of the ESI window, select the XtremIO storage system.

2. Click Volumes in the center pane, and then select one or more volumes to delete from
the list.
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Note

To select multiple volumes, press and hold Ctrl and click the volumes to delete. Each
volume is highlighted as it is selected.

3. In the Actions pane, click Delete Volume.

The Delete LUN wizard appears.

4. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing masked LUNs and XtremIO volumes
View masked LUNs and masked XtremIO volumes in the ESI GUI for supported EMC
storage systems. Masked LUNs and XtremIO volumes are provisioned and managed as
logical storage system components in ESI.

Note

You must use the ESI PowerShell Toolkit to mask and unmask LUNs with ESI. For details,
refer to Set-EmcLunAccess in Powershell cmdlet storage system operations on page 167.

How you view masked LUNs depends on the type of storage system.

Note

You can also view masked LUNs with the ESI PowerShell Toolkit. Get-
EmcLunMaskingView in Powershell cmdlet storage system operations on page 167
provides details.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. In the center pane, select the appropriate tab for your storage system:

Option Description

VNX-Block Use the Storage Groups tab.

VMAX and VNXe3200 Use the LUN Masking Views tab.

XtremIO Use the Masking Views tab.

The masked LUNs or volumes are displayed.
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Creating snapshots
Create snapshots from the ESI GUI for VMAX3, VNXe, Unity, and UnityVSA systems.

Procedure

1. In the left pane of the ESI window, select a storage system.

2. Click LUNs in the center pane.

3. Select the LUN for which you want to create a snapshot.

4. Under Actions, click Create Snapshot.

The Create Snapshot wizard appears.

5. In the New Snapshot page, type a name for the new snapshot.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The snapshot is visible in the Snapshots tab.

7. (Optional) For VMAX systems, create a child snapshot from a snapshot that you
created from the LUN.

a. Click the Snapshots tab and select the snapshot.

b. Go to step 4 and repeat the procedure.

Creating XtremIO snapshots
Create snapshots of XtremIO volumes, XtremIO consistency groups, and other XtremIO
snapshots.

Procedure

1. In the left pane of the ESI window, select the storage system and select Volumes,
Snapshots or Consistency Groups.

2. Under Actions, click Create Snapshot.

Note

You can also use the right-click menu to create snapshots.

The Create Snapshot wizard opens.

3. Type a snapshot name and snapshot suffix, and select Read only or Writable for the
snapshot type, and then click Next.

4. On the View Tags page, from the list of available tags, select tags to add to the
snapshot and then click Next.

5. Click Next to continue through the wizard, and then click Finish.
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Note

Click More Information for more progress details. If a problem occurs while you are
creating a LUN, an error message appears along with options to resume or roll back
the process. After the error is resolved, click Resume to resume the process. Click
Rollback to revert to the previously executed step.

The new snapshot appears in the Snapshots list for the specified XtremIO storage
system.

Viewing snapshots
View snapshots from the ESI GUI for VMAX3, VNXe, Unity, UnityVSA, and XtremIO
systems.

The Snapshots tab includes all the Snapshots for the storage system.

Procedure

1. In the left pane of the ESI window, select a storage system.

2. Click Snapshots in the center pane.

3. Select a snapshot from the list.

4. Click the plus (+) symbol to expand for more details.

Deleting snapshots
Delete snapshots for VMAX3, VNXe, XtremIO, Unity, and UnityVSA systems.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Snapshots in the center pane.

3. Select the snapshot to be deleted.

Hold down the Ctrl key to select more than one snapshot.

Note

If the snapshot is a parent snapshot, you must delete the child snapshots before you
can delete the parent snapshot.

4. In the Actions pane, click Delete Snapshot.

The Delete Snapshot wizard appears.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Results

The snapshot is deleted and is no longer listed in the Snapshots tab.
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Refreshing a volume, consistency group, or snapshot set from an XtremIO snapshot
Restores or refreshes a volume, consistency group, or snapshot set from a point-in-time
snapshot.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Select Volumes, Consistency Groups, or Snapshots in the center pane.

3. In the Actions pane, click the refresh operation that you want to perform.

For consistency groups, you can also refresh from a snapshot tag.

The wizard opens and displays all valid snapshots.

4. Select the snapshot to refresh from and click Next.

5. Continue through the wizard, clicking Next and Finish.

If a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Restoring a LUN from a VMAX3 snapshot

Procedure

1. In the left pane of the ESI window, select a VMAX3 storage system.

2. Click Snapshots in the center pane.

3. Select a snapshot of the LUN that you want to restore.

4. In the Actions pane, click Restore Source from Snapshot.

The Restore Source from Snapshot wizard appears.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing snapshot LUNs
Procedure

1. In the ESI window, select the storage system with the snapshot LUN.

2. Click LUNs from the center pane to display a list of snapshot LUNs.

3. Click the plus (+) symbol to view LUN details.
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Note

l ESI does not support creating snapshot LUNs from the ESI GUI, but you can create
them using the ESI PowerShell toolkit. Getting started with the ESI PowerShell
toolkits on page 160 provides more details. You can then view and delete
snapshot LUNs in the ESI GUI.

l You cannot view or manage snapshot LUNs for VMAX or VMAX3 systems in the ESI
GUI. You can manage VMAX (but not VMAX3) snapshot LUNs using the PowerShell
Toolkit.

l For a block storage system, when you create snapshot LUNs, ESI adds a new
snapshot LUNs storage pool to the Storage Pool tab. This pool groups and
presents all the snapshot LUNs created for that storage system in that special
storage pool. This pool is only a group and is not an actual storage pool. Viewing
storage pools on page 49 provides details about storage pools.

Deleting snapshot LUNs
Procedure

1. In the ESI window, select the storage system with the snapshot LUN.

2. Click LUNs from the center pane and select one or more snapshot LUNs from the list to
delete.

Note

To select multiple snapshot LUNs, press and hold Ctrl and select each snapshot LUN.
Each snapshot LUN is highlighted as it is selected.

3. In the Actions pane, click Delete LUN.

The Delete LUN wizard appears.

4. Click Yes when prompted for confirmation.

5. Click Next to continue through the wizard, and then click Finish.

Note

Click More Information for more progress details. If a problem occurs while you are
creating a LUN, an error message appears along with options to resume or roll back
the process. After the error is resolved, click Resume to resume the process. Click
Rollback to revert to the previously executed step.

Managing XtremIO tags
Use tags to assign named identifiers to any XtremIO object type within a cluster. The Tags
column is displayed in all views, which enables enhanced object filtering and isolation
capabilities for improved management and monitoring of XtremIO clusters.

You can create, modify, and delete tags using the Actions panel or by right-clicking an
object to show the context menu.
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Procedure

1. Select the Tags tab to show the existing tags.

l To create a tag, in the Actions panel, click Create Tags, type a name for the tag and
select the Entity Type.

l To modify a tag, select the tag, click Modify Tags, and type a new name for the tag.

l To delete a tag, select the tag, click Delete Tags.

2. Click Next to continue through the wizard, and then click Finish.

Managing XtremIO object types with tags
Add tags to XtermIO object types to enable enhanced filtering using the Tags column. You
can add tags to volumes, consistency groups, snapshots, snapshot sets, initiator groups,
initiators, and schedulers.

Before you begin

Create tags as described in Managing XtremIO tags on page 46.

Procedure

1. Right-click an object type and select Manage tags.

2. Do one of the following:

l To add tags to the selected object type, select the tag or tags to be added.

l To remove tags from the selected object type, clear the tag or tags to be removed.

3. Click Next to continue through the wizard, and then click Finish.

Creating consistency groups
Use the ESI GUI to create consistency groups for VPLEX and XtremIO systems.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Consistency Groups in the center pane.

3. In the Actions pane, click Create Consistency Group.

The Create New Consistency Group wizard appears.

4. Add a name for the consistency group and then click Next. If you are creating a
consistency group for:

l An XtremIO system, go to the next step.

l A VPLEX system, go to step 7.

5. On the View Tags page, choose an available tag.

6. In Add Volumes to Consistency Group page, choose all available volumes that can be
tagged to the consistency group.

7. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

After you finish

For VPLEX systems, add volumes to the consistency group, as described in Managing
volumes in a VPLEX consistency group on page 48.

Managing volumes in a VPLEX consistency group
Use the ESI GUI to add VPLEX volumes to or remove VPLEX volumes from an existing
consistency group.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Consistency Groups in the center pane.

3. Select the consistency group to which you want to add a volume or from which you
want to delete a volume.

4. In the Actions pane, click either:

l Add Volume

l Remove Volume

Depending on your selection, either the Add Volume to Consistency Group wizard or
Remove Volume From Consistency Group appears.

5. Select the volumes that you want to add to or remove from the consistency group.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing consistency groups
Use the ESI GUI to view consistency groups for Unity and VPLEX systems.

You can view:

l For each Unity consistency group, the total capacity, total current allocation, thin
provisioning setting, member LUNs, snapshots, hosts with LUN access, and hosts
with snapshot access

l For each VPLEX consistency group, the consistency group name, number of volumes,
visibility, and the storage at which cluster.

Procedure

1. In the left pane of the ESI window, select a Unity or a VPLEX system.
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2. Click Consistency Groups in the center pane.

3. Select a consistency group from the list.

4. Click the plus (+) symbol to expand and view group details.

Viewing registered hosts
Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Registered Hosts in the center pane. The registered hosts are listed.

3. Click the plus (+) symbol to expand the registered host information.

Viewing service nodes for block storage systems
Each LUN is assigned an active service node. Service nodes can have multiple ports that
can be either Fibre Channel (FC) or iSCSI.

Note

l For VPLEX systems, only FC ports are supported.

l XtremIO systems do not use service nodes.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Service Nodes in the center pane.

3. Click the plus (+) symbol to expand the storage processor (SP) A or SP B list.

4. Click Fibre Channel Target Ports to view the FC target ports for each SP.

5. Click iSCSI Target Ports to view iSCSI target ports for each SP.

Viewing storage pools
You can view the storage pools for a selected storage system, the LUNs (XtremIO
volumes) in each storage pool, and the initiators to which each LUN is unmasked.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Storage Pools in the center pane.

3. Select a storage pool from the list.

4. Click the plus (+) symbol to expand the storage pool and view the LUNs in that storage
pool.

5. Click the plus (+) symbol next to a LUN to view the initiators to which that LUN is
unmasked.

Note

When you create snapshot LUNs for block storage systems, ESI adds a new storage
pool for snapshot LUNs to the Storage Pools tab. This pool lists all snapshot LUNs
created for that storage system. This pool is only a list and not an actual storage pool.
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Note

Because XtremIO does not use storage pools, the entire XtremIO system is listed as a
single storage pool in the Storage Pools tab.

Viewing VPLEX storage views

Procedure

1. In the left pane of the ESI window, select a VPLEX storage system.

2. Select a cluster.

3. Click Storage Views in the center pane.

The list provides information about the LUNs, host initiators, and hosts associated
with the cluster.

Creating VPLEX virtual volumes
The Create Virtual Volume wizard enables you to create VPLEX virtual volumes.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Virtual Volumes in the center pane.

3. In the Actions pane, click Create Virtual Volume.

The Create Virtual Volume wizard appears.

4. On the Virtual Volume Settings page, choose the settings for the virtual volume, and
then click Next.

Option Description

Virtual Volume Name Name of the virtual volume to be created.

Create Distributed
Volume

Creates a distributed volume. If enabled, the wizard
displays additional pages to provide target cluster details.

Source cluster Select the source cluster from the list box.

Create New Storage
Volume

(Optional) Creates a new storage volume in the underlying
storage array. If not selected, existing storage volumes are
listed in a subsequent step.

5. On the Storage System page, select the storage array associated with the selected
source cluster and then click Next.

6. On the Storage Pool page, select the storage pool and then click Next.

There is only one global storage pool.

7. Perform one of these steps:

l If you enabled Create New Storage on the Virtual Volume Settings page, on the
New LUN page, set the required parameters and then click Next.

l Otherwise, on the LUN page, select a storage volume (LUN) from the list of existing
storage volumes and then click Next.

8. On the LUN Masking Settings page, choose the initiator ports from the list of initiator
ports of the VPLEX source cluster, and then click Next.
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All the initiator ports are selected by default.

9. If you enabled Create Distributed Volume on the Virtual Volume Settings page, repeat
step 5 through step 8 to provide the target cluster details.

10. Click Next to continue through the wizard, and then click Finish.

Note

Click More Information for more progress details. If a problem occurs while you are
creating a LUN, an error message appears along with options to resume or roll back
the process. After the error is resolved, click Resume to resume the process. Click
Rollback to revert to the previously executed step.

The new virtual volume appears in the list on the Virtual Volumes tab.

Viewing VPLEX clusters and virtual volumes

Procedure

1. In the left pane of the ESI window, select the VPLEX storage system.

2. Select a cluster.

3. Click Virtual Volumes in the center pane.

The list shows the details of the virtual volumes for the selected cluster.

Deleting VPLEX virtual volumes
Delete a single or multiple VPLEX virtual volumes from a cluster.

Procedure

1. In the left pane of the ESI window, select the VPLEX storage system and then select a
cluster.

2. On the Virtual Volumes tab, select one or more volumes to delete from the list.

3. In the Actions pane, click Delete Virtual Volume.

The Delete Virtual Volume wizard appears.

4. Continue through the wizard, clicking Next and Finish.

If a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The virtual volume is deleted from the list on the Virtual Volumes tab.

Viewing VPLEX initiators

Procedure

1. In the left pane of the ESI window, select the VPLEX storage system.

2. Select a cluster.

3. Click Initiators in the center pane.
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Registering and unregistering VPLEX initiators

Procedure

1. In the left pane of the ESI window, select the VPLEX storage system and then select a
cluster.

2. Click Initiators in the center pane.

The list of initiators indicates whether initiators are registered or unregistered with the
VPLEX system.

3. Select an initiator from the list.

4. In the Actions pane, click either:

l Register to register an unregistered initiator.

l Unregister to unregister a registered initiator.

Depending on your selection, either the Register Initiator wizard or the Unregister
Initiator wizard appears.

5. Continue through the wizards, clicking Next and Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Results

The list on the Initiators tab is updated accordingly.

Viewing XtremIO initiator groups
View details about initiator groups for XtremIO storage systems in ESI. The Initiator
Groups tab includes the initiator group names and host bus adapter (HBA) IDs for each
group.

Procedure

1. In the left pane of the ESI window, select an XtremIO storage system.

2. Click Initiator Groups in the center pane.

3. Select an initiator group from the list.

4. Click the plus (+) symbol to expand for more details, such as the HBA ID.

Viewing XtremIO storage controllers
You can view details about storage controllers for XtremIO storage systems in ESI. The
Storage Controllers tab provides details about the FC and iSCSI target ports, such as
iSCSI qualified name (IQN) or World Wide Name (WWN), IP address, availability, storage
controller ID, and link status.

Procedure

1. In the left pane of the ESI window, select an XtremIO storage system.

2. Click Storage Controllers in the center pane.

Managing storage systems

52 EMC Storage Integrator for Windows Suite 4.1  Product Guide



3. Select a storage controller from the list.

4. Click the plus (+) symbol to expand the controller data and view specifics for FC and
iSCSI target ports.

Creating and editing XtremIO schedules
Schedules determine when snapshots or consistency groups are created and how long
they are retained.

You can create, view, and edit schedules for XtremIO volumes and consistency groups.
Use this procedure to create schedules. To edit existing schedules, right-click the
schedule, select Modify, and complete the wizard as described below.

Procedure

1. In the left pane of the ESI GUI, select the storage system for which you want to create a
schedule.

2. In the center pane, select the Volumes tab to display the available volumes or the
Consistency Group tab to display the available consistency groups.

3. In the Actions pane, click Create Scheduler.

4. In the wizard, provide the parameters for the new scheduler and click Next.

The options are as follows:

Option Description

Scheduler State Enable or Disable

Scheduler Type Explicit (a specific time and date) or Interval (the time between
snapshot or consistency group creation). Depending on which type
you select, configure the times or intervals.

Keep Last Number to keep

Keep for Length of time

Suffix Type a suffix for the snapshot.

Type Writable or Read-only

5. Continue through the wizard and click Finish.

Results

The new schedule is listed in the Schedules tab.

Managing File storage

Creating shared folders
You can create one or more shared folders for file storage systems.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. In the Actions pane, click Create Shared Folder.

Managing storage systems

Creating and editing XtremIO schedules     53



The Create Shared Folder wizard appears.

4. Select a file storage pool and click Next.

5. Continue through the wizard, setting parameters and clicking Next.

Note

Click More Information for more progress details. If a problem occurs while you are
creating a shared folder, an error message appears along with options to resume or
roll back the process. After the error is resolved, click Resume to resume the process.
Click Rollback to revert to the previously executed step.

The fields and descriptions are as follows:

Option Description

Shared Folder Count Number of shared folders to create

Sequence Number The first number to append to the name for the first folder.
For example, to create three folders with the appended
numbers 15, 16, and 17, type 3 in the Shared Folder Count
field and type 15 in the Sequence Number field.

Name Name of the shared folder or folders

Path Path to the shared folder or folders

Capacity Size and unit of measurement for each folder

Service Node Service node for the folder or folders

Provision Type Select Thick or Thin

Stop provisioning new
shared folders when
error occurs

Stops creating new folders if an error occurs during the
process

6. Click Finish.

Results

The new shared folder or folders appear under Shared Folders.

Viewing shared folders
Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. Click Shared Folders in the center pane.

The shared folders are listed.

Mounting shared folders

Procedure

1. Select the shared folder to mount and click Mount shared folder.

2. Provide the information required in the wizard, clicking Next and Finish.
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3. Log off and log on to see the results of the operation.

Results

The shared folder is mounted on the selected host.

Deleting shared folders
Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. Click Shared Folders in the center pane and select one or more shared folders from
the list.

4. In the Actions pane, click Delete Shared Folder.

The Delete Shared Folder wizard appears.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Unmounting shared folders

Procedure

1. Select Network Disks tab and select the mounted folder.

2. Click Unmount Shared Folder and continue through the wizard.

3. Log off and log on to see the results of the operation.

Creating shared folder pools
A shared folder pool is a container for shared folders. Grouping shared folders into a
shared folder pool enables you to view and access folders from one place.

Before you begin

Create shared folders.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. In the Actions pane, click Create Shared Folder Pool.

The Create Shared Folder Pool wizard appears.

4. Select a file storage pool, and then click Next.

5. Continue through the wizard, typing the required parameters and clicking Next.

Managing storage systems

Deleting shared folders     55



Note

Click More Information for more progress details. If a problem occurs while you are
creating a shared folder pool, an error message appears along with options to resume
or roll back the process. After the error is resolved, click Resume to resume the
process. Click Rollback to revert to the previously executed step.

6. Click Finish.

Results

The new shared folder pool appears under Shared Folder Pools.

Viewing shared folder pools
Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. Click Shared Folder Pools in the center pane, and then select the shared folder pool
from the list.

4. Click the plus (+) symbol to expand the shared folder pool and view the shared
folders.

Extending shared folder pools
After creating a shared folder pool, you can extend or enlarge the size of the pool. The
new size must be larger than the current size of the pool.

Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. In the Actions pane, click Extend Shared Folder Pool.

4. In the Extend Shared Folder Pool wizard, select a file storage pool, and then click
Next.

5. Under Shared Folder Pool Setting, confirm the pool name, type a new larger size, and
select the disk size measurement unit (MB, GB, or TB).

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Deleting shared folder pools
Procedure

1. In the left pane of the ESI window, select the storage system.
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2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. Click Shared Folder Pools in the center pane, and then select one or more shared
folder pools from the list.

4. In the Actions pane, click Delete Shared Folder Pool.

The Delete Shared Folder Pool wizard appears.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing file system service nodes
Procedure

1. In the left pane of the ESI window, select the storage system.

2. For storage systems that support both block and file protocols, select File View from
the Switch View list box in the center pane.

3. In the center pane, click Service Nodes.

4. Click the plus (+) symbol to expand for more details.
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CHAPTER 5

Managing hosts

This chapter contains the following topics:

l Adding hosts.........................................................................................................60
l Viewing registered hosts....................................................................................... 61
l Removing hosts.....................................................................................................61
l Applying host best practices................................................................................. 61
l Viewing SAN initiators........................................................................................... 61
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Adding hosts
ESI requires that you add all supported systems as hosts before you can view or manage
these systems in ESI.

Adding Windows system hosts
Procedure

1. In the left pane of the ESI window, click Hosts.

2. In the Actions pane, click Add Windows System or Add Host.

3. In the Add Host dialog box, specify the following.

Option Description

IP address/Name IP address or name of the host

Username and Password Username and password for the host

Note

Instead of entering a username and password, you can select Use current Windows
credentials.

4. Click Test Connection to test the connection.

5. Click Add.

The host appears in the center pane.

Adding Linux system hosts
Procedure

1. In the left pane of the ESI window, click Hosts.

2. In the Actions pane, click Add Linux System.

3. In the Add Linux Host dialog box, specify the following.

Option Description

IP address/Name IP address or name of the host

Port Confirm the default value of 22.
Note: If you change this, the connection will fail.

Authentication Type Select Password to use your Linux password for
authentication.
Or select Key-based to use your Linux encryption key.

Password:
Username and Password

Username and password for the host

Key based:

l Username

Username for your Linux encryption key.

Browse for or type the path for the key.
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Option Description

l Filepath

l Passphrase

Type the pass phrase for the key.

4. Click Test Connection to test the connection.

5. Click Add.

The host appears in the center pane.

Viewing registered hosts
Procedure

1. In the left pane of the ESI window, select the storage system.

2. Click Registered Hosts in the center pane. The registered hosts are listed.

3. Click the plus (+) symbol to expand the registered host information.

Removing hosts
Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Hosts.

2. Select the host from the center pane.

3. In the Actions pane, click Remove System.

4. Click Yes to confirm that you want to remove the host.

Applying host best practices
This procedure applies to hosts for XtremIO arrays.

Procedure

1. In the left pane of the ESI GUI, select the host.

2. In the Actions pane, click Apply Host Best Practice.

3. In the wizard, select HBA queue depth=256, if required.

4. Continue through the wizard clicking Next and Finish.

Viewing SAN initiators
Procedure

1. In the left pane of the ESI window, select Hosts.

2. Select the host from the center pane.

3. Click SAN Initiators.

The SAN initiator details are listed.
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CHAPTER 6

Managing host disks

This section contains the following topics.

l Changing a host disk drive letter or path............................................................... 64
l Connecting disks to a host.................................................................................... 64
l Creating host disks................................................................................................65
l Viewing host disks................................................................................................ 67
l Expanding host disks............................................................................................ 67
l Deleting host disks................................................................................................68
l Disconnecting disks from a host............................................................................68
l Creating pass-through SCSI disks..........................................................................69
l Connecting pass-through SCSI disks to a host.......................................................70
l Creating raw device mapping disks....................................................................... 71
l Connecting raw device mapping disks to a host.................................................... 73
l Creating SCSI disks............................................................................................... 74
l Connecting SCSI disks to a host............................................................................ 75
l Creating virtual disks.............................................................................................76
l Connecting virtual disks to a host..........................................................................78
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Changing a host disk drive letter or path
Procedure

1. In the left pane of the ESI window, select the host.

2. Click Host Disks in the center pane.

3. Select a disk from the list.

4. In the Actions pane, click Change Drive Letter and Paths.

The Change Drive Letter and Paths wizard appears.

5. Select the drive letter or mount point.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Results

The drive letter or mount path is changed.

Connecting disks to a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Click Host Disks in the center pane.

3. Select a disk from the list.

4. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears

5. On the Storage System page, select the storage system, and then click Next.

The page that appears next depends on the type of system.

6. On the Storage Pool page, select the storage pool, and then click Next

7. Perform one of these steps, depending on the system:

l On the LUN page, select one or more LUNs, and then click Next.

l For VPLEX systems, on the Select a Virtual Volume page, select one or more virtual
volumes and then click Next.

8. On the LUN Masking Settings page, select the initiators and then click Next.

9. In the Review Input Parameters page, do one of the following:

l For Unity and XtremIO systems:

n Click Script To Clipboard to copy the partial script for pasting into PowerShell.

n Click Script To File to create a PowerShell file that you can save and modify.
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l Review the settings.

10. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Creating host disks
If the host is a virtual machine hosted on a hypervisor, review the notes in Creating disks
for virtual machines on page 86 before creating virtual disks for virtual machines. The
hypervisor must appear in the Hypervisors section of the ESI main window and a
hypervisor host must be added after the hypervisor is connected and listed in the
Hypervisors section or the disk creation will fail.

Note

When creating host disks on XtremIO arrays, follow the recommendations in the Create
Disk wizard to align with XtremIO best practices.

Procedure

1. In the left pane of the ESI window, select the host.

2. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

3. Select the storage system, and then click Next.

l If you selected a VPLEX system, go to the next step.

l Otherwise, go to Step 7 on page 65.

4. On the Virtual Volume Settings page, choose the settings for the virtual volume, and
then click Next.

Option Description

Virtual Volume Name Name of the virtual volume to be created.

Create Distributed
Volume

Creates a distributed volume. If enabled, the wizard
displays additional pages to provide target cluster details

Source cluster Select the source cluster from the list box.

Create New Storage
Volume

(Optional) Creates a new storage volume in the underlying
storage array. If not selected, existing storage volumes are
listed in a subsequent step.

5. On the LUN Masking Settings page, select the initiators and click Next.

6. Select the storage system, and then click Next.

7. On the Storage Pool page, select a storage pool, and then click Next.

8. On the New LUN page, set the following details for one or more new LUNs, and then
click Next.
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The fields on the page depend on the selected system.

Option Description

LUN Count Number of disks to be created

Sequence Number First number to append to the name for the first LUN
Note: For example,  to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and
type 15 in the Sequence Number field.

Name Name of the disk or disks

Description Description for the disk or disks

Size Size and unit of measurement for each disk

Service Node Storage processor that hosts the disk or disks

Provision Type Select either Thick or Thin

Stop provisioning new
LUNS when error
occurs

Stops creating new folders if an error occurs during the
process.

9. For VPLEX systems, select the initiators and click Next.

10. On the Disk Preparation Settings page, set details for the disk or disks, and then click
Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

Volume Size Disk volume size

File System For MBR partitions:

l NTFS (New Technology File System)

l For Linux only, Ext2, Ext3, or Ext4

For GPT partitions: NTFS is the only available option

Allocation Unit Size Size of the allocation unit measured in bytes

Volume Label Label for the volume

Drive Letter or Mount
Path

Drive letter or a mount path for the disk or disks
Note: For Linux, Mount Path is the only available option

11. Continue through the wizard, clicking Next and then Finish.

For XtremIO systems, on the Review Input Parameters page, you have the option to
select:

l Script To Clipboard to copy the partial script for pasting into PowerShell.

l Script To File to create a PowerShell file that you can save and modify.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The disk or disks appear in the list of Host Disks for the specific host and in the LUNs
list under Storage Systems.

Viewing host disks
Procedure

1. In the left pane of the ESI window, select Hosts. The list of available hosts appears in
the center pane.

2. Select a host from the list.

3. Click Host Disks. The list of host disks is displayed.

4. Click the plus (+) symbol to expand the host disk information.

Expanding host disks
With ESI, you can expand host disks that meet the following criteria:

l The disk has only one volume. The volume can be expanded if the host is connected.

l The disk has an associated LUN that can either be expanded or is a file-based disk
which is supported by VMware.

Note

With VMware systems, ESI does not support expanding RDM disks that are attached
with virtual compatibility mode.

Procedure

1. In the left pane of the ESI window, select the host.

2. In the center pane, click Host Disk, and then select a disk from the list.

3. From the menu bar, select Action > Expand Disk.

4. On the New Disk Capacity page, type the new capacity for the disk, select a unit of
measurement, and then click Next.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The expanded storage capacity for the disk will display in the Host Disks tab.
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Deleting host disks
Procedure

1. In the left pane of the ESI window, select the host.

2. In the center pane, click Host Disks, and then select the disk or disks to delete.

Note

Hold down the Ctrl key to select multiple disks.

3. In the Actions pane, click Delete Disk.

The Delete Host Disk wizard appears.

4. Click Next to continue through the wizard, and then click Finish.

For XtremIO systems, on the Review Input Parameters page, you have the option to
select:

l Script To Clipboard to copy the partial script for pasting into PowerShell.

l Script To File to create a PowerShell file that you can save and modify.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Disconnecting disks from a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Click Host Disks in the center pane, and then select the host disk from the list.

3. In the Actions pane, click Disconnect Disk.

The Disconnect Host Disk wizard appears.

4. Click Next to continue through the wizard, and then click Finish.

For XtermIO systems, in the Review Input Parameters page, you have the option to
select:

l Script To Clipboard to copy the partial script for pasting into PowerShell.

l Script To File to create a PowerShell file that you can save and modify.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Creating pass-through SCSI disks
If the selected hypervisor supports pass-through SCSI disks, then selecting Passthrough
SCSI is an option when you are creating a disk for a virtual machine. See Creating raw
device mapping disks on page 71 if the hypervisor supports a raw device mapping disk
instead.

Procedure

1. In the left pane of the ESI window, select the host.

2. Select the host disk from the center pane.

3. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

4. Select Passthrough SCSI Disk as the disk type, and then click Next.

5. On the Storage System page, select the storage system, and then click Next.

6. On the Storage Pool page, select the storage pool, and then click Next.

7. On the New LUN page, set the following details for the disk or disks, and then click
Next.

Option Description

LUN Count Number of disks to be created

Sequence Number First number to append to the name for the first LUN
Note: For example, to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and type
15 in the Sequence Number field.

Name Name of the disk or disks

Description Description for the disk or disks

Size Size and unit of measurement for each disk

Service Node Storage processor that hosts the disk or disks

Provision Type Select either Thick or Thin

8. On the LUN Masking Settings page, select the initiators and click Next.

9. On the Hypervisor Settings page, select the SCSI controller and SCSI controller
location settings, and then click Next.

Note

For hypervisors, ESI does not support creating SCSI controllers. However, ESI uses
existing SCSI controllers to create disks for virtual machines.
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10. On the Disk Preparations Settings page, set the following values for the disk or disks,
and then click Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

File System Partition Type of MBR or GPT is NTFS as the only available
choice

Allocation Unit Size Size of the allocation unit measured in bytes

Volume Label Label for the volume

Drive letter or mount
path

Drive letter or a mount path for the disk or disks

11. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Results

The disk or disks appear in the list of Host Disks for the specific host and in the LUNs list
under Storage Systems.

Connecting pass-through SCSI disks to a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Select the host disk from the center pane.

3. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears.

4. On the Select Disk Type page, select Passthrough SCSI Disk, and then click Next.

5. On the Hypervisor Settings page, select the controller and location settings, and then
click Next.

6. On the Passthrough SCSI Disk page, select the candidate disk, and then click Next.

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.
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Creating raw device mapping disks
If the hypervisor supports raw device mapping (RDM) disks, the RDM is an available
option when you are creating disks for a virtual machine. See Creating pass-through SCSI
disks on page 69 if the hypervisor uses pass-through SCSI disks instead.

Note

With VMware systems, ESI does not support expanding RDM disks that are attached with
virtual compatibility mode.

Procedure

1. In the left pane of the ESI window, select the host.

2. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

3. Select Raw Device Mapping as the disk type, and then click Next.

4. On the Storage System page, select the storage system, and then click Next.

5. On the Storage Pool page, select the storage pool, and then click Next.

6. On the New LUN page, set the following details for the new disk or disks, and then
click Next.

Option Description

LUN Count Number of disks to be created

Sequence Number First number to append to the name for the first LUN
Note: For example,  to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and
type 15 in the Sequence Number field.

Name Name of the disk or disks

Description Description for the disk or disks

Size Size and unit of measurement for each disk

Service Node Storage processor that hosts the disk or disks

Provision Type Select either Thick or Thin

Stop provisioning new
LUNs when error
occurs

Stops creating new LUNs if an error occurs during the
process

7. On the LUN Masking Settings page, select the initiators and click Next.

8. On the Hypervisor Settings page, set the following field values, and then click Next.

Note

For hypervisors, ESI does not support creating SCSI controllers. However, ESI uses
existing SCSI controllers to create disks for virtual machines.
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Option Description

Controller SCSI controller

Location SCSI controller location

RDM
Compatibility
Mode

The type of compatibility (physical or virtual)
Note: If you select Physical in the RDM Compatibility Mode field,
the guest operating system can access the hardware directly.

Persistence Types include:

l Persistent: Changes are immediately and permanently written
to the disks.

l Independent Persistent: Independent disks are not affected
by snapshots.

l Independent Non Persistent: Changes to disks are discarded
when you shut down your system or revert to the snapshot.

Note

With Physical mode, Persistent is the only available option.

Disk
Provisioning

Options if you create a virtual disk:

l Thick Provision Eager Zeroed: All disk space is allocated and
any previous content is deleted when the disk is created; this
option might take longer than the other two options.

l Thick Provision Lazy Zeroed: All disk space is allocated but
existing content is not deleted when the disk is created.

l Thin Provision: Allocates only the disk space that is currently
needed.

9. On the Disk Preparations Settings page, set the following field values for the disk or
disks, and then click Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

Volume Size Disk volume size

File System Partition Type of MBR or GPT is NTFS as the only available
choice

Allocation Unit Size Size of the allocation unit measured in bytes

Volume Label Label for the volume

Drive letter or mount path Drive letter or a mount path to the disk

10. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The disk appears in the list of Host Disks for the specific host and in the LUNs list
under Storage Systems.

Connecting raw device mapping disks to a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Select the host disk from the center pane.

3. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears.

4. On the Select Disk Type page, select the disk type of Raw Device Mapping, and then
click Next.

5. On the VMware vSphere Settings page, set the following field values, and then click
Next:

Note

For hypervisors, ESI does not support creating SCSI controllers. However, ESI uses
existing SCSI controllers to create disks for virtual machines.

Option Description

Controller SCSI controller

Location SCSI controller location

RDM
Compatibility
Mode

Type of compatibility (physical or virtual)

Note

In physical mode, the guest operating system can access the
hardware directly.

Persistence Types include:

l Persistent: Changes are immediately and permanently written
to the disks.

l Independent Persistent: Independent disks are not affected
by snapshots.

l Independent Non Persistent: Changes to disks are discarded
when you shut down your system or revert to the snapshot.
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Option Description

Note

In Physical mode, Persistent is the only available option.

Disk
Provisioning

Select one of the following options if you are creating a virtual
disk:

l Thick Provision Eager Zeroed: All disk space is allocated and
any previous content is deleted when the disk is created; this
option may take longer than the other two options.

l Thick Provision Lazy Zeroed: All disk space is allocated but
existing content is not deleted when the disk is created.

l Thin Provision: Allocates only the disk space that is currently
needed.

6. On the Passthrough SCSI Disk page, select the candidate disk, and then click Next.

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Creating SCSI disks

Note

The SCSI disk option is not available for VMAX storage systems when provisioning
storage to virtual machines.

Procedure

1. In the left pane of the ESI window, select the host.

2. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

3. Select SCSI Disk as the disk type, and then click Next.

4. On the Storage System page, verify the information, and then click Next.

5. On the Storage Pool page, select the storage pool, and then click Next.

6. On the New LUN page, set the following details for the new disk or disks, and then
click Next.

Option Description

Name Name of the disk or disks

Description Description for the disk or disks
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Option Description

Size Size and unit of measurement for each disk

Service Node Storage processor that hosts the disk or disks

Provision Type Select either Thick or Thin

7. On the Disk Preparation Settings page, set the following details for the disk or disks,
and then click Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

Volume Size Disk volume size in MB

File System Partition Type of MBR or GPT is NTFS by default

Allocation Unit Size Size of the allocation unit measured in bytes

Volume Label Label for the volume

Drive letter or mount path Drive letter or a mount path for the disk or disks

8. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The disk or disks appear in the list of Host Disks for the specific host and in the LUNs
list under Storage Systems.

Connecting SCSI disks to a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Select the host disk from the center pane.

3. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears.

4. On the Select Disk Type page, select SCSI Disk, and then click Next.

5. On the Storage System page, review the details, and then click Next.

6. On the Storage Pool page, select a storage pool, and then click Next.

7. On the LUN page, select a LUN, and then click Next.

8. On the LUN Masking Settings page, review the settings, and then click Next.

9. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.
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10. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

11. On the Summary page, click Finish.

Creating virtual disks
You can use ESI to create additional virtual disks for a virtual machine.

Before you begin

You must add the host before creating virtual disks. Before this option is available, the
hypervisor that hosts the virtual machine must appear in the Hypervisors section on the
main ESI windows and the virtual machine must be listed in the Hosts section. When you
select the virtual machine in the Hosts section, the Hypervisor and Hypervisor type
appear at the top of the center pane (gray information area). If these do not appear, the
virtual machine might have been discovered before the hypervisor. If so, remove the
virtual machine and add it again as a host.

Procedure

1. In the left pane of the ESI window, select the host.

The host has to be a virtual machine that correctly identifies the hypervisor.

2. Select the host disk from the center pane.

3. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

4. Perform one of the following steps:

l For Unity systems, select Virtual Disk as the disk type and then click Next

l For all other systems, select Virtual Hard Disk as the disk type and then click Next.

5. On the Create File-based Disk page, set the following details and then click Next.

Option Description

File Name Name of the file, including the file extension of VHD, VHDX, or
VMDK.

Size Size of the file in GB.

File-based Disk
Type

Select either Fixed or Dynamic (not available for Unity
systems).

Location Location of the virtual hard disk. For Unity systems, the
location of the virtual volumes (VVols) datastore.
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Note

The page that appears next depends on the type of host that you select:

l The Hypervisor Settings page appears if you selected a hypervisor host.

l The VMware vSphere Settings page appears if you selected a VMware vSphere
host.

6. On either the Hypervisor Settings or VMware vSphere Settings page, set the following
details, and then click Next.

Option Description

Controller Hypervisor or VMware controller

Location SCSI controller location

Persistence (VMware
Settings page only)

Types include:

l Persistent: Changes are immediately and permanently
written to the disks

l Independent Persistent: Independent disks are not
affected by snapshots

l Independent Non Persistent: Changes to disks are
discarded when you shut down your system or revert to
the snapshot

Disk Provisioning
(VMware Settings page
only)

Select either Thick or Thin

7. Depending on the hypervisor, the Disk Preparation Settings page might appear. If the
page appears and the disk does not require these values, skip this step. If the disk
requires one or more of the values, set the applicable details, and then click Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

File System NTFS is the default.

Allocation Unit Size Size of the allocation unit measured in bytes

Volume Label Label for the volume

Drive letter or mount
path

Drive letter or a mount path to the disk
Note: If you enter a drive letter and folder path that does not
exist, ESI will create the specified folder path, and then
create the disk.

8. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Connecting virtual disks to a host
Procedure

1. In the left pane of the ESI window, select the host.

2. Select the host disk from the center pane.

3. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears.

4. On the Select Disk Type page, select Virtual Disk, and then click Next.

5. On the Virtual Hard Disk page, type the File Path, or browse to select it, and then click
Next.

6. On the Hypervisor Settings page, select the controller and location settings, and then
click Next.

7. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

8. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

9. On the Summary page, click Finish.
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CHAPTER 7

Managing host clusters

This chapter contains the following topics:

l Adding host clusters............................................................................................. 80
l Viewing host clusters and nodes........................................................................... 80
l Removing clusters from a host...............................................................................81
l Creating cluster disks............................................................................................81
l Connecting cluster disks to a host cluster..............................................................82
l Connecting cluster nodes to a host........................................................................83
l Disconnecting cluster disks from a host cluster..................................................... 83
l Deleting cluster disks from a host cluster.............................................................. 83
l Changing a cluster disk drive letter or path............................................................84
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Adding host clusters
Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or a host cluster.

l If you selected EMC Storage Integrator, click Add Host Cluster in the Actions pane.

l If you selected Host Clusters, click Add Cluster System in the Actions pane.

2. In the Add Cluster dialog box, specify the following for the cluster.

Option Description

IP address/Name IP address or name of the cluster

Username/Password Username and password for the cluster

Note

Alternatively, click Use current Windows credentials.

3. Click Test Connection to test the connection before adding it.

4. Click Add.

The cluster appears in the Available Systems list.

Viewing host clusters and nodes
You can view cluster disks, cluster nodes, and SAN initiators of a host cluster.

Procedure

1. In the left pane of the ESI window, select Host Clusters.

2. Select the host cluster.

3. Click Cluster Disks from the center pane.

The cluster disks are listed.

4. Click the following tabs in the center pane to view host cluster details:

l Cluster Disks

l Cluster Nodes

l SAN Initiators

5. Click the plus (+) symbols to expand the host cluster information.

Note

Click Connect to Host in the Actions pane or click the host node to connect to the
host. This host must be added to ESI. If not, ESI prompts you to add the host.
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Removing clusters from a host
Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Host Clusters.

2. Select one or more clusters from the center pane.

Note

Hold down the Ctrl key to select multiple clusters.

3. In the Actions pane, click Remove System.

4. Click Yes to confirm your selection.

Creating cluster disks
Procedure

1. In the left pane of the ESI window, select the host cluster.

2. In the Actions pane, click Create Cluster Disk.

The Create Cluster Disk wizard appears.

3. In the Storage System list box, select a storage system, and then click Next.

4. On the Storage Pool page, select a storage pool, and then click Next.

5. On the New LUN page, set the following values for the new disk or disks, and then
click Next.

Option Description

LUN Count Number of disks to be created

Sequence
Number

First number to append to the name for the first disk
Note: For example, to create three LUNs with the appended
numbers 15, 16, and 17, type 3 in the LUN Count field and type
15 in the Sequence Number field.

Name Name of the disk or disks

Description Description of the disk or disks

Size Size and unit of measurement for each disk

Service Node Storage processor that hosts the disk or disks

Provision Type Select either Thick or Thin
Note: The Thin option is not available if the selected pool does
not support thin LUNs.

Application The type of application, such as Generic Storage.
Note: This field appears only if a Unity or VNXe storage system is
selected.

6. For VMAX3 systems only, on the LUN Masking Settings page, select the initiators.

7. On the Cluster Parameters page, select one of the following, and then click Next:
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l Cluster Group and the name of a cluster group

l Cluster Shared Volumes for a shared disk

8. On the Disk Preparation Settings page, set the following values, and then click Next.

Option Description

Partition Type Type of partition to be created, either MBR (Master Boot
Record) or GPT (GUID Partition Table)

File System Partition Type of MBR or GPT is NTFS by default.

Allocation Unit Size Size of the allocation unit in bytes

Volume Label Label for the volume

Drive letter or mount path Drive letter or mount path for the disk

9. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The cluster disk or disks appear in the Cluster Disks list for the specified cluster.

Connecting cluster disks to a host cluster
Procedure

1. In the left pane of the ESI window, select the host cluster.

2. In the Actions pane, click Connect Cluster Disk.

The Connect Cluster Disk wizard appears.

3. In the Storage System list box, select a storage system, and then click Next.

4. On the Storage Pool page, select a storage pool, and then click Next.

5. On the LUN page, select a LUN from the storage pool, and then click Next.

6. On the Cluster Parameters page, select one of the following, and then click Next:

l Cluster Group and the name of a cluster group

l Cluster Group and the name of a cluster group

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.
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Connecting cluster nodes to a host
Procedure

1. In the left pane of the ESI window, select the host cluster.

2. Click Cluster Nodes from the center pane.

3. Select a cluster node from the list.

4. In the Actions pane, click Connect.

Disconnecting cluster disks from a host cluster
Procedure

1. In the left pane of the ESI window, select the host cluster.

2. Select the cluster disk from the list.

3. In the Actions pane, click Disconnect Cluster Disk.

The Disconnect Cluster Disk wizard appears.

4. On the Disconnect Cluster Disk page, click Next.

5. Click Yes to confirm your selection.

6. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

7. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

8. On the Summary page, click Finish.

Deleting cluster disks from a host cluster
Procedure

1. In the left pane of the ESI window, select a host cluster.

2. Select one or more cluster disks to be deleted.

Note

Hold down the Ctrl key to select multiple clusters.

3. In the Actions pane, click Delete Cluster Disk.

The Remove Cluster Disk wizard appears.  

4. Verify the cluster disk details, and then click Next.
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5. Click Yes when prompted for confirmation again.

6. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

7. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

8. On the Summary page, click Finish.

Changing a cluster disk drive letter or path
Procedure

1. In the left pane of the ESI window, select Host Clusters.

2. Click Cluster Disks in the center pane.

3. Select the cluster disk to change.

4. In the Actions pane, click Change Drive Letter and Paths.

The Change Drive Letter and Paths wizard appears.

5. Change the following values, and then click Next.

Option Description

Drive Letter Select from the available drive letters.

Mount Path Click Browse and locate the path.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

The cluster disk appears in the Cluster Disks list with the new disk drive or path.

7. On the Summary page, click Finish.

The cluster disk appears in the Cluster Disks list with the new disk drive or path.
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CHAPTER 8

Managing hypervisors

This chapter contains the following topics:

l Managing virtual machines and disks................................................................... 86
l Adding, viewing, and deleting hypervisors.............................................................92
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Managing virtual machines and disks

Creating disks for virtual machines
ESI supports Microsoft Hyper-V and VMware vSphere hypervisors. The disk options in ESI
vary depending on what the hypervisor supports.

The following table shows the storage options that are supported by ESI for each
hypervisor.

Table 4 Disk options

Disk option Microsoft Hyper-V VMware vSphere

Pass-through disk Yes
(Pass-through SCSI)

Yes
(Raw Device Mapping)

File-based or virtual
disk

Yes
(VHD or VHDX file)

Yes
(VMDK file)

Datastore  Yes

SCSI disk  Yes

Host disk Yes  

Cluster shared volumes Yes  

You can create the these disk types for virtual machines:

l SCSI Disks (VMware vSphere) See Creating SCSI disks on page 74

l Virtual disks (Hyper-V and VMware vSphere) See Creating virtual disks on page 76

l Pass-through SCSI disks (Hyper-V) See Creating pass-through SCSI disks on page 69

l Raw device mapping (RDM) disks (VMware vSphere) See Creating raw device
mapping disks on page 71

Note

n For hypervisors, ESI does not support creating new SCSI controllers. However, ESI
uses existing SCSI controllers to create disks for a virtual machine.

n For hypervisors, if the Virtual disk option is not available, confirm that the
applicable hypervisor appears as a connected hypervisor in the Hypervisors
section in the main ESI window. When you select the virtual machine in the Hosts
section, the Hypervisor and Hypervisor Type should appear at the top of the
center pane (gray information area). If these do not appear, the virtual machine
might have been discovered before the hypervisor. If so, remove the virtual
machine and add it again as a host.

n The order of the pages and steps vary slightly in the Create Disk wizard,
depending on the disk type that you select.
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Creating hypervisor SCSI LUNs
Create a hypervisor SCSI LUN from a volume.

Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click SCSI LUNs in the center pane.

3. In the Actions pane, click Create Disk.

The Create Disk wizard appears.

4. Perform one of these steps:

l For a VPLEX system, go to the next step.

l Otherwise, go to Step 7 on page 87.

5. Select a VPLEX storage system and click Next.

6. In the Virtual Volume Settings page, choose the settings for the virtual volume, and
then click Next.

Option Description

Virtual Volume Name Name of the virtual volume from which the SCSI LUN will be
created.

Create Distributed
Volume

Creates a distributed virtual volume. If enabled, the wizard
displays additional pages to provide target cluster details.

Select cluster Select the volume from a particular cluster.

Create New Storage
Volume

(Optional) Creates a new virtual volume in the underlying
storage array. If not selected, existing virtual volumes are
listed in a subsequent step.

7. On the LUN Masking Settings page, select a hypervisor initiator and click Next.

8. On the Storage System page, select the underlying array and click Next.

9. On the Storage Pool page, select the storage pool and then click Next.

There is only one global storage pool.

10. Perform one of these steps:

l If you enabled Create New Storage Volume on the Virtual Volume Settings page,
on the New LUN page, set the required parameters and then click Next.

l Otherwise, on the LUN page, select a storage volume (LUN) from the list of existing
storage volumes and then click Next.

11. On the LUN Masking Settings page, choose one or more ports from the list of initiator
ports of the VPLEX source cluster, and then click Next.

All the initiator ports are selected by default.

12. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Connecting SCSI LUNs

Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click SCSI LUNs in the center pane and select a disk from the list.

3. In the Actions pane, click Connect Disk.

The Connect Disk wizard appears.

4. On the Storage System page, select the storage system and click Next.

5. On the Select a VirtualVolume page, select on or more virtual volumes to connect to
the hypervisor node and click Next.

6. On the LUN Masking Settings page, choose from the list of initiator ports and then
click Next.

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Disconnecting or removing SCSI LUNs
The Disconnect SCSI Disk wizard and Delete SCSI Disk enable you to manage SCSI disks.

Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click SCSI LUNs in the center pane and select a disk from the list.

3. In the Actions pane, perform one of these steps:

l To disconnect the SCSI disk, click Disconnect SCSI Disk.

l To delete the SCSI disk, click Delete SCSI Disk.

Depending on your choice, either the Disconnect SCSI Disk wizard or the Delete SCSI
Disk wizard appears.

4. Continue through the wizard, clicking Next and Finish.
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Managing virtual machines in ESI
Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click Virtual Machines in the center pane and select a virtual machine from the list.

3. In the Actions pane, click Connect to Host.

Note

If the virtual host is already in ESI, click Connect to Host to open the pane that
displays the host information.

4. Click Yes to confirm that you want to manage this virtual machine host in ESI.

The Add Host dialog box appears.

5. Review the details for the IP address or host name.

Note

Adding hosts on page 60 provides more information about adding a host.

6. Click Test Connection to test the connection before adding it.

7. Click Add.

The host name appears in the center pane.

Attaching virtual disks
Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click Virtual Machines in the center pane and select a virtual machine from the list.

3. In the Actions pane, click Attach Disk.

The Attach Disk wizard appears.

4. Identify the disk to attach by selecting one of the following options:

l Virtual hard disk - see Attaching a virtual hard disk on page 90

l Virtual hard disk and create a virtual disk or LUN - see Attaching a virtual hard disk
and creating a virtual disk or LUN on page 90

l Pass-through SCSI disk - see Attaching a pass-through SCSI disk on page 91

l Pass-through SCSI disk and create a virtual disk or LUN - see Attaching a pass-
through SCSI disk and creating a virtual disk or LUN on page 91

Note

If you create a virtual disk or LUN during this process, select Create Virtual Disk or
LUN. The pages for each disk option are different.
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Attaching a virtual hard disk
Procedure

1. On the Select Disk Type page, select Virtual Hard Disk, and then click Next.

2. On the Virtual Hard Disk page, type the File Path, or browse to select it, and then click
Next.

The Hypervisor Settings or VMware Settings page appears.

3. Select the controller and location settings, and then click Next.

4. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Note

Creating virtual disks on page 76 provides more details on virtual hard disk and
hypervisor settings.

Attaching a virtual hard disk and creating a virtual disk or LUN
Procedure

1. On the Select Disk Type page, select Virtual Hard Disk.

2. Select Create Virtual Hard Disk or LUN, and then click Next.

3. On the Virtual Hard Disk page, select a file name, location, size, and type fixed or
dynamic, and then click Next.

The Hypervisor Settings or VMware Settings page appears.

4. Select the controller and location settings, and then click Next.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Note

Creating virtual disks on page 76 provides more details on virtual hard disk and
hypervisor settings.
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Attaching a pass-through SCSI disk
Procedure

1. On the Select Disk Type page, select Passthrough SCSI Disk and then click Next.

2. On the Passthrough SCSI Disk page, select the candidate disk from the list, and then
click Next.

The Hypervisor Settings or VMware Settings page appears.

3. Select the controller and location settings, and then click Next.

4. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Note

Creating pass-through SCSI disks on page 69 provides more details.

Attaching a pass-through SCSI disk and creating a virtual disk or LUN
Procedure

1. On the Select Disk Type page, select Passthrough SCSI Disk.

2. Select Create Virtual Hard Disk or LUN, and then click Next.

3. On the Storage System page, review the details, and then click Next.

4. On the Storage Pool page, select the storage pool for the disk, and then click Next.

5. On the New LUN page, specify the LUN count, sequence number, name, description,
and other details for the new LUN, and then click Next.

The Hypervisor Settings or VMware Settings page appears.

6. Select the controller and location settings, and then click Next.

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Note

Creating pass-through SCSI disks on page 69 provides more details.
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Removing virtual disks from a hypervisor
Procedure

1. In the left pane of the ESI window, select Hypervisors and one of the hypervisor
servers.

2. Click Virtual Machines in the center pane and select a virtual machine.

3. Click the plus (+) symbol to view the disks in the virtual machine.

4. Select one or more disks to be removed and click Remove System in the Actions
pane.

5. Click Yes to confirm that you want to remove the virtual disks.

The Remove Virtual Disk wizard appears.

6. Select Delete the corresponding virtual file or the passthrough SCSI disk if you also
want to delete the file or disk.

7. Confirm the list of disks to be removed.

8. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Adding, viewing, and deleting hypervisors

Adding hypervisor servers
You can add a Microsoft Hyper-V or VMware vSphere hypervisor server.

Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Hypervisors.

2. In the Actions pane, click Add Hypervisor.

3. In the Add New Server dialog box, set the following values.

Option Description

Server Host name or IP address of the server that you are adding

Type Select one of the following hypervisor types:

l Microsoft Hyper-V

l VMware vSphere

Current Credentials
or

Specify Credentials

Use existing server credentials
or

New username and password for that server
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4. Click Test Connection to test the connection before adding it.

5. Click Add.

The server name appears in the center pane.

Viewing hypervisor hosts
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. Click Hosts in the center pane.

Hosts details, such as host names, IP addresses, cluster and datacenter names, and
the username, appear.

Viewing hypervisor datastores
You can view all datastores for a hypervisor or view datastores for a specific cluster.

Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. Click Datastores in the center pane.

A list of datastores appears. Datastores are identified as VMFS5 and virtual datastores
are identified as VVOL types.

3. Select a datastore from the list and then click the plus (+) symbol.

Datastore information, such as LUNs, storage IDs, capacity, and provision types,
appears.

Viewing datastores for a specific cluster
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. From the left pane, click the plus (+) symbol for the hypervisor, and then click
Datacenter - ESI.

3. Click the plus (+) symbol for Datacenter - ESI and then click the plus (+) symbol for
Cluster.

4. Select a cluster from the list, and then click Datastores.

The datastore information appears for the cluster.

Creating a hypervisor datastore
Create a datastore from a virtual volume.

Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. Click Datastores in the center pane.
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3. In the Actions pane, click Create Datastore.

The Create Datastore wizard appears.

4. In the Select Disk Type page, choose whether to create the datastore from a new or
existing virtual volume and click Next.

5. Select the storage system and click Next.

6. Select a storage pool and click Next.

This page does not appear for VPLEX storage systems.

7. Perform one of the following steps:

l If you selected to use an existing LUN:

n For VPLEX systems, in the Select a Virtual Volume page, select a virtual volume
and click Next.

n For all other systems, in the Select a LUN page, select a LUN and click Next.

l If you selected to use a new LUN:

n For VPLEX systems, in the in the Virtual Volumes Settings page, specify the
virtual volume name, select the cluster, and enable Create New Storage
Volume, and then click Next.

n For other systems, in the New LUN page, specify the LUN name, description,
and size, and then click Next.

8. In the LUN Masking Settings page, select the hypervisor initiators and click Next.

9. Proceed through the wizard to create a new LUN for the virtual volume. until you reach
the Datastore Preparation Settings page.

10. In the Datastore Preparation Settings page, type the name of the datastore.

11. Continue through the wizard, clicking Next and Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing hypervisor virtual volumes
View virtual volumes for Unity and UnityVSA on an EXS hypervisor.

Procedure

1. Select an ESX hypervisor in the left pane of the ESI GUI.

2. Select the Virtual Volumes tab.

Details for all virtual volumes are displayed.

Viewing hypervisor virtual machines
View the virtual machines for a hypervisor or view virtual machines for a specific cluster.

Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.
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2. Click Virtual Machines in the center pane, and then select a virtual machine from the
list.

3. Click the plus (+) symbol.

Disk information for the virtual machine appears.

Viewing virtual machines for a specific cluster
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. In the left pane, click the plus (+) symbol for the hypervisor, and then click Datacenter
- ESI.

3. Click the plus (+) symbol for Cluster.

4. Select a cluster from the list, and then click Virtual Machines.

Disk information is displayed for the virtual machines in the selected cluster.

Viewing hypervisor SAN initiators
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. In the left pane, click the plus (+) symbol for the hypervisor, and then click Datacenter
- ESI.

3. Click the plus (+) symbol for Datacenter - ESI and then click the + symbol for Cluster.

4. Select a cluster from the list, and then click SAN Initiators.

The SAN initiator details appear.

Viewing hypervisor SCSI LUNs
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. In the left pane, click the plus (+) symbol for the hypervisor, and then click Datacenter
- ESI.

3. Click the plus (+) symbol for Datacenter - ESI and then click the plus (+) symbol for
Cluster.

4. Select a cluster from the list, and then click SCSI LUNs.

The SCSI LUN details appear.

Deleting hypervisor servers
Procedure

1. In the left pane of the ESI window, select Hypervisors, and then select one of the
hypervisor servers.

2. In the Actions pane, click Remove System.
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3. Click Yes to confirm your selection.

Note

When you remove a hypervisor server from ESI, you must remove all the hosts that are
managed by that hypervisor server. Then, you must add the hosts in ESI again to
perform any provisioning operations on those hosts.
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CHAPTER 9

Managing SharePoint farms and web applications

This section provides an overview of the SharePoint adapter and instructions for
managing SharePoint farms and web applications.

l Adding SharePoint farms.......................................................................................98
l Viewing SharePoint farms......................................................................................98
l Creating SharePoint web applications................................................................... 99
l Removing SharePoint farms................................................................................ 101
l Configuring remote SQL Servers.......................................................................... 101
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Adding SharePoint farms
Procedure

1. In the left pane of the ESI window, select EMC Storage Integrator or Applications >
SharePoint.

2. In the Actions pane, click Add Application.

3. In the Applications dialog box, set the following values:

Option Description

Farm Friendly Name Type a name to identify the farm.

Local Farm l If ESI is running on the same server as the farm, select
Local Farm.

l Clear this check box to connect to a remote farm.

Note

If Local Farm is not selected and the database server name
matches the local server as the ESI host, ESI assumes that
you are adding a local farm and ignores all of the field values
except for the Friendly Name.

Database Server Type the database server name.

Configuration
Database

l Type the farm name of the configuration database.

l Get these details from the SQL Server or SharePoint
administration.

Integrated Security Select to use Microsoft Windows Authentication.

User Name and
Password

Clear the Integrated Security check box to use SQL Server
Authentication, and then type a username and password.

4. To confirm that the values are correct, click Test Connection.

5. Click Add.

The farm is added to the list in the Applications window. However, ESI is not yet
connected to the farm.

Viewing SharePoint farms
Procedure

1. In the left pane of the ESI window, select Applications > SharePoint.

2. Click the farm name to activate the connection.

3. Click Web Applications to list the web applications in the farm.

4. Click the plus (+) symbol to expand a web application and view Site Collections and
Content Databases.

5. Click Storage to view the content databases that are mapped to the storage systems
used by the farms.
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6. Click the plus (+) symbol to view database storage details.

Creating SharePoint web applications
Procedure

1. In the left pane of the ESI window, select Applications > Applications and then
applicable SharePoint farm.

2. In the Actions pane, click New SharePoint Web Application.

The ESI SharePoint Provisioning Wizard appears.

3. For SharePoint Information, set the following values.

Option Description

Selected Farm The farm selected in step 1 appears in this field.
Note: If the farm has more than one SQL Server, they will also be
listed in the Database Server list box.

New IIS Web
Site

For a local farm, select this check box, and then type a name to
create a new web application.
This field is not available if this is a remote farm.

Note: If you do not want to create a new web application, clear the
New IIS Web Site check box.

Database Server Confirm or change the default corresponding database server.

SQL Server
Instance

Confirm or change the default SQL Server instance.

Note

You cannot create SharePoint web applications for remote farms in ESI.

For Application Pool Security Settings, set the following values.

Option Description

User Name Confirm or change the default SharePoint username that has
access to the configuration database.

Password Password for the user who has access to the configuration
database.

Confirm Password Type the password again to confirm it.

4. Click Next.

If SQL Server is running on a virtual machine, the Select Disk Type page appears. If the
Database Storage page appears, skip to step 7.

For the Virtual Hard Disk type, skip to step 7. Otherwise, the Database Storage page
appears.

5. In the Disk Type field, select the applicable disk type, and then click Next.
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Note

Unless a Windows-based hypervisor is an option, the SCSI Disk type is the only
choice.

For the Virtual Hard Disk type, skip to step 7. Otherwise, the Database Storage page
appears.

6. If the Database Storage page appears, set the following field values for new LUNs,
and then click Next.

Option Description

Database Name Database name

Data File Folder:
Drive Letter or Mount Path

Drive letter or mount path for the data file
folder

Log File Folder: Drive Letter or Mount
Path

Drive letter or mount path for the log file
folder

7. On the Create File-based Disk page, set the following values for new LUNs, and then
click Next.

Option Description

File Name Complete file name (including the VHD or VHDX extension) of
the file to be used as a hard drive.

Folder Folder on the hypervisor machine in which the file should be
created.

Size Size of the file in GB.

File-based Disk
Type

Select either Fixed or Dynamic.

8. On the Disk and Database Size Information page, set the following values, and then
click Next.

Option Description

Data File Initial Size Initial size of the data file.

Log File Initial Size Initial size of the log file.

Database Maximum
Size

Maximum size of the database.

Database Growth Rate Database growth rate.

Data Disk Size Size of the data disk.

Log Disk Size Size of the log disk.
Note: The Log Disk Size field is unavailable when only one
disk is being created for both folders. This occurs when
the same drive letter or mount path is selected for both
the data and log folders on the Database Storage page.

9. On the Database Security page, confirm that the Server Name and SQL Instance Name
are correct.
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l If SQL Server is configured for Windows Authentication, confirm that the Integrated
Security check box is selected.

l If Integrated Security is selected, set the following values, and then click Next.

Option Description

Database User Name SQL Server username.

Password SQL Server password .

Confirm Password Type the password again to confirm it.

10. Click Next.

The Remote Blob Storage (RBS) Information page appears.

11. In the Storage System list box, select a storage system to host the SharePoint
storage, and then click Next.

12. On the Storage Pool Information page, select the required storage pool and service
node, and then click Next.

Storage Pools: Select a storage pool or RAID group to host SharePoint storage.

Service Node: For a service node, select the applicable node.

13. On the Review Parameters page, review the settings, and then click Next to confirm
them.

14. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

15. On the Summary page, click Finish.

Removing SharePoint farms
Procedure

1. In the left pane in ESI, select Applications > SharePoint.

2. In the center pane, select the SharePoint farm.

3. In the Actions pane, click Remove Application.

4. In the Remove Farm dialog box, click Yes.

Configuring remote SQL Servers
If you are using ESI to connect to a remote SharePoint farm, the SQL Server computer and
other servers in the farm are distinct from the machine on which ESI is running.

Use the following procedure to complete these tasks:

l Set up the login mode
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l Set up SQL Server

l Set up the firewall

l Confirm the connection

Procedure

1. Set up login mode:

Option Description

SQL
Authentication

If the remote SQL Server computer is configured for SQL
Authentication, then confirm the data complies with the defined
guidelines. This should be simple, assuming that the machine
running ESI is authenticated or trusted in the domain to which
the farm belongs.

Windows
Authentication

If the remote SQL Server is configured for Windows
Authentication, then it is possible that the user who logged in to
the ESI machine is in the same domain as the one used by SQL
Server.

Note

ESI supports domain-based farm deployments, which require that SQL Server and
SharePoint be installed in the same Windows domain as the ESI host controller.

2. Set up SQL Server:

a. On the SQL Server machine, navigate to Start > All Programs > SQL Serverversion >
Configuration Tools > SQL Server Configuration Manager.

b. In the left side of the MMC console, expand SQL Server Network Configuration.

c. Click Protocols for Name.

The name might be MSSQLSERVER or a different name, depending on your
installation.

d. In the main MMC view, double-click TCP/IP and confirm that it is enabled.

e. In TCP/IP properties, click IP Address.

f. Confirm that the IP address is correct. For a virtual environment, you may need to
correct the address.

g. Confirm that the port number is 1433. If the port number is different, make a note
of the port number that SQL Server uses.

h. Click Apply, and then click OK.

i. In the left pane of MMC, confirm that TCP/IP is enabled under SQL Native Client.

3. Set up the firewall.

a. On the computer that is running SQL Server, which id the same computer on which
you applied the SQL settings, enable port 1433 in the firewall.

b. If the selected port is not 1433, then enable the port that you noted.

c. Confirm that TCP/IP is enabled for the port.

4. If a machine other than the one configured earlier is running SQL Server, then open
SQL Server Management Studio and confirm the connection:

Managing SharePoint farms and web applications

102 EMC Storage Integrator for Windows Suite 4.1  Product Guide



a. On the small toolbar above the left pane, click Connect Object Explorer.

b. Complete the applicable details by using the correct server name. You can then
connect to the remote server and browse the databases.

c. Confirm the configuration by opening Visual Studio.

d. In Server Explorer, click Connect to Database.

e. Type the remote SQL server name or IP address.

f. Click Test Connection.
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CHAPTER 10

Managing Exchange forests

This section provides instructions for managing Exchange forests.

l Adding and viewing Exchange forests..................................................................106
l Removing Exchange forests.................................................................................106
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Adding and viewing Exchange forests
Before you begin

Add one or more Exchange on-premises forests or organizations in ESI. ESI does not
support Exchange online forests.

Because Exchange limits a single DAG to a maximum of 16 servers, this is the maximum
supported in ESI.

You can view all Exchange entities in a forest, including DAGs, mailbox servers,
databases, and database copies.

ESI discovers and associates database copies to corresponding host disks in ESI. View
the status of the database copies and associated disks in the ESI GUI or with the ESI
PowerShell Toolkit. You can also use the Get-EmcMailboxServer and Get-
EMCHostSystem cmdlets to associate Exchange mailbox servers with the
corresponding host systems.

Procedure

1. In the left pane of the ESI window, select Applications > Exchange.

2. In the Actions pane, click Add Exchange.

The Add Exchange forest dialog box appears.

3. Set the following field values for the forest.

Option Description

Friendly Name Short name for the forest that is unique across the
different forests

FQDN or URL Fully Qualified Domain Name (FQDN) or URL of an
Exchange server name or URL that is in the forest

User login Username Administrator user name for the forest

User login Password Administrator password for the forest

Use current Windows
Credential

Accept or change it to use the current credentials of the
ESI host system

4. Click Add to add the forest.

The forest and related servers appears in the Available Systems list in the center
pane.

Note

Click Test Connection to test if the field settings are correct before adding the forest.

Removing Exchange forests
Procedure

1. In the left pane of the ESI window, select Applications > Exchange > Applicable Mailbox
Server and the applicable mailbox forest.
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2. In the Actions pane, click Remove System.

3. In the Remove System dialog box, click Yes to remove the forest and related servers.
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CHAPTER 11

Managing Microsoft SQL Server databases and
availability groups

This section provides instructions for managing SQL Server databases and availability
groups.

l Adding SQL Servers.............................................................................................110
l Viewing SQL Servers............................................................................................110
l Creating SQL Server databases............................................................................111
l Creating SQL Server availability groups............................................................... 112
l Adding a SQL Server database to an availability group........................................ 113
l Removing SQL Server databases from availability groups.................................... 113
l Deleting SQL Server databases............................................................................114
l Adding replicas to SQL Server availability groups................................................ 114
l Removing SQL Server replicas............................................................................. 115
l Using T-SQL script............................................................................................... 115
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Adding SQL Servers
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server.

2. In the Actions pane, click Add SQL Servers.

3. In the SQL Servers dialog box, do one of the following:

l Select I have a range of Servers and type the IP addresses to define the range.

l Select I will provide a list of IPs and type a list of one or more IP addresses or
names (one IP or name per line). Click Browse to locate the server name.

4. Click Start Scanning to locate and list the properties for the specified range of servers.

By default, all accessible SQL Server instances are set to be added.

5. Clear the check box for specific servers that you do not want to add.

6. Click Add.

The server appears in All groups.

 

Note

If the "Failed to connect to one or more SQL Server" message appears, one or more
SQL Server instances rejected the attempt to open a connection with Windows
Authentication. Confirm that firewall and remote settings for the SQL Server instances
are set up according to Microsoft documentation and that the instances support
Windows Authentication. Servers that cannot be accessed are identified as Unknown
in the Virtual Machine column.

Viewing SQL Servers
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server Groups.

2. The center pane displays the following:

l All groups, which displays data for the selected SQL Server group, including all
connected SQL Servers, related instances, databases, and connected storage.
Click a group to display the group details in the center pane.

l Servers and Storage, which lists the data for the selected group. For example, for
servers, you can view server IDs, instance IDs, database IDs, total visible memory,
total storage, and other details.

l AlwaysOn, which lists the servers, server instances, databases in availability
groups, and other details about groups that support the SQL Server AlwaysOn
feature. For example, you can view the databases, candidate databases (primary
groups), and replicas for a specific availability group, and their roles, failover
mode, connection states, and other related details.

l Script Execution, which provides the following tasks:

n For AlwaysOn availability groups, add and remove replicas.
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n For databases, create and delete databases and add or remove databases to or
from AlwaysOn availability groups.

Note

Click the plus (+) symbol to view more details.

To customize the center pane, such as columns, right-click a column in the center
pane and select the action from the menu.

Creating SQL Server databases
You can use ESI to create and configure new SQL Server databases.

Procedure

1. In the left pane of the ESI window, select Applications > SQL Server > Groups.

2. In All Groups, select the SQL Server and instance for the database.

3. Click Script Execution and then click Create Database.

4. On the Create Database page, specify the following.

Option Description

Use Selected
Instance Storage

Select this option to use the instance you selected in All groups
for the database.

Data Storage Do one of the following:

l Select Create New Storage and click Go to create a new disk
and specify the disk details.

l If using a selected instance, select the disk folder for the data
storage and click Go.

Log Storage Do one of the following:

l Select Create New Storage and click Go to create a new disk
and specify the disk details.

l Select an existing disk and click Go.

Use Selected
Server or
Instance

Select to use the selected server or instance for storage.

Server Select the server for the new database or databases.

Instance Select the instance for the new database or databases.

Database Name Type a unique database name.

File Name Type a unique file name for the database or databases.

Folder(s) Type a folder path for the database or databases.

Bulk Create Do one of the following:

l Select Create Multiple Databases to create multiple
databases.

l Leave the default of 1 to create one database.
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5. Confirm or change the following default settings for the new database or databases.

Option Description

Bulk Create
Create a folder for each database

Default is False.

Number of Databases to Create Defaults to the Bulk Create number value set
in step 4.

Database
Data File Growth Rate

Default is 1.

Data Growth Rate Type Default is MB.

Default Log File Size Default is 1.

Log File Growth Rate Default is 10.

Log Growth Rate Type Default is Percentage.

Maximum Data File Size Default is 1.

Maximum Log File Size Default is based on the Log Storage setting
in the previous step.

Use Separate Data and Log Disks Default is False.

Misc
Remember My Settings

Default is True.

Server and Instance
Create Database on Default Instance

Default is True.

T-SQL
Show Script Before Creating Database

Default is True, which displays the T-SQL
script after you click Create database.

6. Click Create database to create the database.

7. When the Created Database message appears, click OK.

Creating SQL Server availability groups
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server > Groups.

2. In All Groups, select the SQL Server for the group.

3. Click Script Execution and then click Create Availability Group.

4. On the Create Availability Group page, specify the following.

Option Description

Availability Group
Name

Type a unique name for the availability group.

Primary Server Select the server to be the primary replica in the DAG. Only
instances with AlwaysOn enabled are available.

Primary Instance Select the instance to be the primary replica instance in the
group.
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Option Description

Database Select one or more databases to add to the availability group.
Only databases with full backups are available.

Replica Server Select the server to be the secondary replica server in the
availability group.

Replica Instance Select the instance to be the secondary replica instance in the
availability group. Only instances with AlwaysOn enabled are
available.

Shared Network
Location

Browse to or type a shared network path in UNC format that is
accessible by the primary and secondary servers in the DAG.
Local paths are not supported.

Show script Select to show the T-SQL script, which appears after adding the
availability group.

5. Click Create Availability Group.

6. If an added availability group message appears, click OK.

Adding a SQL Server database to an availability group
Procedure

1. In the left pane of the ESI window, select Applications > SQL Servers Group.

2. In All groups, select the SQL Server that contains the database.

3. Click Script Execution and then click Add Database to Availability Group.

4. Confirm or specify the following.

Option Description

Server SQL Server in the availability group

Instance SQL Server instance in the availability group

Availability Group Availability group for which to add the database

Candidate Database Candidate database to add to the group.

Show script Select to show the T-SQL script, which appears after adding
the database.

5. Click Add Database.

6. If the Added database to availability group message appears, click OK.

Removing SQL Server databases from availability groups
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server Groups.

2. In All groups, select the group from which to delete the database.

3. Click Script Execution and then click Remove Database from Availability Group.

4. On the Remove Database from Availability Group page, confirm or select the
following.
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Option Description

Server SQL Server in the availability group

Instance SQL Server instance in the availability group

Availability Group Availability group from which to remove the database

Availability Database Database to remove from the group

Show script Select to show the T-SQL script, which appears after removing
the database

5. Click Remove Database.

6. When the database removed message appears, click OK.

Deleting SQL Server databases
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server Groups.

2. In All groups, select the group from which to delete the database.

3. Click Script Execution and then click Delete Database.

4. On the Delete Database page, confirm the correct server and instance are selected.

5. Select the database name, select Show script to show T-SQL script, and then click
Delete.

6. When the database deleted message appears, click OK.

Adding replicas to SQL Server availability groups
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server Groups.

2. In All Groups, select the SQL Server and instance for the replica.

3. Click Script Execution and then click Add Replica.

4. On the Add Replica page, specify the following.

Option Description

Server SQL Server in the availability group

Instance SQL Server instance in the availability group

Availability Group Availability group for the database replica

Candidate Replica Server Candidate server for the replica

Candidate Replica
Instance

Candidate instance for the replica

Show Script Select to show the T-SQL script, which appears after
adding the replica.

5. Click Add Replica.

6. When the added replica message appears, click OK.
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Removing SQL Server replicas
Procedure

1. In the left pane of the ESI window, select Applications > SQL Server > Groups .

2. In All Groups, select the SQL Server and instance for the replica.

3. Click Script Execution and then click Remove Replica.

4. On the Remove replica page, confirm or specify the following:

Option Description

Server The SQL Server that contains the replica

Instance SQL Server instance that contains the replica

Availability Group Availability group from which to remove the replica

Availability Replica Replica to remove from the group.

Show script Select to show the T-SQL script, which appears after removing
the replica.

5. Click Remove replica.

6. When the removed replica message appears, click OK.

Using T-SQL script
In the Script Execution tab, you can use the Show Script field to view, edit, and run script
changes with T-SQL.

The T-SQL script appears on the page after the task is completed. You can then edit and
execute any script changes for the following tasks:

l Add or remove SQL Server replicas

l Create or delete SQL Server databases

l Create or delete SQL Server availability groups

l Add or remove SQL Server databases to or from availability groups
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CHAPTER 12

Managing AppSync applications

This section provides instructions for managing databases and protecting databases
using AppSync service plans.

l Viewing AppSync databases................................................................................118
l Mounting database copies from AppSync databases...........................................118
l Unmounting database copies..............................................................................119
l Protecting databases with service plans..............................................................120
l Restoring database copies.................................................................................. 120
l Subscribing databases to AppSync service plans................................................ 121
l Unsubscribing databases from AppSync service plans........................................ 121
l Expiring database copies.................................................................................... 122
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Viewing AppSync databases
In ESI, you can view AppSync Application Server instances and databases, including SQL
Server databases and Exchange databases, registered storage, registered hosts, and
registered EMC RecoverPoint systems.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. When the Protection Switch View is selected, you can click the following to view
AppSync system details:

l SQL Server Databases: View database names, host IP addresses, instance names,
database files, database copies, and service plans, as well as mount hosts, copy
mount status, copy storage type, and copy backup type

l Exchange Databases: View database names, host IP addresses, instance names,
database files, database copies, and service plans, as well as mount hosts, copy
mount status, copy storage type, and copy backup type

l Storage: View storage system names, display (friendly) names, usernames, IP
addresses, and models

l Registered Hosts: View host system names, display (friendly) names, usernames,
and OS versions

l RecoverPoint Systems: View RecoverPoint site IP addresses, site names, and site
versions

4. When the Service Plan Switch View is selected, click the Service Plan type and the
following tabs to display AppSync details for the selected service plan.

Option Description

SQL Server
Databases

Database subscriptions, database copies, settings, and events
tabs with related details, such as server names, instance names,
database names, service plan settings, and log events

Exchange
Databases

Database subscriptions, database copies, settings, and events
tabs with related details, such as server names, instance names,
database names, service plan settings, and log events

5. Click the plus (+) symbols to expand details.

Mounting database copies from AppSync databases
In ESI, you can mount AppSync database copies on VNX or RecoverPoint target hosts.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. Select Protection Switch View, select a database, and expand the database to view
the AppSync database copies.

4. Select a database copy and select Mount in the Actions pane.
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5. In the Mount Database Copy wizard, specify the following, and then click Next.

Option Description

Mount Select to mount without recovering the database copy

Mount and Recover (SQL
Server only)

Select to mount the database copy to recover the
specified instance

Mount on Server Select the server on which to mount the copy

Mount with access Select Read-only or Read-write for the mounted copy

Mount Path Select Default path (displayed on screen) or a new path

Recovery Instance (SQL
Server only)

Select the database instance to recover with the
selected copy to mount

Recovery Type (SQL Server
only)

Select the applicable type: Recovery, NoRecovery, or
Standby

Database Name Suffix Type a suffix name for the recovered database

Note

Some of the field options in the wizard are only available for SQL Server database
copies.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Unmounting database copies
Unmount AppSync database copies from VNX or RecoverPoint target hosts.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. Select Protection Switch View, select a database, and expand the database to view
the AppSync database copies.

4. Select a database copy and select Unmount in the Actions pane.

5. In the Unmount Database Copy wizard, confirm the selected database copy to
unmount and click Next.

6. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Protecting databases with service plans
To protect an AppSync database, the Protect Now action creates a copy of a selected
application database and enables you to choose the type of service plan to protect the
database.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. Select Protection Switch View and select a database.

4. In the Actions pane, select Protect Now.

5. In the Protect Database wizard, select the AppSync service plan to use, and then click
Next.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Restoring database copies
Restore a selected database by using the specified database copy. You can only restore
database copies that are unmounted.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. Select Protection Switch View, select a database, and expand the database to view
the AppSync database copies.

4. Select a database copy and select Restore in the Actions pane.

5. In the Restore Database Copy wizard, confirm the selected copy to restore and click
Next.

6. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Subscribing databases to AppSync service plans
In ESI, you can subscribe Exchange and SQL Server databases to AppSync Service plans.

AppSync provides the following built-in service plans:

l The Bronze plan creates and manages local copies.

l The Silver plan creates and manages remote copies.

l The Gold plan creates and manages local and remote copies.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. In the Protection Switch View, select and expand the AppSync Database.

4. In the Actions pane, click Subscribe Service Plan.

5. In the Subscribe AppSync Service Plan wizard, specify the service plan to which to
subscribe and click Next.

6. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Unsubscribing databases from AppSync service plans
Unsubscribe Exchange and SQL Server databases from AppSync Service plans.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. In the Protection Switch View, select and expand the AppSync Database.

4. Click AppSync Service Plans and then select the service plan from which to
unsubscribe the database.

5. In the Actions pane, click Unsubscribe Service Plan.

6. In the Unsubscribe AppSync Service Plan wizard, confirm the selected service plan
and click Next.

7. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Expiring database copies
In ESI, you can expire (remove) a database copy from an AppSync database. You can only
expire database copies that are unmounted.

Procedure

1. In the left pane of the ESI window, select the AppSync replication service.

2. In the Actions pane, click Connect.

3. Select Protection Switch View, select a database, and expand the database to view
the AppSync database copies.

4. Select a database copy and select Expire in the Actions pane.

5. In the Expire Database Copy wizard, confirm the selected copy to expire, and then
click Next.

6. On the Review Input Parameters, review the parameters, and then click Next.

7. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

8. On the Summary page, click Finish.
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CHAPTER 13

Managing RecoverPoint applications

This section provides instructions for managing consistency groups, replica copies, and
replica snapshots.

l Adding RecoverPoint consistency groups............................................................ 124
l Viewing consistency groups................................................................................ 124
l Managing consistency groups............................................................................. 125
l Applying bookmarks to consistency groups.........................................................125
l Deleting consistency groups................................................................................126
l Adding replica copies to a consistency................................................................126
l Failing over to a replica copy............................................................................... 127
l Deleting replica copies........................................................................................128
l Adding replica sets..............................................................................................128
l Deleting replica sets............................................................................................129
l Enabling image access for replica snapshots...................................................... 130
l Disabling image access for replica snapshots..................................................... 131
l Recovering production for replicas...................................................................... 131
l Viewing replication clusters.................................................................................132
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Adding RecoverPoint consistency groups
A consistency group is a group of one or more replica sets that can be backed up together
and recovered together as a unit or a set. Consistency groups can include both local and
remote replica copies, and usually include as many replication sets as there are volumes
in the production storage to replicate.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups.

3. From the Actions pane, click Add Consistency Group.

The Add Consistency Group wizard appears.

4. On the Consistency Group page, type a name for the new consistency group.

5. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

6. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

7. On the Summary page, click Finish.

Click Consistency Groups in the center pane to view details for the new consistency
group.

Viewing consistency groups
Procedure

1. In the left pane of the ESI window, select a replication service.

2. In the Actions pane, click Connect.

3. Click Consistency Groups in the center pane.

4. Select a consistency group from the list.

5. Click the following to view replica details for the consistency group:

l Replica Sets

l Replica Copies

l Replica Links

6. Click the plus (+) symbols to expand the replica details.
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Managing consistency groups
Add volumes or LUNs to an existing consistency group or remove volumes or LUNs from
an existing consistency group.

Procedure

1. Select a storage system in the left pane and click Consistency Group in the center
pane.

2. Right-click a consistency group and select Add Volume (or Add LUN) or Remove
Volume (or Remove LUN).

3. In the wizard, select or clear the volumes to be added or deleted and click Next.

4. Click Next to continue through the wizard and then click Finish.

Applying bookmarks to consistency groups
A RecoverPoint bookmark is a text label that you can apply to a snapshot to uniquely
identify it at any point in time. For multiple consistency groups, you must apply a parallel
bookmark.

You can create bookmarks manually or automatically at regular intervals. Bookmarks are
useful to mark specific events, such as an application update or for a failover. All
bookmarks are listed in the copy journal.

You can only bookmark a snapshot for a consistency group that is enabled and actively
transferring.

You can set a consolidation policy for the bookmark, which specifies the time the
bookmark must survive either daily, weekly, or monthly consolidations. This setting helps
to manage the journal and space required for consolidations.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups and either select:

l A single consistency group

l Two or more consistency groups

3. In the Actions pane, click either:

l Apply Bookmark, if you selected a single consistency group

l Apply Parallel Bookmark, if you selected multiple consistency groups

The Apply Bookmark wizard appears.

4. In the Apply Bookmark wizard, specify the following, and then click Next.

Option Description

Bookmark Unique name for the bookmark

Mark as Select either:

l Crash-Consistent for immediate recovery to the
time of a crash with no data loss

l Application Consistent for recovery consistent
with application settings for failovers.
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Option Description

Define a Consolidation
Policy for this Snapshot

Select to define the consolidation policy.

Never consolidate this
snapshot

Select to prevent ESI from consolidating the snapshot
with this bookmark

This snapshot must survive
Daily (Weekly or Monthly)
consolidations

Select to keep the bookmark snapshot from
consolidation until after Daily, Weekly, or Monthly
RecoverPoint snapshot consolidations

5. Click Next to continue through the wizard and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Deleting consistency groups
Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups in the center pane, and then select a consistency group
from the list.

3. In the Actions pane, select Delete consistency group.

The Delete Consistency Group wizard appears.

4. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Adding replica copies to a consistency
Add local and remote replica copies to a consistency group. The first copy is the
production copy. You can then add a local copy or a remote copy, or both local and
remote copies.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups.

3. From the Actions pane, click Add Replica Copy.

The Add Replica Copy wizard appears.

Managing RecoverPoint applications

126 EMC Storage Integrator for Windows Suite 4.1  Product Guide



4. On the Replica Copy page, specify the following and click Next.

Option Description

Name Name for the replica copy

Replication
Site

Replication site that you want to use

Journal Size Size in GB for the journal LUN

Link Mode If this is not the production copy, select Asynchronous or
Synchronous:.

l Select Asynchronous for write transactions to be acknowledged
locally at the source side and then sent to the target side.
Asynchronous replicas can be the fastest option without
degrading the performance of host applications. This mode is
typically used for remote copies.

l Select Synchronous for host applications to wait for an
acknowledgment from a replica before continuing. Synchronous
can be slower than asynchronous, but offers less risk of data
loss. This mode is typically used for local copies.

5. On the Journal Storage System page, select a storage system from which the journal
LUN will be created, and then click Next.

6. On the Journal Storage Pool page, select a storage pool from which the journal LUN
will be provisioned, and then click Next.

7. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

8. Click Consistency Groups > Replica Copies in the center pane to view details for the
new replica copy or copies.

Failing over to a replica copy
Use the Failover to Replica Copy action to fail over to a specific replica copy in a single
consistency group only.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups and select a consistency group.

3. In the Actions pane, click Failover to Replica Copy.

4. On the Replica Copy page, select a replica copy, and then click Next.

5. Click Next to continue through the wizard, and then click Finish.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Deleting replica copies
Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups in the center pane and select a consistency group from the
list.

3. Click Replica Copies and select a replica copy.

4. In the Actions pane, select Delete Replica Copy.

The Delete Replica Copy wizard appears.

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Adding replica sets
Create a replica set, which is a source LUN and the local and remote copies that are
managed by a replication cluster, and perform continuous backup for the source LUN.

You can use the Add Replica Set wizard to create replica sets that contain production,
local, and remote copies. The order of the pages and steps vary in the wizard, based on
which type or types of copies that you created.

Note

You must have at least one replica link before you can create a replica set.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups.

3. From the Actions pane, click Add Replica Set. The Add Replica Set wizard appears.

4. On the Replica Set page, type a name for the replica set and then click Next.

5. For the production copy, do the following:

a. On the Production Copy Storage System page, select a storage system, review the
connection information, and then click Next.

b. On the Production Copy Storage Pool page, select a storage pool, and then click
Next.
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c. On the Production Copy LUN page, select a LUN, and then click Next.

6. If the consistency group contains a local copy, do the following:

a. On the Local Copy Storage System page, select a storage system, review the
connection information, and then click Next.

b. On the Local Copy Storage Pool page, select a storage pool, and then click Next.

c. On the Local Copy LUN page, select a LUN, and then click Next.

7. If the consistency group contains a remote copy, do the following:

a. On the Remote Copy Storage System page, select a storage system, review the
connection information, and then click Next.

b. On the Remote Copy Storage Pool page, select a storage pool, and then click Next.

c. On the Remote Copy LUN page, select a LUN, and then click Next.

8. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

9. On the Progress page, click Next.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

10. On the Summary page, click Finish.

Click Consistency Groups > Replica Sets in the center pane to view details for the new
replica set.

Deleting replica sets
Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups in the center pane and select a consistency group from the
list.

3. Click Replica Sets and select a replica set.

4. In the Actions pane, select Delete Replica Set.

The Delete Replica Set wizard appears.

5. Click Next, and then click Yes when prompted for confirmation.

6. On the Review Input Parameters page, review the settings, and then click Next to
confirm them.

7. On the Progress page, click Next.
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Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

8. On the Summary page, click Finish.

Enabling image access for replica snapshots
You can search for a particular snapshot and apply that snapshot for RecoverProduction
or Failover. You can use the Enable Image Access action to enable access to a replica
copy image or snapshot so that it is available for a failover. Replication changes are not
propagated to the copy while image access is enabled.

Note

When image access for replica snapshots is enabled, ESI automatically uses the
RecoverPoint Image Access mode of Logged Access. This mode ensures the snapshot
resides on the replica LUN and not the journal. This is the only supported mode in ESI and
cannot be changed.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups and select a consistency group.

3. Click Replica Copies and select the target copy with the snapshot.

4. In the Actions pane, click Enable Image Access.

The Enable Image Access for Snapshot wizard appears.

5. On the Select an Image page, specify the following and click Next.

Option Description

Copy Name Select the snapshot to enable access.

Image Access Scenario Select the applicable scenario:

l Failover to ReplicaCopy

l RecoverProduction from ReplicaCopy

Image to access Select the applicable image:

l Latest image

l An image from the image list

l A specific point in time or bookmark

l Previous Image

l Current Image

l Next Image

6. If you select A specific point-in-time or bookmark, specify the following and click
Next.
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Option Description

Point-in-time Select the specific date and time, including microseconds.

Bookmark Select Exact and specify the unique name of the bookmark.

Image type Select the applicable type:

l All images

l All images with bookmarks

l All images with system bookmarks

l All images with user bookmarks

Max. range Select the maximum range number of hours or minutes.

7. On the Replica Snapshots page, select a snapshot from the list, and then click Next.

8. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Disabling image access for replica snapshots
After you enable a snapshot for image access, you can disable the access for system
updates, such as replication changes, which are not propagated to the copy while image
access is enabled. After changes are propagated, you can then reenable image access for
replica snapshots. See Enabling image access for replica snapshots on page 130.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Consistency Groups and select a consistency group.

3. Click Replica Copies and select the target copy with the snapshot.

4. In the Actions pane, select Disable Image Access.

ESI displays a progress message while disabling image access to the selected target
copy.

Recovering production for replicas
Use the RecoverProduction for Replica Copy action in ESI to restore a specific copy as a
production copy. This restoration action starts from the selected snapshot (point of time)
and restores the production source from this copy. The production source data that is
newer than the selected point in time is rolled back and rewritten with version in the
copy. The copy’s journal is preserved and remains valid.

Procedure

1. In the left pane of the ESI window, select a replication service.
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2. Click Consistency Groups and select a consistency group.

3. In the Actions pane, click RecoverProduction for Replica Copy.

4. On the Replica Copy page, specify the following, and then click Next.

Option Description

Bookmark Unique name for the bookmark

Mark as Do one of the following:

l Select Crash-Consistent for immediate recovery to
the time of a crash with no data loss.

l Select Application Consistent for recovery
consistent with application settings for failovers.

Define a Consolidation
Policy for this Snapshot

Select to define the consolidation policy

Never consolidate this
snapshot

Select to prevent ESI from consolidating the snapshot
with this bookmark

This snapshot must survive
Daily (Weekly or Monthly)
consolidations

Select to keep the bookmark snapshot from
consolidation until after Daily, Weekly, or Monthly
RecoverPoint snapshot consolidations

5. Click Next to continue through the wizard, and then click Finish.

Note

In the Progress page of the wizard, click More Information for more progress details. If
a problem occurs while you are creating a LUN, an error message appears along with
options to resume or roll back the process. After the error is resolved, click Resume to
resume the process. Click Rollback to revert to the previously executed step.

Viewing replication clusters
A replication cluster is a group of RecoverPoint replication services grouped together so
that they are aware of each other and can back up linked storage systems.

Procedure

1. In the left pane of the ESI window, select a replication service.

2. Click Replication Clusters in the center pane.

3. Click Systems or Connected Storage Systems to view details.

4. Click the plus (+) symbols to expand the replication cluster details.
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CHAPTER 14

Managing storage with Microsoft SCOM

This chapter contains the following topics:

l ESI Service and ESI SCOM Management Packs overview......................................134
l ESI Service and Management Packs best practices..............................................134
l ESI Service overview............................................................................................135
l Installing the ESI Service..................................................................................... 136
l ESI SCOM Management Packs overview.............................................................. 143
l Installing the ESI SCOM Management Packs........................................................143
l Using the ESI Monitoring Management Pack........................................................149
l Setting up optional management pack overrides.................................................155
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ESI Service and ESI SCOM Management Packs overview
The ESI Service and the ESI SCOM Management Packs work in conjunction with Microsoft
System Center Operations Manager for centralized discovery and monitoring of all
supported EMC storage systems and storage-system components.

Note

ESI Service must be installed and set up on the ESI host system. The ESI Service has the
same requirements as the ESI host controller.

The ESI Service and ESI SCOM Management Packs support the same EMC Unity, VMAX
family, VNX, VNXe3200, and XtremIO systems that are supported in ESI. Supported
versions are listed in the EMC Simple Support Matrix and prerequisites are listed in the
Release Notes.

The ESI SCOM Management Packs also support EMC VPLEX systems.

ESI SCOM Management Packs do not currently support VNXe3100, VNXe3150,
VNXe3300, or VNXe1600 systems.

ESI Service and Management Packs best practices
Follow these recommended best practices for optimum performance and scalability:

l For performance and scalability, install ESI on a controller host machine that is
dedicated to ESI and separate from the SCOM Management Group machines.

l For load balancing, use multiple SCOM agents to monitor a large number of storage
systems. Also, set up multiple SCOM agents to communicate with one or more ESI
hosts running the ESI Service.

l To achieve the best scalability, assign storage systems with a large number of
components to different SCOM agents running on your most resourceful computers.

l The Number of Entities column in SCOM displays information about the number of
entities that the ESI Service uses. To view this column, replace ESI Service IP and
HTTPS port with the applicable values and open this link in a web browser: https://ESI
Service IP:HTTPS port/esi/console/RegisteredSystems.

l For information about the number of entities that SCOM monitors, open the SCOM
Operations Console, connect to the SCOM Management Group, and then select
Operations Manager > Agent Performance > Module Count.

The following figure represents how one SCOM Management Group that is running the ESI
SCOM Management Packs connects to multiple SCOM agents, which connect through
HTTPS to one or more ESI Services.
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Figure 1  ESI for Windows Suite setup with SCOM Management Group and monitoring agents

ESI Service overview
The ESI Service is the communications link between ESI and the ESI SCOM Management
Packs.

You can use the ESI Service to view and report on all registered systems and system
components connected to the ESI host system. ESI Service then pushes this data to
SCOM. You can also use the ESI Service as a stand-alone tool without SCOM to collect,
view, and report this same system data.

The ESI Service PowerShell Toolkit is also installed as part of the ESI Service. Use this
toolkit to set up the ESI Service to communicate with the ESI SCOM Management Packs. 
Getting started with the ESI PowerShell toolkits on page 160 provides details.

The ESI Service provides the following functionality:

l A common repository for all registered storage systems and related storage system
connection information

l Configures and securely stores the settings and access control policies for all of the
registered storage systems

l Authorization of storage system access with the Windows Authentication access
control settings

l An entity graph, a meta-model, and a query engine for discovering systems and
related components

l An HTTP API for remotely accessing the entity graph and remotely viewing policy and
configuration information and operations
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Installing the ESI Service
During the ESI installation, you can choose to install the ESI Service on the same ESI host
system. When you install the ESI Service, the ESI Service PowerShell Toolkit is also
installed on the ESI host system.

Installing ESI on page 17 provides instructions for installing ESI.

You can use the ESI Service PowerShell Toolkit to set up or update the ESI Service entity
graph, service configuration, and system registration information. Getting started with the
ESI PowerShell toolkits on page 160 and ESI Service PowerShell cmdlet list on page 165
provide details.

Setting up ESI Service for SCOM
The ESI installer automatically enables a Windows firewall rule for the ESI Service, sets up
the SSL certificate, and sets the service to listen to two IP ports on the ESI host system.

Procedure

1. If using Microsoft Active Directory services, confirm that you created an ESI Service
user account within the Active Directory domain as described in Setting up Directory
Services integration for ESI applications on page 28.

2. If necessary, change the HTTP connection defaults as described in Setting up the Run
As profile for the EMC SI Monitoring account on page 145 and Setting up the Run As
profile for the EMC SI Service Monitoring account on page 145 .

3. Confirm that the correct HTTP connections are set up as described in Changing HTTP
connection defaults on page 136.

4. Register or publish all applicable systems with the ESI Service as described in 
Publishing storage systems on page 34.

5. View and set up the security policy for the ESI Service as described in Viewing and
setting up the security policy on page 141.

6. If necessary, change the security policy on page 141, which by default is set to every
30 minutes. This is how often the ESI Service checks for registered systems and
collects data about the registered systems and system components.

Changing HTTP connection defaults
By default, the installer sets up the HTTP port 54500 and HTTPS port 54501 connections.
You can change the defaults for the ESI Service by using the following procedures:

l Setting up new IP ports with a new domain certificate on page 139

l Setting up default IP ports with a new domain certificate on page 138

l Setting up new IP ports with a new domain certificate on page 139

l Confirming the HTTP connections on page 140

Note

All of these procedures require a Windows command prompt and not a PowerShell
command prompt.
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Setting up new IP ports with the default certificate
Procedure

1. To delete the reserved URLs, on the ESI host machine, open a command prompt and
type:

netsh http delete urlacl "http://+:54500/esi/"
netsh http delete urlacl "https://+:54501/esi/"

2. Choose new IP port numbers. To get a list of used IP ports for your ESI Service, on the
ESI Service machine at a Windows command prompt, type:

netstat –an
The industry standard is to choose an available port that is between port numbers
49152 and 65535.

3. To reserve the new URLs, replace HttpPort and HttpsPort with the new port numbers by
typing:

netsh http add urlacl url="http://+:HttpPort/esi/" user="NT
AUTHORITY\NETWORK SERVICE"
netsh http add urlacl url="https://+:HttpsPort/esi/" user="NT
AUTHORITY\NETWORK SERVICE"
For example:

netsh http add urlacl url="http://+:56560/esi/" user="NT AUTHORITY
\NETWORK SERVICE"
netsh http add urlacl url="https://+:57570/esi/" user="NT AUTHORITY
\NETWORK SERVICE"

4. Delete the existing firewall rule for default ports:

netsh advfirewall firewall delete rule name="ESI Service"

5. To add the new firewall rule for the new ports, type:

netsh advfirewall firewall add rule name="ESI Service" dir=in
action="allow" protocol="TCP" localport=HttpPort, HttpsPort
Replace HttpPort and HttpsPort with the new port numbers

For example:

netsh advfirewall firewall add rule name="ESI Service" dir=in
action="allow" protocol="TCP" localport=<56560>,<57570>

6. To unbind the existing IP ports from the SSL certificate, type:

netsh http delete sslcert ipport=0.0.0.0:54501

7. To bind the ports with the new certificate:

l For Windows Server 2012, search and open Manage computer certificates.

l For Windows Server 2008, at a command prompt, type mmc.exe.

8. Select File > Add/Remove Snap-in, select Certificates, and then click Add.

9. In the Certificates snap-in dialog box, select Computer account, click Next, select
Local computer, and then click Finish.
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10. In Certificates (Local Computer) > Personal > Certificates, double-click the new
certificate to open it.

11. Select Details, select Thumbprint, and then highlight and copy the thumbprint.

12. At a command prompt, type:

netsh http add sslcert ipport=0.0.0.0:HttpsPort certhash=Thumbprint
appid="{4024FDC3-B30D-43CA-8707-A50940B4BD14}"
In place of Thumbprint, paste your new certificate thumbprint and remove all spaces
between the thumbprint numbers and letters. Replace HttpsPort with the applicable
port number and keep appid the same.

For example:

netsh http add sslcert ipport=0.0.0.0:57570
certhash=0794721c36f00902c6b9b6cb687f7a6b2997925d appid="{4024FDC3-
B30D-43CA-8707-A50940B4BD14}"

13. To set the registry keys and change the ports, navigate to the HKEY_LOCAL_MACHINE
\SOFTWARE\EMC\WSI\Service folder and change the value of the Port key to the new
HTTP port number and the SSLPort value to the new HTTPS port number. For example:

Port: 12345   SSLPort: 23456

14. To restart the ESI Service, perform either step:

l Go to Services and restart the ESI Service

l Type:
net stop esiservice
net start esiservice

For details about the port setup, refer to Confirming the HTTP connections on page
140.

Setting up default IP ports with a new domain certificate
Procedure

1. On the ESI host machine, create a new domain certificate.

Refer to your Windows documentation for more information.

2. To stop the ESI Service, open a Windows command prompt and type:

net stop esiservice

3. To unbind the existing IP ports from the ESI Service SSL certificate, type:

netsh http delete sslcert ipport=0.0.0.0:54501

4. To bind the ports with the new certificate:

l For Windows Server 2012, search and open Manage computer certificates.

l For Windows Server 2008, at a command prompt, type mmc.exe.

5. Select File > Add/Remove Snap-in, select Certificates, and then click Add.

6. In the Certificates snap-in dialog box, select Computer account, click Next, select
Local computer, and then click Finish.

7. In Certificates (Local Computer) > Personal > Certificates, double-click the new
certificate.
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8. Select Details, select Thumbprint, and then highlight and copy the thumbprint.

9. At a command prompt, type:

netsh http add sslcert ipport=0.0.0.0:54501 certhash=Thumbprint
appid="{4024FDC3-B30D-43CA-8707-A50940B4BD14}"
In place of Thumbprint, paste your new certificate thumbprint and remove all spaces
between the thumbprint numbers and letters and keep appid the same.

For example:

netsh http add sslcert ipport=0.0.0.0:54501
certhash=0794721c36f00902c6b9b6cb687f7a6b2997925d appid="{4024FDC3-
B30D-43CA-8707-A50940B4BD14}"

10. To restart the ESI Service, at the Windows command prompt, type:

net start esiservice

For details about port setup, refer to Confirming the HTTP connections on page 140.

Setting up new IP ports with a new domain certificate
Procedure

1. To delete the reserved URLs, on the ESI host machine, open a Windows command
prompt and type:

netsh http delete urlacl "http://+:54500/esi/"
netsh http delete urlacl "https://+:54501/esi/"

2. Choose new IP port numbers. Get a list of used IP ports for your ESI Service, on the ESI
Service machine at a Windows command prompt, type:

netstat –an
The industry standard is to choose an available port that is between port numbers
49152 and 65535.

3. To reserve the new URLs, type:

netsh http add urlacl url="http://+:HttpPort/esi/" user="NT
AUTHORITY\NETWORK SERVICE"
netsh http add urlacl url="https://+:HttpsPort/esi/" user="NT
AUTHORITY\NETWORK SERVICE"
Replace HttpPort and HttpsPort with the new port numbers.

For example:

netsh http add urlacl url="http://+:12345/esi/" user="NT AUTHORITY
\NETWORK SERVICE"

4. To delete the existing firewall rule for default ports, type:

netsh advfirewall firewall delete rule name="ESI Service"

5. To add the new firewall rule for the new ports, type:

netsh advfirewall firewall add rule name="ESI Service" dir=in
action="allow" protocol="TCP" localport=HttpPort, HttpsPort
Replace HttpPort and HttpsPort with the new port numbers
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For example:

netsh advfirewall firewall add rule name="ESI Service"
dir=in action="allow" protocol="TCP" localport=56560,57570

6. To unbind the existing default IP ports from the SSL certificate, type:

netsh http delete sslcert ipport=0.0.0.0:54501

7. Create a new domain certificate. Refer to Windows documentation for more
information.

8. To bind the ports with the new certificate:

l For Windows Server 2012, search and open Manage computer certificates.

l For Windows Server 2008, at a command prompt, typemmc.exe.

9. Select File > Add/Remove Snap-in, select Certificates, and then click Add.

10. In the Certificates snap-in dialog box, select Computer account, click Next, select
Local computer, and then click Finish.

11. In Certificates (Local Computer) > Personal > Certificates, double-click the new
certificate.

12. Select Details, select Thumbprint, and then highlight and copy the thumbprint.

13. At a command prompt, type:

netsh http add sslcert ipport=0.0.0.0:HttpsPort
certhash=Thumbprintappid="{4024FDC3-B30D-43CA-8707-A50940B4BD14}"
In place of Thumbprint, paste your new certificate thumbprint and remove all spaces
between the thumbprint numbers and letters. Also, replace HttpsPort with the
applicable port number and keep appid the same

For example:

netsh http add sslcert ipport=0.0.0.0:57570
certhash=0794721c36f00902c6b9b6cb687f7a6b2997925d appid="{4024FDC3-
B30D-43CA-8707-A50940B4BD14}"

14. To set the registry keys and change the ports, navigate to the HKEY_LOCAL_MACHINE
\SOFTWARE\EMC\WSI\Service folder and change the value of the Port key to the new
HTTP port number and the SSLPort value to the new HTTPS port number. For example:

Port: 56560   SSLPort: 57570

15. To restart the ESI Service, perform one of the following steps:

l Go to Services and restart the ESI Service.

l Type:
net stop esiservice
net start esiservice

For details about the port setup, refer to Confirming the HTTP connections on page
140.

Confirming the HTTP connections
Procedure

1. Open a web browser that supports Windows Authentication and browse to the ESI
Service console with the applicable IP port numbers:
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l For an HTTP connection with the default IP port numbers, go to http://ESI Service
IP:54500/esi/console, replacing ESI Service IP.

l For an HTTP connection with new port numbers, replace ESI Service IP and new HTTP
port, and go to http://ESI Service IP:new HTTP port/esi/console, replacing ESI
Service IP.

l For a secured HTTPS connection with the default IP port numbers, go to https://ESI
Service IP:54501/esi/console, replacing ESI Service IP.

l For a secured HTTPS connection with new port numbers, go to https://ESI Service
IP:new HTTPS port/esi/console, replacing ESI Service IP and new HTTPS port.

2. In the Services applet on the ESI host system, confirm that the ESI Service is installed
and started as a network service.

3. On the ESI host system, confirm that the ESIService-SSL or your new domain
certificate is listed in the \Personal\Certificates folder on the local computer.
Refer to at How to: View Certificates with the MMC Snap-in for information about how
to view certificates.

4. On the host, open the Start menu and search for firewall to locate the Windows
firewall.

5. In the search results, select Windows Firewall with Advanced Security.

6. Select Inbound rules, and confirm that ESI Service is listed and enabled as the new
ESI Service firewall rule for the default 54500 and 54501 ports or your new port
numbers.

7. After confirming HTTP connections, publish systems to the ESI Service. See Publishing
storage systems on page 34.

Viewing and setting up the security policy
The ESI Service authorizes every API call based on the Windows identity of the caller.
Authorization is granted based on the caller’s role membership.

The following Service roles are defined by the ESI Service. If these roles are changed, the
ESI Service will not work.

l Administrator role group members can invoke configuration commands on the ESI
Service and query the Entity Graph for discovered systems and system components.

l Monitor role group members can only query the Entity Graph to view discovered
systems and system components and set the system refresh interval policy.

l The ESI Service Administrator can add principal names (security groups or users) to
one of these ESI Service roles. Adding a security principal to a Service role enables
the administrator to delegate access control to one or more users who can add or
modify members of the group. After you add the group to the Monitor role, any user
who belongs to this group can make an ESI Service call.

Note

As an exception to the role assignments, the ESI Service automatically grants the
Administrator role to the local administrator group on the host that is running the ESI
Service. This allows any local administrator to manage the ESI Service without being
explicitly added; however, the user must be running elevated credentials if UAC is
enabled.

View the security policy
You can view the security policy in on of the following ways:
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l Open a web browser that supports Windows Authentication and browse to the ESI
Service console. If you have changed the default port numbers, replace the following
default numbers with your assigned ports:

n For an HTTP connection, go to http://localhost:54500/esi/console.

n For a secured HTTPS connection, go to https://localhost:54501/esi/console.

l At a PowerShell command prompt, type the following and press Enter:
Get-EmcServicePolicy

Set the security policy for a user
At a PowerShell command prompt, type the following where you replace <domain name>/
<principal name> with the applicable domain name and principal name that you want to
add to the Monitor role, and then press Enter:

Add-EmcUser "domain name\principal name" Monitor
 

Note

The cmdlet fails if the principal name is invalid. Also, if you want to add the principal
name to the Administrator role, replace Monitor in the command above with
Administrator.

 

Next step

After setting up the security policy, you can change the refresh interval. See Changing the
system refresh interval on page 142.

Changing the system refresh interval
The System Refresh Interval setting enables you to set how often the ESI Service polls all
registered storage systems and populates the entity graph with all discovered storage
systems and system components. The ESI Management Packs use this information to
confirm and update to the most current data about discovered components.

By default, this interval is set to poll the storage systems every 30 minutes for new
information. This setting, combined with the ESI Monitoring management pack interval
number, sets the frequency for receiving monitor updates in SCOM. For example, if this
interval is set to 30 minutes and the ESI Monitoring interval override is set to 10 minutes,
an updated health state can take up to 40 minutes. The time intervals can affect the data
performance. Changing discovery interval overrides on page 156 provides details about
the Monitor interval override.

To change the system refresh interval for the ESI Service:

Procedure

1. Open a PowerShell command prompt, type this command, and then press Enter to
import the ESI Service PowerShell module:

Import-Module ESIServicePSToolkit

2. Type this command and press Enter to get the current setting in minutes:

Get-EmcServicePolicy

3. Type this command, replacing 30 with the preferred number of minutes, and then
press Enter:

Managing storage with Microsoft SCOM

142 EMC Storage Integrator for Windows Suite 4.1  Product Guide



Set-EmcServicePolicy –RefreshIntervalInMinutes 30

ESI SCOM Management Packs overview
The ESI SCOM Management Packs enable you to manage EMC storage systems with
SCOM by providing consolidated and simplified dashboard views of storage entities.

These views enable you to:

l Discover and monitor the health status and events of your EMC storage systems and
system components in SCOM

l Receive alerts for any possible problems with disk drives, power supplies, storage
pools, and other types of physical and logical components in SCOM

The ESI SCOM Management packs include the following files:

l EMC.SI.Library.mp: Defines properties for supported storage systems and system
components and their relationships.

l EMC.SI.Discovery.mp: Contains all of the discoveries for all of the ESI storage
systems and system components. At a set interval, the ESI Service creates and
updates the collection of classes and relationships that are defined in the library. It
discovers all registered storage systems and all of their physical and logical
components. Collected data is stored in the System Center Operations Manager
database.

l EMC.SI.Monitoring.mp: Contains the monitors, rules, and diagnostics for the storage
systems and the physical and logical system components. These include disk drives,
power supplies, and logical components, such as storage pools and storage volumes.
It also monitors the available capacity of some components. Alerts generate when
abnormal conditions are detected or the available capacity limit has been reached for
a component. Data is stored in the System Center Operations Manager database and
data warehouse.

l EMC.SI.Presentation.mp: Presents all registered storage systems, systems
components, and view definitions that appear in the SCOM console.

l EMC.SI.Reporting.mp: Reports on the health and capacity of the storage systems and
system components. For example, you can view a report for available storage
capacity, storage pool capacity, and snapshot pool capacity in a storage
environment. You can also view a report on the most common alerts that were
generated during the previous week.

l EMC.SI.Customization.xml: Contains all of the overrides and customizations for your
specific storage environment. Import this management pack only during an initial
installation. If you import it again, you will lose all of your overrides and
customizations. The version number of this management pack is 1.0.0.0, which is
different from the other management packs. You can increment the version number
when you make changes.

Installing the ESI SCOM Management Packs
The ESI Zip file, which is available on EMC Online Support, contains the ESI SCOM
Management Packs installer. The management packs must be installed on the SCOM
Management Group that is connected to the ESI SCOM monitoring agents. The ESI SCOM
agents are connected to the same Windows domain as the ESI host system that has the
ESI Service installed.
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Installing and importing the ESI SCOM management packs

Procedure

1. On the SCOM Management Group server that is connected to the ESI SCOM agents,
download the ESI Zip file.

2. In the ESI Zip file, locate and double-click the ESI SCOM
ManagementPacks.*.Setup file.

The management pack files are installed by default to the C:\Program Files
(x86)\EMC\ESI SCOM Management Packs folder.

3. On the Administration tab of the SCOM console, right-click and click Export.

4. Export the EMC Storage Integrator Customization and EMC Storage
Integrator Exchange High Availability Extension Monitoring
Customization XML files.

5. If you are upgrading from ESI version 2.1, select all the EMC Storage Integrator
management packs, right-click, and then click Delete.

6. Import the latest version of each ESI management pack file in SCOM

Note

How to Import a Management Pack in Operations Manager 2007 and How to Import an
Operations Manager Management Pack on Microsoft TechNet for more details about
importing the management packs.

7. Right-click and click Import.

8. Import the EMC Storage Integrator Customization and EMC Storage
Integrator Exchange High Availability Extension Monitoring
Customization XML files that you exported in step 4 in SCOM.

Setting up ESI SCOM Management Packs
Before you begin

Ensure that you have completed the steps in Installing the ESI SCOM Management
packs on page 143.

Procedure

1. See Confirming the connection between SCOM agents and ESI Service on page 145 to
confirm the connection.

2. See Setting up the Run As profile for the EMC SI Monitoring account on page 145 to
access the ESI Service.

3. If necessary, set up optional overrides:

l If you have more than one SCOM agent connecting to one or more ESI Services,
see Setting up the system filter file on page 146 to set up the system filter file.

l To skip the client certificate error message for your specific setup, see Setting up
the ignore client certificate error override on page 148 to set the client certificate
error override.

l If the ESI Service must connect to the ESI Service with a web proxy server, see 
Setting up the HTTP proxy on page 147 to set up the HTTP proxy.
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4. Complete the steps in Setting up the required ESI Service Host override and
discovery on page 148 to set up the host and enable discovery of the ESI Service.

5. For additional monitoring of the ESI Service, see Setting up the ESI Service Monitoring
Account on page 145 to set up the monitoring account.

6. See Using the ESI Monitoring Management Pack on page 149 to set up the
management packs.

After you complete these setup steps, refer to Setting up optional management pack
overrides on page 155 for information about optional overrides.

Confirming the connection between SCOM agents and ESI Service
Before setting up the agents, confirm the connection between the SCOM agents and ESI
Service:

Procedure

1. On the SCOM Agent computer, open this link: https://<ESI Service IP>:HttpsPort/esi/
console/graph/Entities?class=StorageSystem. Replace ESI Service IP and HttpsPort
with the applicable values.

2. Confirm that the load time displayed at the bottom of the page is less than one
second. Repeat this step a few times for consistent results.

Setting up the Run As profile for the EMC SI Monitoring account
For the EMC SI Monitoring Account Run As profile, create and set up the Run As profile for
each SCOM agent that needs to connect to ESI Service. Refer to Microsoft TechNet for
detailed instructions.

To set up an EMC SI Monitoring Account Run As profile for a SCOM agent to connect to
each ESI Service:

Procedure

1. Create a Windows Run As account from the Windows account that is used in the
Monitoring Role for the ESI Service.

2. In the EMC SI Monitoring account, assign the Windows Run As account to the related
SCOM agent that will connect to the ESI Service.

Setting up the Run As profile for the EMC SI Service Monitoring account
You can set up an EMC SI Service (ESI Service) Monitoring account Run As profile to
monitor the ESI Windows Service. If you install a SCOM agent on the ESI controller host,
this agent can discover and monitor the health state of the ESI Service.

The SCOM agent periodically checks if the ESI Service is running and checks the
application event log for any events written by the ESI Service. This agent also raises
alerts if the ESI Service is not running, if any events that indicate problems with the ESI
Service occur, or if any expected events are not received.

Some errors are only detected and reported with a SCOM agent installed on the ESI host
controller.

If your SCOM environment uses a Default Action account that is a local administrator,
then the action account has the necessary settings.

However, if your SCOM environment uses a low privilege account as the Default Action
account, you might need to use a special account to monitor the ESI Service. If you do,
then you must work with a SCOM administrator to create the Run As account. You might
also need to create a Windows account to monitor the service.
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The SCOM account that monitors the ESI Service must have the Allow log on locally
enabled, which enables the account to read the Application Event log and use WMI
(Windows Management Instrumentation) to query the status of the service.

Refer to SCOM documentation on Microsoft TechNet for details on agent installation
considerations and instructions.

Setting up the SCOM agent registry
Before enabling the discovery of ESI Service, you must change Value to decimal 5120 in
the following registry key for each SCOM agent that will monitor EMC systems.

Procedure

1. Open Windows Registry Editor.

2. Locate the following subkey:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services
\HealthService\Parameters\Persistence Version Store Maximum
Type: REG_DWORD
Name: Persistence Version Store Maximum
Value: Number of 16-kilobyte pages

3. Change the value to decimal 5120.

Setting up optional ESI Service discovery overrides
Based on your specific environment, you can set up the following optional discovery
overrides for the ESI Service:

l Setting up a system filter file on page 146

l Setting up the HTTP proxy on page 147

l Changing the HTTPS to HTTP override on page 147

l  Setting the Ignore client certificate error override on page 148

l Setting basic authentication overrides on page 148

After setting up these optional overrides, then set up the required ESI Service Host
override.

Setting up a system filter file
If you are using more than one SCOM agent to connect to one or more ESI Services, set up
a system filter file for each SCOM agent. The filter file tells the SCOM agent which system
to monitor. This text file must be set up on each SCOM agent with the ESI Service
Registered Systems Friendly Name for all the supported systems. Confirm that each
system appears in a single list.

To set up the system filter file on a SCOM agent for an ESI Service:

1. On the SCOM agent, open Notepad.

2. Type the ESI Service Registered Systems Friendly Name of each supported system
being monitored by this agent. Use one name per line in the text file.

3. Save the file to a location on the SCOM agent machine. Confirm that the Windows
domain account set up in the Run As Account has at least read access to this file.

4. Enter the full path to this file in the Filter File Path override field for the ESI Service
Discovery management pack.
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Setting up the HTTP proxy
If the SCOM agent must connect to the ESI Service through a web proxy server, provide
the following information for the Proxy Server and Bypass List overrides in the EMC SI
Service Discovery for each related SCOM agent:

l Proxy server: proxy server string. For example:
proxy_server:80

l Bypass List: domain bypass list string. For example, the following represents that the
discovery can bypass the proxy server when the host name ends with .emc.com:
. *.emc.com

l If the overrides above are not set, then the proxy settings are obtained from the
registry. This assumes the proxy configuration tool, Proxycfg.exe has been run. If
Proxycfg.exe has not been run, then the ESI Service can be accessed directly.

Changing the HTTPS to HTTP override
The SCOM agent always tries to connect to the ESI Service by using an HTTPS connection.
By default, if the HTTPS connection fails, the SCOM agent cannot communicate with the
ESI Service.

If you want the ESI Service to connect with an HTTP connection instead of an HTTPS
connection, set the HTTPS to HTTP Override to True for the ESI Service connection.

Note

If you set up the override, secure the SCOM agents. With this override, SCOM sends the
username and password as text, which can be hijacked. This option is a data security
risk.

To change the HTTPS to HTTP override:

1. Open the SCOM Operations Console and connect to the SCOM Management Group.

2. From the menu bar, select Go > Authoring.

3. In the left pane, select Object Discoveries.

4. Locate and double-click the EMC SI Service Discovery.

5. Open the Overrides properties and select to Override > For a specific object of class:
Windows Computer.

6. In the Select Object dialog box, select the SCOM proxy agent that you want to
connect to the ESI Service, and then click OK.
The Override Properties page appears.

7. Select Override for the HTTPS to HTTP Fallback override to enable it.

8. Change the value of the Override Value field to True and click OK.

9. Click Close to save the change.
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Figure 2  HTTPS to HTTP Override

Setting the ignore client certificate error override
You can set an override to ignore the client certificate when the SCOM agent connects to
the ESI Service. To set up this override, follow the steps in Set up HTTPS to HTTP
override on page 147 and set the Ignore Certificate Error override to True.

Setting basic authentication overrides
If one or more SCOM agents are not on the same domain or trusted domain as the ESI
Service, use basic authentication. To use basic authentication, set up the User Name and
Password overrides for the EMC SI Service Discovery.

Note

This override is a data security risk, because SCOM stores the username and password as
text, so any user with SCOM console access or access to the file system on the agent can
view and hijack the account credentials. If you set up the basic authentication overrides,
secure the SCOM agents to avoid this risk.

Setting up the required ESI Service Host override and discovery
Set up the ESI Service Host override and enable the discovery of the ESI Service for each
SCOM agent.

Before you begin

Perform this procedure after:

l Setting up the SCOM agent registry on page 146

l Setting up optional management pack overrides on page 155

Procedure

1. Open the SCOM Operations Console and connect to the SCOM Management Group.
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2. From the menu bar, select Go > Authoring.

3. In the left pane, select Object Discoveries.

4. Locate and double-click EMC SI Service Discovery and the EMC SI Service Discovery
Properties page appears.

5. Click Overrides and select Override > For a specific object of class: Windows
Computer.

6. In the Select Object dialog box, select the SCOM proxy agent that you want to connect
to the ESI Service from the list and click OK.

The Override Properties page appears.

7. Confirm the Enabled parameter name override is selected and that the override value
is set to True.

8. Change the override value for the ESI Service Host parameter to the IP address of the
computer hosting the ESI Service.

9. If the default port number of 54500 or 54501 for the ESI Service has been changed,
change the port parameter default value to the correct port number.

10. In the Select destination management pack list box, select the EMC Storage
Integrator Customizations management pack.

11. Click Apply and confirm the changed values.

12. Click OK.

Note

If you change the Interval or Discovery Timeout (sec) values, discovery performance
might be affected.

13. After completing this setup, export and save a copy of the
EMC.SI.Customization.xml file as a backup of your customization values. If you
lose a needed customization, you can import this backup copy to recover your set
customizations. This file is installed with version number 1.0.0.0. You can increment
the version number when you make changes.

Note

How to Monitor Using Overrides on Microsoft TechNet provides more information about
creating overrides.

Using the ESI Monitoring Management Pack
The ESI Monitoring Management Pack can discover and monitor many different system
components using SCOM agents. The monitoring agent retrieves data from the ESI
Service by using a RESTful HTTPS connection, which in turn retrieves the data from the
supported (registered) systems. The monitoring data is added to the SCOM database.

The ESI Monitoring Management Pack views the components of EMC systems as a
topology map. The health of each level depends on the health of the components that roll
up to the component.

At the lowest level, the SCOM Management Group monitors the physical and logical
components, such as disk drives, power supplies, storage volumes, and virtual volumes.
The ESI management packs monitor the operational state of the components. For
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example, when one or more storage or virtual volumes are in an unhealthy state, then the
unhealthy state is rolled up to the storage groups containing the volumes.

The ESI Monitoring Management Pack provides the following monitors:

Monitor Action at the set interval

Monitoring physical component health on
page 152 check the health of the system
physical components, such as the disk
drives and power supplies.

Check the operational status of all of the physical
components of a specific class and raise alerts when
abnormal conditions are detected.

Monitoring logical component health on
page 154 check the health of the logical
components, such as the storage pools,
storage volumes, and virtual volumes.

Check the operational status of all of the logical
components of a specific class and raise alerts when
abnormal conditions are detected.

Monitoring capacity on page 154 check the
available capacity of a number of physical
and logical system components.

Check the available and subscribed capacity of the
components and issue alerts if limits are met or
exceeded. These monitors also collect data for SCOM
displays and reports.

Viewing monitors on page 155 and rule. Check the execution of the management pack
components and generate alerts when errors occur.

The EMC Storage Integrator Monitoring Management Pack monitors all systems that are
registered to the ESI Service and all of the physical and logical system components. The
following figure shows which system components are monitored and the health rollup
component relationships.

If you are supporting mission-critical applications on VMAX and VNX storage systems,
you can also set up fault monitoring, fault reporting, call home, and remote diagnostics
features to ensure redundancy for VNX and VMAX arrays.
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Figure 3  EMC System Components Monitored by the ESI Monitoring Management Pack
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Monitoring physical component health
When a warning or critical error occurs in a physical component, the health status of the
affected component changes and generates an alert. You can use the alert description
and product knowledge to troubleshoot the issue.

If a physical component fails and disappears from the data collected by ESI Service, an
alert is generated to investigate the failure. You can use this alert to determine the root
cause of a failure. You can also use the physical component count values that are stored
in the database to detect long term trends.

The following rules are available for each component:

l Two collection rules save the count values to the database (DB) and data warehouse
(DW) for the specified physical components of a specified class per parent instance.

l One warning alert is generated and updated in the active alerts folder in SCOM if a
physical-component count changes. If the alert rule for the specified physical
component is enabled, the rule collects data every 90 minutes and calculates the
total component count. Multiple alert generations are suppressed to reduce the
number of alerts generated for the same failure.
The first table below lists the collection and alert rules that are enabled by default
and the second table lists the rules that are disabled by default. The total counts for
enclosures and LUN storage service nodes includes all of the components in the class
hierarchy. The disabled rules are optional for investigating problem alerts. You can
enable one or more of the disabled rules when a physical component or hardware
problem requires investigation.

Table 5 Enabled component collection and alert rules

Physical component Enabled collection and alert rules

Enclosure EMC SI Enclosure Physical Components Total Count Collection Rule (DB)
EMC SI Enclosure Physical Components Total Count Collection Rule (DW)

EMC SI Enclosure Physical Components Total Count Alert Rule

LUN storage service node EMC SI LUN Storage Service Node Physical Components Total Count
Collection Rule (DB)
EMC SI LUN Storage Service Node Physical Components Total Count
Collection Rule (DW)

EMC SI LUN Storage Service Node Physical Components Total Count Alert
Rule

Cluster (VPLEX) EMC SI VPLEXCluster Count Collection (DB)
EMC SI VPLEXCluster Collection (DW)

EMC SI VPLEXCluster Alert Rule

Cooling component EMC SI Cooling Component Count Collection (DB)
EMC SI Cooling Component Count Collection (DW)

EMC SI Cooling Component Count Alert Rule

Disk drive EMC SI Disk Drive Count Collection(DB)
EMC SI Disk Drive Count Collection(DW)

EMC SI Disk Drive Count Alert Rule

Engine (VPLEX) EMC SI Engine Count Collection (DB)
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Table 5 Enabled component collection and alert rules (continued)

Physical component Enabled collection and alert rules

EMC SI Engine Count Collection (DW)

EMC SI Engine Count Alert Rule

FC storage port EMC SI Fc Storage Port Count Collection (DB)
EMC SI Fc Storage Port Count Collection (DW)

EMC SI Fc Storage Port Count Alert Rule

iSCSI storage port EMC SI ISCSI Storage Port Count Collection (DB)
EMC SI ISCSI Storage Port Count Collection (DW)

EMC SI ISCSI Storage Port Count Alert Rule

Link control card EMC SI Link Control Card Collection (DB)
EMC SI Link Control Card Collection (DW)

EMC SI Link Control Card Count Alert Rule

Memory module EMC SI Memory Module Count Collection (DB)
EMC SI Memory Module Count Collection (DW)

EMC SI Memory Module Count Alert Rule

Power supply EMC SI Power Supply Count Collection (DB)
EMC SI Power Supply Count Collection (DW)

EMC SI Power Supply Count Alert Rule

Table 6 Disabled component collection and alert rules

Physical component Disabled collection and alert rules

CPU module EMC SI CPU Module Count Collection (DB)
EMC SI CPU Module Count Collection (DW)

EMC SI CPU Module Count Alert Rule

Device EMC SI Storage Device Count Collection (DB)
EMC SI Storage Device Count Collection (DW)

EMC SI Storage Device Count Alert Rule

Extent (VPLEX) EMC SI Extent Count Collection (DB)
EMC SI Extent Count Collection (DW)

EMC SI Extent Count Alert Rule

I/O module EMC SI IO Module Count Collection (DB)
EMC SI IO Module Count Collection (DW)

EMC SI IO Module Count Alert Rule

Storage array (VPLEX
back-end storage system)

EMC SI Storage Array Collection (DB)
EMC SI Storage Array Collection (DW)

EMC SI Storage Array Alert Rule

Storage service node EMC SI Storage Service Node Count Collection (DB)
EMC SI Storage Service Node Count Collection (DW)
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Table 6 Disabled component collection and alert rules (continued)

Physical component Disabled collection and alert rules

EMC SI Storage Service Node Count Alert Rule

Storage volume EMC SI Storage Volume Count Collection (DB)
EMC SI Storage Volume Count Collection (DW)

EMC SI Storage Volume Count Alert Rule

Network switch EMC SI Network Switch Count Collection(DB)
EMC SI Network Switch Count Collection(DW)

EMC SI Network Switch Count Alert Rule

Unclassified port EMC SI Unclassified Port Count Collection (DB)
EMC SI Unclassified Port Count Collection (DW)

EMC SI Unclassified Port Count Alert Rule

Virtual volume (VPLEX) EMC SI Virtual Volume Count Collection (DB)
EMC SI Virtual Volume Count Collection (DW)

EMC SI Virtual Volume Count Alert Rule

Monitoring logical component health
When a warning or critical error occurs in a logical component (such as a storage or
virtual volume), the health state of the affected component changes and generates an
alert. You can use the alert description and product knowledge to decide what action is
necessary.

If a logical component fails and disappears from the data collected by ESI Service, an
alert is generated to investigate the failure. You can use this alert to determine root cause
of a failure. You can also use the logical component count values that are stored in the
database to detect long term trends.

The collection and alert rules that are enabled and disabled by default for system
components are described in Monitoring physical component health on page 152.

Monitoring capacity
The available capacity of storage and snapshot pools and groups are monitored. Alerts
are generated when certain thresholds are exceeded. These monitors allow a storage
administrator to ensure that adequate capacity is available on a system.

The following table shows the default thresholds for the capacity monitors. If the
thresholds are not appropriate for your environment, you can override them, either for all
instances of the monitors or for specific snapshot, storage pools, or virtual volume.

Table 7 Capacity monitoring threshold values:

Capacity monitors Warning Thresholds Error Thresholds

Snapshot Pool available
capacity

20% 10%

Storage Pool available capacity 20% 10%
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Table 7 Capacity monitoring threshold values: (continued)

Capacity monitors Warning Thresholds Error Thresholds

Storage Pool subscribed
capacity

70% 90%

Viewing monitors
In the Monitoring tab of the Operations Console, the EMC Storage Integrator folder
contains views for monitoring the supported systems and the ESI Service:

l The top Active Alerts view lists the open alerts for all of the systems.

l The Overall Topology view displays a hierarchical diagram of all the monitored
systems.

l The ESI Service Overall Health and the ESI Windows Service Overall Health views list
the health state and active alerts for the ESI Service and ESI Windows Service.

l Each physical and logical component has an Overall Health view showing health
state and active alerts.

l The Diagnostics folder contains views that are related to the health of the
management pack monitoring facilities. The Monitoring Delays, Errors and Timeouts
view displays events and alerts for monitoring failures, which include: ESI Service
authorization problems, communication timeouts, and problems with resource
availability on the monitoring agents. The other views display performance data for
the ESI Service. Some of the rules collecting this data are disabled by default, so
some data might be unavailable. If you have monitoring problems, EMC Support
might ask that you enable one or more of these rules for diagnostic tests.

Setting up monitoring maintenance mode
When a monitored object, such as a disk drive or power supply, goes offline for
maintenance, the ESI Service detects the condition and might generate numerous alerts
and notifications.

To prevent ESI Service and the ESI SCOM Management Packs from creating alerts and
notifications, you can set the monitored object to maintenance mode.

When an object is in maintenance mode, alerts, notifications, rules, monitors, automatic
responses, state changes, and new alerts are suppressed by SCOM.

For more information on setting a monitored object to maintenance mode in SCOM, refer
to How to Put a Monitored Object into Maintenance Mode in Operations Manager 2007 or
Operations Manager Maintenance Mode (for 2012) on Microsoft TechNet.

Setting up optional management pack overrides
You can use the procedures in this section to temporarily change intervals during a
customization or when making significant storage environment changes. You can also
use the following procedures to reduce network traffic and increase network performance
for your specific storage environment:

l Disabling performance data collection on page 156

l Changing discovery interval overrides on page 156
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l Changing monitoring interval overrides on page 157

After changing intervals and each time you make changes to your overrides and
customizations, export and save a copy of the EMC.SI.Customization.xml file as a backup
of your customization values. If you lose a needed customization, you can import this
backup copy to recover your specific customizations.

How to Monitor Using Overrides on Microsoft TechNet provides more information on
creating overrides.

Disabling performance data collection
To reduce network traffic or to improve performance on servers with slow WAN links,
disable the rules that collect performance data.

Each performance counter has two rules, one for the:

l Operational database

l Data warehouse

If you disable an operational database rule or data warehouse rule, you cannot view
performance data in the Operations console or in reports.

Note

You must enable the rules again before you use the views or run any performance data
reports.

Procedure

1. Open the SCOM Operations Console and connect to the SCOM Management Group.

2. Select Go > Authoring.

3. In the left pane, select Rules.

4. Change the scope to EMC SI Snapshot Pool and EMC SI Storage Pool.

5. Select and double-click the rule that you want to disable.

Note

The collection rules for the operational database include (DB) in the name. Collection
rules for the data warehouse include (DW) in the name.

6. Open the Override properties and select to edit the overrides for all objects of class.

7. Select the EMC Storage Integrator Customizations management pack.

8. Change the Enabled property to False.

9. Click Apply and verify the changed values.

10. Click OK, and then click Close.

11. Repeat this procedure for each rule that you want to disable.

Changing discovery interval overrides
When you install a new system or make changes to an existing system, the ESI Service
takes a set amount of time to send these changes to the ESI management packs on the
SCOM agents.

To trigger the discovery of new changes, you can toggle the Enabled override setting for
the EMC SI Service Discovery:
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Procedure

1. Open the Override Properties window for the EMC SI Service Discovery.

2. Clear the Enabled override check box and click Apply.

3. Then, before closing the window, select the Enabled override check box to reset the
override. This triggers the discovery of all changes to components regardless of the
interval values.

The default intervals for the discovery of new components vary depending on the
component. If you want SCOM to discover newly added components more quickly
than the set interval, you can temporarily change the interval setting. Then you can
see the changes more quickly in SCOM. And after the changes are discovered, you can
change it back to the preferred setting for your storage environment.

To change the discovery interval:

4. Open the SCOM Operations Console and connect to the SCOM Management Group.

5. Select Go > Authoring.

6. In the left pane, select Object Discoveries.

7. Locate and double-click the EMC Discovery for the desired object class.

8. Open the Override properties and select to edit the overrides for all objects of class.

9. Change the Interval (sec) property to the preferred value. The default values vary
depending on the specific object  or component.

Note

 

l You can temporarily reduce the interval to 600 or more seconds (10 minutes) to
enable quick discovery of new components.

l Do not change the Discovery Timeout (sec) value. If you reduce it, discoveries can
fail before all of the data is retrieved. If you increase it, performance problems can
occur.

10. Select the EMC Storage Integrator Customizations management pack.

11. Click Apply and verify the changed values.

12. Click OK, and then click Close.

Changing monitoring interval overrides
By default, the monitors communicate with the ESI Service approximately every six
minutes to check the status of the systems. In a large storage environment, the ESI
controller host, the SCOM agent, or the SCOM Management Group machines might
experience a resource (CPU or memory capacity) shortage. Increasing the monitoring
interval alleviates this type of shortage.

The ESI Service interval setting combined with the ESI Service system refresh interval
number is the maximum frequency for receiving monitor updates in SCOM. For example,
with this interval set to 600 seconds (about 10 minutes) and the ESI Service system
refresh interval set to 30 minutes, an updated health state can take up to 40 minutes.
The time intervals can affect the data performance. Changing the system refresh
interval on page 142 provides details on the ESI Service interval.

Refer to How to Monitor Using Overrides on Microsoft TechNet for more details.
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Procedure

1. Open the SCOM Operations Console and connect to the SCOM Management Group.

2. From the menu bar, select Go > Authoring or select Authoring from the lower left pane.

3. From the left pane, select Monitors.

4. Locate and double-click the EMC component and monitor that you want to change.

5. Open the Overrides properties and select one of the following choices:

l For all objects of class: to override the rule for all objects

l For a specific object of class: to override for a specific object.

6. Select the EMC Storage Integrator Customizations management pack.

7. Change the Interval (sec) property to your preferred time. The default value is 600
seconds (about 10 minutes).

8. Click Apply and verify the changed values.

Note

Do not change the Timeout Value (sec). If you reduce it, monitors can fail before all of
the data is retrieved. If you increase it, performance problems can occur.
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CHAPTER 15

Managing storage with the PowerShell Toolkits

This chapter contains the following topics:
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Getting started with the ESI PowerShell toolkits
ESI for Windows includes:

l ESI PowerShell Toolkit

l ESI Service PowerShell Toolkit

The toolkits are written for the PowerShell platform, which is developed by Microsoft
specifically for Windows System Management automation.

ESI PowerShell Toolkit
The ESI PowerShell Toolkit enables you to provision and manage storage to Microsoft
Windows hosts that use EMC storage. This toolkit includes a set of PowerShell cmdlets to
manage EMC storage systems from the PowerShell command line. The ESI PowerShell
Toolkit provides access to most of the provisioning functionality offered by the ESI MMC
application and shares a common configuration set with the MMC application.

The ESI PowerShell Toolkit provides cmdlets provision block storage and to manage:

l Connections to host and storage systems

l Disk devices in hypervisor environments, such as VMware vSphere and Microsoft
Hyper-V

l Block device snapshots for EMC VNX, VNXe, and Unity storage systems

l XtremIO snapshots and RecoverPoint profiles

ESI PowerShell commandlets list on page 165 provides links to the cmdlets based on
functionality.

ESI Service PowerShell Toolkit
The ESI Service PowerShell Toolkit provides cmdlets for setting up the ESI Service for use
with the ESI System Center Operations Manager (SCOM) Management Packs.

The toolkit provides cmdlets for setting up the ESI Service to:

l Get the storage system entity data and entity relationships for the entity graph.

l Configure service security.

l Register EMC storage systems.

System prerequisites
The ESI PowerShell Toolkit is installed as part of the ESI product. The ESI Service
PowerShell Toolkit is installed when you install the ESI Service. The toolkits have the
same system prerequisites as ESI, including that a supported version of Microsoft
Windows PowerShell be installed and enabled as a Windows feature on each system that
is running the toolkit.

Getting help at the command line
Detailed cmdlet information is available at the command line.

To view cmdlet details at the command line, type the following from the Windows
PowerShell command line, replacing cmdlet name with a specific cmdlet name:

get-help cmdlet name -full
For example, to get help about the Get-EmcLun cmdlet, at the PowerShell command
line, type:
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get-help Get-EmcLun -full

Importing the modules
To use the ESI PowerShell toolkits, with Windows Server 2008 R2, you must run the
toolkit launcher and then import the corresponding toolkit module. With Windows Server
2012, modules are imported automatically and you can omit this step.

Run the launcher and import the ESI PowerShell Toolkit
During the core ESI installation, the ESI PowerShell Toolkit is installed on the same
system in a default EMC folder.

To run the launcher and import the ESI PowerShell Toolkit module:

Procedure

1. Open a Windows PowerShell command prompt in either the interactive or scripting
environment.

2. At the PS C:\> command prompt, type the following and press Enter to run each
command separately:

cd "C:\Program Files\EMC\EMC Storage Integrator\ESIPSToolKit" .
\ESIPSToolKitLauncher.ps1 import-module ESIPSToolkit

Import the ESI Service PowerShell Toolkit
During the ESI installation, when you select to install the ESI Service, the ESI Service
PowerShell Toolkit is installed on the same system in a default EMC folder.

To import the ESI Service PowerShell Toolkit module:

Procedure

1. Open a Windows PowerShell command prompt in either the interactive or scripting
environment.

2. At the PowerShell C:\> command prompt, type the following and press Enter to run
each command separately:

cd "C:\Program Files\EMC\EMC Storage Integrator
\ESIServicePSToolKit" import-module ESIServicePSToolkit

Using PowerShell objects
The ESI PowerShell toolkits accept objects as inputs, which can be standard objects,
such as strings and integers. In many instances, these inputs have useful properties that
can be accessed using dot notation. A full list of these objects and their properties is
beyond the scope of this topic.

Defining and accessing variables
PowerShell enables you to create objects and store them in variables. For example, an
ESI LUN object can be created and stored in a variable by using the Get-EmcLun
command:

$lun = Get-EmcLun “My LUN”
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This LUN object is used with the Set-EmcLunAccess cmdlet to present the LUN to a
host:

Set-EmcLunAccess –LUN $lun –HostSystem $myhost -Available

Retrieving object information
Use the Get-Member cmdlet to access information about the properties and methods
supported by an object. The Get-Member cmdlet accepts pipeline inputs. You can pipe
an object returned by a cmdlet to Get-Member to determine the properties and methods
of the object.

Standard object descriptions
The following table lists common PowerShell objects.

Object Description

Boolean Represents a true or false value. For true, type 1 or $true. For
false, type 1 or $false.

Int32 Represents a 32-bit signed integer. Signed integers are either
positive or negative.

Int64 Represents a 64-bit signed integer. Signed integers are either
positive or negative.

SecureString Represents an encrypted string for private data.

String Represents a set of alphanumeric characters. A string that
contains the space character must be enclosed by quotation
marks. For example:
Get-EmcLun “My Basic LUN”

UInt32 Represents a 32-bit unsigned integer. Unsigned integers cannot
be negative.

UInt64 Represents a 64-bit unsigned integer. Unsigned integers cannot
be negative.

Examples

Provisioning a new storage volume
The following script is an example of how to:

l Create a new 100 GB thin LUN on a VNX storage pool.
l Present the LUN to a Windows 2008 R2 host and initialize the disk.
l Create an NTFS volume and mount it on an available drive letter. The following

example requires that the storage system and host are connected and available.

Example script
PS C:\Users\administrator.BROOKSDOM> import-module esipstoolkit
PS C:\Users\administrator.BROOKSDOM> $pool = Get-EmcStoragePool
"VM Pool"
Block storage system: [Name = APM00111102550. UserFriendlyName
= VNX5100]. Lun Pools are not initialized. Refreshing Lun
Pools.
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PS C:\Users\administrator.BROOKSDOM> $system = Get-
EmcHostSystem NEC-BLADE6
PS C:\Users\administrator.BROOKSDOM> $lun = New-EmcLun -Pool
$pool -CapacityInMB 102400 -Thin
TaskStatus: Started
10% : Creating the LUN...
100% : The specified LUN has been created...
TaskStatus: Completed
PS C:\Users\administrator.BROOKSDOM> Set-EmcLunAccess -Lun $lun
-HostSystem $system -Available
TaskStatus: Started
10% : Unmasking the LUN to the specified host(s)...
100% : The specified LUN has been unmasked to the specified
initiators...
TaskStatus: Completed
PS C:\Users\administrator.BROOKSDOM> $hdisk=Get-EmcHostDisk -
Host: NEC-BLADE6. Refreshing MultiPath software information.
Host: NEC-BLADE6. Retrieving disk information from Virtual Disk
Service.
WARNING: Unable to find host disk(s) with the given parameters
PS C:\Users\administrator.BROOKSDOM> $hdisk=Get-EmcHostDisk -
HostSystem $system -Lun $lun
PS C:\Users\administrator.BROOKSDOM> Initialize-EmcHostDisk -
HostSystem $system -HostDisk $hdisk -PartitionStyle GPT
TaskStatus: Started
10% : Initializing the disk...
100% : The specified disk has been initialized...
TaskStatus: Completed
PS C:\Users\administrator.BROOKSDOM> $vol =New-EmcVolume -
HostSystem $system -HostDisk $hdisk -FileSystemType NTFS -Labe
l TestVolume
TaskStatus: Started
10% : Provisioning the volume...
100% : The specified volume has been provisioned...
TaskStatus: Completed
PS C:\Users\administrator.BROOKSDOM> Get-
EmcAvailableDriveLetter -HostSystem $system
A, B, D, E, F, … (up to Z, except for default C)
PS C:\Users\administrator.BROOKSDOM> Set-EmcVolumeMountPoint -
HostSystem $system -Volume $vol -DriveLetter Z
TaskStatus: Started
10% : Mounting the volume...
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100% : The specified volume has been mounted...
TaskStatus: Completed
PS C:\Users\administrator.BROOKSDOM>

Removing a storage volume
Remove a volume from a host and delete the LUN where it resides.

Because the LUN identity might be unknown, map the Windows volume to the storage
LUN.

Example script

PS C:\Users\administrator.BROOKSDOM> import-module esipstoolkit
PS C:\Users\administrator.BROOKSDOM> $system = Get-EmcHostSystem NEC-
BLADE6
PS C:\Users\administrator.BROOKSDOM> $vol = Get-EmcHostVolume -
HostSystem $system -ID TestVolume
Host: NEC-BLADE6. Refreshing MultiPath software information.
Host: NEC-BLADE6. Retrieving disk information from Virtual Disk
Service.
PS C:\Users\administrator.BROOKSDOM> $hdisk = Get-EmcHostDisk -Volume
$vol
PS C:\Users\administrator.BROOKSDOM> $lun = Get-EmcLUN -HostDisk
$hdisk

Associating the specified host disk with its corresponding storage 
system...
PS C:\Users\administrator.BROOKSDOM> Remove-EmcVolumeMountPoint -
HostSystem $system -Volume $vol
TaskStatus: Started
10% : Unmounting the volume...
100% : The specified volume has been unmounted...
TaskStatus: Completed

PS C:\Users\administrator.BROOKSDOM> Set-EmcHostDiskOnlineState -
HostDisk $hdisk -Offline

TaskStatus: Started
10% : Bringing the disk offline...
100% : The specified disk has been brought offline...
TaskStatus: Completed

PS C:\Users\administrator.BROOKSDOM> Set-EmcLunAccess -HostSystem
$system -Lun $lun -Unavailable

TaskStatus: Started
10% : Masking the LUN from the initiators...
100% : The specified LUN has been masked from the specified 
initiators...
TaskStatus: Completed
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PS C:\Users\administrator.BROOKSDOM> Update-EmcSystem -HostSystem
$system

Refreshing disks of host system '[Name: NEC-BLADE6, IP address: 
172.20.1.106.]'
Host: NEC-BLADE6. Refreshing MultiPath software information.
Host: NEC-BLADE6. Retrieving disk information from Virtual Disk 
Service.

PS C:\Users\administrator.BROOKSDOM> Remove-EmcLun -Lun $lun

Confirm
Are you sure you want to perform this action?
Performing operation "Remove-EmcLun" on Target "LUN 44".
[Y] Yes  [A] Yes to All  [N] No  [L] No to All  [S] Suspend  [?] Help 
(default is "Y"):  

y

TaskStatus: Started
10% : Destroying the LUN...
100% : The specified LUN has been destroyed...PS C:\Users
\administrator.BROOKSDOM>
TaskStatus: Completed

ESI PowerShell cmdlet list
This topic lists the available ESI PowerShell cmdlets, grouped by operation type.

To get syntax, parameters, and examples for a specific cmdlets, type the following at the
PowerShell command prompt:

get-help cmdlet name -full
The cmdlets support these operations:

l Connection operations on page 165

l Storage system operations on page 167

l Host operations on page 173

l Hypervisor operations on page 174

l Application operations on page 175

l AppSync replication operations on page 176

l RecoverPoint replication operations on page 177

l ESI Service operations on page 178

Powershell cmdlets connection operations
Connect-EmcSystem

Connects or adds the host, cluster, and storage systems to ESI. The Connect-
EmcSystem cmdlet is used to connect the host, cluster, and storage systems to ESI
from the specified creation BLOB. You can use this cmdlet along with the Get-
EmcHostSystemCredential, Get-EmcClusterSystemCredential, and Get-
EmcStorageSystemCredential cmdlets to get the creation BLOB.

Disable-EmcPublisherCertificateValidation
Disables server SSL certificate validation when using SSL to communicate with the
specified ESI service. The publish commands use a secure channel (SSL) when
connecting to the specified ESI service by specifying an HTTPS URL in the Set-
EmcPublisherEndpointUrl cmdlet or via the -ServiceURL parameter. This command
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disables the validation of the server certificate while establishing the SSL
connection. This is necessary if the specified ESI service is configured to use a self-
signed certificate.

Enable-EmcPublisherCertificateValidation
Enables server Disconnect-EmcHostSystemSSL certificate validation when using SSL
to communicate with the specified ESI service. The publish commands use a secured
channel (SSL) when connecting to the specified ESI service by specifying an HTTPS
URL in the Set-EmcPublisherEndpointUrl cmdlet or via the -ServiceURL parameter.
This command disables the validation of the server certificate while establishing the
SSL connection. This is necessary if the specified ESI service is configured to use a
self-signed certificate.

Disconnect-EmcClusterSystem
Disconnects cluster systems.

Disconnect-EmcHostSystem
Disconnect host systems.

Disconnect-EMCStorageSystem
Disconnects storage systems.

Disconnect-EMCSystem
Disconnects clusters, hosts, and storage systems.

Get-EmcClusterSystemCredential
Gets the encrypted connection string or BLOB, based on the specified parameters.
You can use this cmdlet with the Connect-EmcSystem cmdlet to connect cluster
systems to ESI. The Get-EmcClusterSystemCredential cmdlet creates a BLOB or
encrypted string based on the specified parameters. The cmdlet prompts you to
specify the cluster name, IP address, and credentials. The cmdlet then creates a
BLOB with these credentials. You can use the BLOB to connect cluster systems to ESI
by using the Connect-EmcSystem cmdlet. You can also click Test Connection in ESI
to test the connection with the specified parameters. Current Credential is selected
by default for authentication. If you are using another credential, click Specify
Credential and type the username and password.

Get-EmcLinuxHostSystemCredential
Gets the encrypted connection string or BLOB, based on the specified connection
(system object creation) parameters for a Linux system. You can use the BLOB with
the Connect-EmcSystem cmdlet to connect or add Linux host systems to ESI. You can
use the BLOB with the Connect-EmcSystem cmdlet to connect or add Linux host
systems to ESI. This cmdlet creates a BLOB (encrypted string) from the specified
connection (system object creation) parameters. It prompts the user for host name,
IP address, and connection. Use the BLOB to connect or add a Linux host system to
ESI with the Connect-EmcSystem cmdlet. Password authentication is a default
selection. If you are using key-based authentication, then use the key-based
username, file path, and pass phrase.

Get-EmcPublisherConnectionInfo
Gets the list of systems currently registered with the specified ESI service.

Get-EmcPublisherEndpointOptions
Gets the current options used to connect to the specified ESI service.

Get-EmcPublisherSupportedSystem
Gets all the system types that are available for registration with the specified ESI
service.

Get-EmcHostSystemCredential
Gets the encrypted connection or system object creation parameters BLOB, which
you can use along with the Connect-EmcSystem cmdlet to connect host systems to
ESI.

Get-EmcStorageIntegratorVersion
Gets the specific software version of ESI that is installed. This cmdlet gets EMC
Storage Integrator version details including: product name, product version, and
company name.
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Get-EmcStorageSystemCredential
Gets the encrypted connection or system object creation parameters BLOB, which is
used along with the Connect-EmcSystem cmdlet to connect storage systems to ESI.

Get-EmcSupportedSystemsCreationRequirement
Gets the list of creational parameters required to add or connect to a system in ESI.

Publish-EmcPublisherConnectionInfo
Publishes the connection information of the specified system to the specified ESI
service.

Publish-EmcPublisherUserConnectionInfo
Publishes the connection information for the specified system to the specified user.

Set-EmcPublisherEndpointUrl
Sets the URL to the specified ESI service on the current session.

Test-EmcSystemConnectedToBlockStorageSystem
Verifies the connectivity of a host system or replication system to a block storage
system. This cmdlet only works with VNX and VMAX block storage systems. The
cmdlet does not work with VNXe storage systems.

Unpublish-EmcPublisherConnectionInfo
Unpublishes the connection information for the specified system to the specified ESI
service. This cmdlet unregisters the specified system from the specified ESI service.

Update-EmcSystem
Updates the specified host, storage, or cluster systems. The Update-EMCSystem
cmdlet updates the specified host, cluster, or storage systems. For the host system,
the cmdlet updates the host disks. For the cluster system, it updates the cluster
disks. For the block storage system, it updates the LUNs.

Powershell cmdlets storage system operations
This section lists FAST VP, Meta management, and general storage system operations.

FAST VP Operations

Add-EmcFastVpPolicy
Adds or associates the specified storage group to the specified FAST VP policy.

Add-EmcLunsToVmaxStorageGroup
Adds one or more LUNs to the specified VMAX storage group. Clears the host disk
signatures and assigns new ones.

Get-EmcFastVpPolicy
Gets the FAST VP policies that are associated with the specified storage system or
VMAX storage group.

Get-EmcStorageTier
Gets the storage tiers for the specified storage system or the specified FAST VP
policy.

Get-EmcVmaxStorageGroup
Gets all storage groups for the specified VMAX storage system.

New-EmcVmaxSnapshot
Creates a VMAX3 snapshot.

New-EmcVmaxStorageGroup
Adds LUNs to the specified VMAX storage group.

Remove-EmcFastVpPolicy
Removes the specified FAST VP policy from the specified storage groups.

Remove-EmcLunsFromVmaxStorageGroup
Removes LUNs from a VMAX storage group.

Remove-EmcVmaxSnapshot
Removes or deletes the specified VMAX3 snapshot.

Restore-EmcVmaxSnapshot
Restores a VMAX3 snapshot back to its source.

Remove-EmcVmaxStorageGroup
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Deletes the specified storage group that is not associated to any FAST VP policies.

Meta management operations

Expand-EmcCompositeLun
Expands capacity of the composite LUN.

Get-EmcAvailableCandidatesForLunComposition
Gets all the LUNs which are qualified to be a member LUN of the specified meta,
meta volume, or composite LUN.

Get-EmcCompositeLun
Gets all composite LUNs from the specified storage system.

Get-EmcCompositeLunMember
Gets one or more meta or composite LUN members of the specified composite LUN
head.

Get-EmcUnboundLun
Gets all the unbound LUNs that are not bound to any storage pool from the specified
storage system.

New-EmcCompositeLun
Creates a meta or composite LUN from the specified LUNs. To compose or form a
meta or composite LUN, at least two LUNs are required and the first LUN becomes
the metahead.

Remove-EmcCompositeLun
Removes (destroys) the composite LUN from the storage system.

General storage system operations

Add-EmcUnityConsistencyGroupMember
Adds one or more members to a consistency group. A consistency group has three
types of members: LUNs, hosts that have access to LUNs in the group, and hosts
that have access to snapshots of LUNs in the group. This command is used to add
any of these members to the consistency group. This command is applicable only for
Unity systems.

Add-EmcVnxeLunGroupMember
Adds one or more members to a LUN group. A LUN group has three types of
members: LUNs, hosts that have access to LUNs in the group, and hosts that have
access to snapshots of LUNs in the group. This command is used to add any of these
members to the LUN group. This command is applicable only for VNXe3200 systems.

Add-EmcVplexConsistencyGroupVirtualVolume
Adds a VPLEX virtual volume to a specified VPLEX consistency group.

Add-EmcXtremIOTagEntity
Adds the specified tag to the specified consistency groups, initiators, initiator
groups, snapshots, snapshot sets, and volumes .

Copy-EmcVnxAdvancedSnapshot
Copies VNX advanced snapshot to a new VNX advanced snapshot.

Dismount-EmcUnitySnapshot
Dismounts a Unity LUN or Consistency group snapshot to prevent host access.

Dismount-EmcVnxAdvancedSnapshot
Dismounts or detaches the VNX advanced snapshot with its associated snapshot
mount point LUN.

Dismount-EmcVnxeSnapshot
Dismounts a VNXe LUN or LUN group snapshot to prevent host access.

Expand-EmcFileBasedDisk
Expands the size of a file-based disk.

Expand-EmcLun
Expands the capacity of a LUN.

Expand-EmcVNXSharedFolderPool
Expands the capacity of a Shared Folder Pool. This command applies to Shared
Folder Pools on a VNX file system.
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Get-EmcLun
Gets the list of LUNs for the specified storage system or systems.

Get-EmcLunMaskingView
Gets a list of LUN masking views. A LUN masking view object contains the
information that a set of LUNs are unmasked to a set of initiators and the
corresponding HLU (host logical unit) information of the unmasked LUNs with
respect to those initiators.

Get-EmcScsiLun
Gets the list of VMware SCSI LUNs.

Get-EmcSharedFolder
Gets the list of shared folders available from a file storage system.

Get-EmcSnapshotLun
Gets the list of snapshot LUNs.

Get-EmcSnapshotPool
Gets the list of snapshot pools. This cmdlet is not supported for XtremIO systems.

Get-EmcStoragePool
Gets the list of storage pools. For VNX File storage pools, use Get-
EmcVNXFileStoragePools.

Get-EmcStorageRegisteredHost
Gets a list of registered hosts for a specified storage system. This cmdlet is not
supported for VMAX storage systems.

Get-EmcStorageRegisteredInitiator
Gets the list of host initiators that are registered on the storage systems. This cmdlet
is not supported for VMAX storage systems.

Get-EmcStorageServiceNode
Gets the list of storage service nodes.

Get-EmcStorageSystem
Gets the list of storage systems.

Get-EmcSupportedSystem
Gets the list of supported systems.

Get-EmcUnityConsistencyGroup
Gets consistency groups on the connected Unity systems. Consistency groups
enable consistent snapshots of multiple LUNs and are used to grant hosts access to
LUNs and to snapshots of LUNs in the group.

Get-EmcUnityConsistencyGroupMember
Gets the members of a consistency group. A consistency group has three types of
members: LUNs, hosts that have access to LUNs in the group, and hosts that have
access to snapshots of LUNs in the group. The -IncludeLuns, -IncludeLunHosts, and -
IncludeSnapshotHosts parameters return only those specific types of members. If
omitted, the cmdlet returns all member types.

Get-EmcUnityFileSystem
Gets the file systems on connected Unity systems. File systems contain shares which
are exposed to hosts. They are allocated from pools and hosted in NAS servers. This
command is for Unity systems only.

Get-EmcUnitySnapshot
Gets the snapshots on connected Unity systems. You can retrieve snapshots of a
particular source LUN or consistency group with the Source parameter.

Get-EmcTargetPort
Gets the list of target ports.

Get-EmcVnxAdvancedSnapshot
Gets the list of VNX advanced snapshots.

Get-EmcVnxAdvancedSnapshotMountPoint
Gets the list of VNX advanced snapshot mount points.

Get-EmcVnxeFileSystem
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Gets the file systems on connected VNXe3200 systems. File systems contain shares
which are exposed to hosts. They are allocated from pools and hosted in NAS
servers. This command is for VNXe3200 systems only.

Get-EmcVnxeLunGroup
Gets LUN groups on the connected VNXe systems. LUN groups enable consistent
snapshots of multiple LUNs and are used to grant hosts access to LUNs and to
snapshots of LUNs in the group.

Get-EmcVnxeLunGroupMember
Gets the members of a LUN group. A LUN group has three types of members: LUNs,
hosts that have access to LUNs in the group, and hosts that have access to
snapshots of LUNs in the group. The -IncludeLuns, -IncludeLunHosts, and -
IncludeSnapshotHosts parameters return only those specific types of members. If
omitted, the cmdlet returns all member types.

Get-EmcVnxeSnapshot
Gets the snapshots on connected VNXe systems. You can retrieve snapshots of a
particular source LUN or LUN group with the Source parameter.

Get-EmcVNXFileStoragePool
Gets the list of VNX file storage pools used by the VNX storage system to provision
shared folder pools. Applies to VNX arrays only.

Get-EmcVplexClusters
Gets VPLEX clusters on the connected VPLEX systems.

Get-EmcVplexConsistencyGroup
Gets VPLEX consistency groups on the connected VPLEX systems.

Get-EmcVplexInitiators
Gets VPLEX initiators on the connected VPLEX systems.

Get-EmcVplexPorts
Gets VPLEX ports on the connected VPLEX systems.

Get-EmcVplexServiceNodes
Gets VPLEX service nodes on the connected VPLEX systems.

Get-EmcVplexStorageViews
Gets VPLEX storage views on the connected VPLEX systems.

Get-EmcVplexVirtualVolume
Gets VPLEX virtual volumes on the connected VPLEX systems.

Get-EmcXtremIOXBrick
Gets a list of X-Brick information from the XtremIO storage system.

Get-EmcXtremIOInitiator
Gets a list of initiators for the specified XtremIO storage system.

Get-EmcXtremIOInitiatorGroup
Gets a list of initiator groups for the specified XtremIO storage system.

Get-XtremIOSnapshotScheduler
Gets all the schedulers from the XtremIO storage array

Get-EmcXtremIOSnapshotSet
Gets the list of snapshot sets for the specified XtremIO system.

Get-EmcXtremIOTag
Gets all the tags from the XtremIO storage array.

Get-EmcXtremIOTagVolume
Gets all tags associated with the specified volume.

Mount-EmcUnitySnapshot
Mounts a Unity LUN or consistency group snapshot so it is visible to hosts in the
snapshot access list for the LUN or consistency group.

Mount-EmcVnxAdvancedSnapshot
Mounts/attaches the VNX advanced snapshot with the specified snapshot mount
point LUN.

Mount-EmcVnxeSnapshot
Mounts a VNXe LUN or LUN group snapshot so it is visible to hosts in the snapshot
access list for the LUN or LUN group.
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New-EmcLun
Creates an ESI LUN object.

New-EmcSharedFolder
Creates a file shared folder object.

New-EmcSnapshotLun
Creates a snapshot LUN. For XtremIO systems, ignore the SnapshotPool and
Retention parameters.

New-EmcStorageRegisteredHost
Registers a host for a specified storage system.

New-EmcStorageRegisteredInitiator
Registers a host initiator on a specified storage system.

New-EmcUnityConsistencyGroup
Creates a consistency group on a Unity system. Consistency groups enable
consistent snapshots of multiple LUNs and are used to grant hosts access to LUNs
and snapshots of LUNs in the group.

New-EmcUnitySnapshot
Creates a snapshot on a Unity system. Unity allows snapshots of LUNs, consistency
groups, and file systems.

New-EmcVnxAdvancedSnapshot
Creates a VNX advanced snapshot from a Lun and snapshot mount point (SMP).

New-EmcVnxAdvancedSnapshotMountPoint
Creates a VNX advanced snapshot mount LUN from a source LUN.

New-EmcVnxeLunGroup
Creates a LUN group on a VNXe system. LUN groups enable consistent snapshots of
multiple LUNs and are used to grant hosts access to LUNs and snapshots of LUNs in
the group.

New-EmcVnxeSnapshot
Creates a snapshot on a VNXe system. VNXe allows snapshots of LUNs, LUN groups,
and file systems.

New-EmcVNXSharedFolderPool
Creates a VNX file storage shared folder pool object.

New-EmcVplexConsistencyGroup
Creates a consistency group on a VPLEX system.

New-EmcVplexDistributedVirtualVolume
Creates a VPLEX distributed virtual volume on the connected VPLEX systems.

New-EmcVplexLocalVirtualVolume
Creates a VPLEX local virtual volume on the connected VPLEX systems.

New-EMCXtremIOSnapshotScheduler
Creates a scheduler with the specified properties.

New-EmcXtremIOSnapshotSet
Creates a snapshot set from a single volume, multiple volumes, a consistency group,
or snapshot set.

New-EmcXtremIOTag
Creates a tag with the specified name.

Register-EmcVplexInitiators
Registers or unregisters a specified initiator on the connected VPLEX systems.

Register-EmcVplexVirtualVolume
Registers a specified virtual volume on the connected VPLEX systems.

Remove-EmcCifsSharedFolderMountPoint
Removes or unmounts a specified shared folder.

Remove-EmcFileBasedDisk
Deletes a file-based disk from a hypervisor.

Remove-EmcLun
Removes or destroys the LUN from the storage system.

Remove-EmcSharedFolder
Removes or destroys the shared folder from the storage system.
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Remove-EmcSnapshotLun
Removes the snapshot LUN.

Remove-EmcStorageRegisteredHost
Removes the registered host from the storage system where it is registered.

Remove-EmcStorageRegisteredInitiator
Removes the specified host initiator from the storage system where the initiator host
is registered.

Remove-EmcUnityConsistencyGroup
Deletes a consistency group from a Unity system.

Remove-EmcUnityConsistencyGroupMember
Removes one or more members from a consistency group. This command is used to
remove LUNs, LUN access hosts, or snapshot access hosts from a consistency group
from a Unity system.

Remove-EmcUnitySnapshot
Deletes a snapshot from a Unity system.

Remove-EmcVnxAdvancedSnapshot
Removes or deletes the specified VNX advanced snapshot.

Remove-EmcVnxeLunGroup
Deletes a LUN group from a VNXe system.

Remove-EmcVnxeLunGroupMember
Removes one or more members from a LUN group. This command is used to remove
LUNs, LUN access hosts, or snapshot access hosts from a LUN group.

Remove-EmcVnxeSnapshot
Deletes a snapshot from a VNXe system.

Remove-EmcVNXSharedFolderPool
Removes or destroys the shared folder pool for a specified VNX storage system.

Remove-EmcVplexConsistencyGroup
Deletes a consistency group from a VPLEX system.

Remove-EmcVplexConsistencyGroupVirtualVolume
Deletes specified virtual volumes from a VPLEX consistency group.

Remove-EmcVplexVirtualVolume
Deletes specified virtual volumes from a VPLEXsystem.

Remove-EMCXtremIOSnapshotScheduler
Removes the scheduler from the list of schedulers on the XtremIO array.

Remove-EmcXtremIOSnapshotSet
Removes a snapshot set from a specified XtremIO system. Removing a snapshot set
deletes all the snapshot volumes associated with the snapshot set.

Remove-EmcXtremIOTag
Removes the specified tag from the list of tags.

Remove-EmcXtremIOTagVolume
Removes the specified tag from the specified volume.

Restore-EmcSnapshotLun
Restores a snapshot LUN.

Restore-EmcUnitySnapshot
Restores a Unity snapshot back to its source.

Restore-EmcVnxAdvancedSnapshot
Restores the VNX advanced snapshot to source LUN.

Restore-EmcVnxeSnapshot
Restores a VNXe snapshot back to its source.

Restore-EmcXtremIOSnapshots
This command is used to reassign or restore a snapshot, volume, consistency group,
or snapshot set, and to create a backup of snapshots if required.

Set-EmcCIFSSharedFolderMountPoint
Mounts a shared folder onto a host system.

Set-EmcLun
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Sets the storage service node for the specified LUN. For VNX storage systems only, it
sets the storage tiering policy and LUN compression and compression rate for the
specified LUN.

Set-EmcLunAccess
Masks or unmasks a LUN to a host, cluster, FC, or iSCSI initiator.

Set-EmcVNXLunAllocationPolicy
Modifies the VNX Allocation Policy of a LUN.

Set-EmcVplexUnmaskLun
Unmasks a LUN to the specified VPLEX host.

Set-EMCXtremIOSnapshotScheduler
Updates the scheduler with the specified properties.

Set-EmcXtremIOTag
Renames the specified tag.

Update-EmcVnxAdvancedSnapshot
Updates the VNX advanced snapshot.

Powershell cmdlets host operations
Add-EmcHostDiskToCluster

Adds a disk to a cluster.
Clear-EmcHostDiskSignature

Clears the host disk signatures and assigns new ones.
Expand-EmcHostVolume

Expands the volume of a host.
Find-EmcHostDisk

Finds the ESI host disk associated with an ESI LUN, host LUN identifier, or VM disk
configuration on a host or cluster system.

Get-EmcAvailableDriveLetter
Gets the available drive letters on a host system or cluster system.

Get-EmcCifsNetworkShare
Gets the list of network shares used by a specified host.

Get-EmcClusterDisk
Gets the list of cluster disks.

Get-EmcClusterGroup
Gets the list of cluster groups.

Get-EmcClusterNode
Gets the list of cluster nodes.

Get-EmcClusterSystem
Gets connected cluster systems. A cluster system can be added to ESI using the
Get-EmcClusterSystemCredential and Connect-EmcSystem cmdlets.

Get-EmcHostBusAdapter
Gets the list of host bus adapters for the specified hosts.

Get-EmcHostDisk
Gets a list of host disk objects.

Get-EmcHostLunIdentifier
Gets the host LUN identifier.

Get-EmcHostSystem
Gets connected host systems.

Get-EmcHostVolume
Gets the list of host volumes.

Initialize-EmcHostDisk
Initializes a host disk by bringing the disk online and setting a specified partition
style in a host or cluster system.

New-EmcVolume
Creates a volume.

Remove-EmcHostDiskFromCluster
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Removes a disk from a cluster.
Remove-EmcVolumeMountPoint

Removes or unmounts the specified volume.
Set-EmcHostDiskOnlineState

Changes the online state of the specified disk.
Set-EmcHostDiskReadonlyState

Changes the read-only state for the specified disk.
Set-EmcVolumeMountPoint

Sets the drive letter or mount path for the volume.

Powershell cmdlets hypervisor operations
Add-EmcFileBasedDiskToVirtualMachine

Adds or attaches a file-based disk to a virtual machine.
Add-EmcPassthroughDiskToVirtualMachine

Adds or attaches a pass-through disk to a virtual machine.
Get-EmcAvailablePassthroughDiskCandidate

Gets available pass-through disk candidates to attach or add to a virtual machine for
a specified hypervisor.

Get-EmcAvailableScsiControllerLocation
Gets the list of available SCSI controllers for a virtual machine that you can use to
attach file-based or pass-through disks.

Get-EmcDatastore
Gets the list of VMware datastores.

Get-EmcESXCluster
Gets the list of VMware ESX clusters.

Get-EmcESXHost
Gets the list of VMware ESX hosts.

Get-EmcHyperVSystem
Gets the list of connected Hyper-V systems.

Get-EmcHyperVSystemCredential
Gets the credentials for Microsoft Hyper-V to connect ESI.

Get-EmcVcenterSystem
Gets the list of vCenter systems.

Get-EmcVirtualMachineScsiController
Gets the SCSI controllers from the virtual machine configurations.

Get-EmcVirtualVolume
Gets the virtual volumes for an ESX Hypervisor or a vCenter system.

Get-EmcVMwareSystemCredential
Gets the encrypted connection parameters BLOB or the system object creation
parameters for VMware systems. Use this cmdlet and the Connect-EmcSystem
cmdlet to add or connect storage systems to ESI. It creates a BLOB or encrypted
string by using the specified connection or system object creation parameters. ESI
prompts you for the server IP address and credentials and then uses these
parameters to create a BLOB. You can use the BLOB to connect or add VMware
systems to ESI by using the Connect-EmcSystem cmdlet. Click Test Connection in
ESI to test the connection with the specified parameters.

Get-EmcVirtualDiskConfiguration
Gets the virtual disk configuration for the specified host disk of a virtual machine,
which can be either a file-based or pass-through disk.

Get-EmcVirtualMachineConfiguration
Gets the virtual machine configuration.

Get-EmcVirtualMachineHypervisor
Gets the virtual machine hypervisor.

New-EmcFileBasedDisk
Creates a file-based disk for a specified hypervisor.
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New-EmcDatastore
Creates a new datastore.

Remove-EmcDatastore
Deletes the specified datastore.

Remove-EmcVirtualDiskFromVm
Removes a file-based or pass-through disk from the virtual machine.

Powershell cmdlets application operations
This section lists the cmdlets available for Microsoft Exchange and SQL Server.

Exchange operations

Get-EmcExchangeCmdletOutput
Gets results of some standard Microsoft PowerShell cmdlets for Exchange. This is
not an ESI cmdlet.

Get-EmcExchangeSystem
Gets information about the Exchange system.

Get-EmcExchangeSystemCredential
Gets the encrypted connection string or BLOB. You can use this cmdlet with the
Connect-EmcSystem cmdlet to connect or add host systems to ESI.

Get-EmcMailboxDatabase
Gets one or more mailbox database objects from a server, forest, or organization.

Get-EmcMailboxDatabaseCopy
Gets one or more mailbox database copy objects from a server or organization.

Get-EmcMailboxDatabaseCopyStatus
Gets the health and status information for one or more mailbox database copies.

Get-EmcMailboxServer
Gets the list of mailbox database servers. If no parameters are specified, it gets a
complete list of the mailbox servers in the entire organization.

SQL server operations

Add-EmcDatabaseToAvailabilityGroup
Adds one or more databases to given AlwaysOn Availability Group. This command is
used for adding a SQL Server Databases to an existing Availability Group.

Add-EmcReplicaToAvailabilityGroup
Adds a secondary replica to given AlwaysOn Availability Group. An Availability Group
can have up to four secondary replica. This command is used to add a secondary
replica to an existing Availability Group.

Get-EmcDatabaseAvailabilityGroup
Gets the configuration settings, status, and other information about a database
availability group (DAG).

Get-EmcSqlServerAvailabilityGroup
Adds a secondary replica to given AlwaysOn Availability Group. An Availability Group
can have up to four secondary replica. This command is used to add a secondary
replica to an existing Availability Group.

Get-EmcSqlServerDatabase
Gets databases present in given SQL Server. Lists down databases in a given SQL
Server Instance. For each database, details, including the data file path and log file
path, are shown.

Get-EmcSqlServer
Gets details of given SQL Server. This command shows the details of a given SQL
Server.

Get-EmcSqlServerCredential
Gets connection information. Prompts the user for the connection details and the
credentials required to connect to the SQL Server.

New-EmcSqlServerAvailabilityGroup

Managing storage with the PowerShell Toolkits

Powershell cmdlets application operations     175



Creates a new AlwaysOn Availability Group. This command creates a new SQL Server
AlwaysOn Availability Group with given details of Primary and Secondary Replica
along with databases to be added.

New-EmcSqlServerDatabase
Creates a new database in given SQL Server. Creates a new SQL Server database
with the given details such as name of the database, file paths for data file, and log
file.

Remove-EmcDatabaseFromAvailabilityGroup
Removes one or more databases from given AlwaysOn Availability Group. This
command is used for removing SQL Server databases from an existing Availability
Group.

Remove-EmcReplicaFromAvailabilityGroup
Removes a secondary replica from given AlwaysOn Availability Group. An Availability
Group can have up to four secondary replica. This command is used to remove a
secondary replica from an existing Availability Group.

Remove-EmcSqlServerAvailabilityGroup
Removes an Availability Group from given SQL Server. This command is used to
remove an AlwaysOn Availability Group from given SQL Server.

Remove-EmcSqlServerDatabase
Removes one or more databases from given SQL Server. This command is used to
remove one or more databases from given SQL Server.

Powershell cmdlets AppSync replication operations
Dismount-EmcAppSyncCopy

Dismounts a copy of a SQL Server database or an Exchange database for AppSync
replication in ESI.

Get-EmcAppSyncCopy
Gets the copies of SQL Server databases or Exchange databases according to the
specified criteria.

Get-EmcAppSyncExchangeDatabase
Gets the Exchange databases according to the specified criteria.

Get-EmcAppSyncExchangeServer
Gets the Exchange servers according to the specified criteria.

Get-EmcAppSyncManifest
Gets the manifest information of the specified AppSync system.

Get-EmcAppSyncRegisteredHost
Gets the hosts that are registered with the specified AppSync system.

Get-EmcAppSyncRegisteredRecoverPointSystem
Gets the RecoverPoint systems that are registered on the specified AppSync system.

Get-EmcAppSyncRegisteredStorageSystem
Gets the storage systems that are registered on the specified AppSync system.

Get-EmcAppSyncServicePlan
Gets the service plans according to the specified criteria.

Get-EmcAppSyncServicePlanSubscription
Gets the subscription information of the specified service plan.

Get-EmcAppSyncSqlServerDatabase
Gets the SQL Server databases according to the specified criteria.

Get-EmcAppSyncSqlServerInstance
Gets the SQL Server instances on the specified AppSync system.

Get-EmcAppSyncSystemAlert
Gets the alerts for the specified AppSync system.

Mount-EmcAppSyncExchangeDatabaseCopy
Mounts an Exchange database copy according to the specified criteria.

Mount-EmcAppSyncSqlServerDatabaseCopy
Mounts the SQL Server database copy according to the specified criteria.

Managing storage with the PowerShell Toolkits

176 EMC Storage Integrator for Windows Suite 4.1  Product Guide



New-EmcAppSyncExchangeDatabaseCopy
Protects the specified Exchange database by making a copy according to the criteria
set by the specified service plan.

New-EmcAppSyncServicePlanCopies
Runs the specified service plan and creates copies of applications that subscribe to
that service plan.

New-EmcAppSyncServicePlanSubscription
Subscribes the specified SQL Server database or Exchange database to the specified
service plan.

New-EmcAppSyncSqlServerDatabaseCopy
Protects the specified SQL Server database by making a copy according to the
criteria set by the specified service plan.

Remove-EmcAppSyncCopy
Expires or removes the specified SQL Server database copy or Exchange database
copy.

Remove-EmcAppSyncServicePlanSubscription
Removes the specified subscription.

Restore-EmcAppSyncExchangeDatabaseCopy
Restores the source Exchange database by using the specified copy.

Restore-EmcAppSyncSqlServerDatabaseCopy
Restores the source SQL Server database by using the specified copy.

Update-EmcAppSyncSystem
Updates the AppSync system by discovering applications.

Powershell cmdlets RecoverPoint replication operations
Add-EmcXtremIOConsistencyGroupVolume

Adds XtremIO volumes to a specified XtremIO consistency group.
Disable-EmcReplicaCopy

Disables a replica copy to stop the replication of that copy.
Disable-EmcReplicaCopyImageAccess

Disables a replica copy image access so that it is not available for mounting.
Replication changes are again propagated to the copy.

Disconnect-EmcReplicationService
Disconnects replication services.

Enable-EmcReplicaCopy
Enables a replica copy to start replication on that copy.

Enable-EmcReplicaCopyImageAccess
Enables a replica copy image access so that it can be available for mounting.
Replication changes are not propagated to the copy while image access is
enabled.When image access is enabled for replica snapshots, ESI automatically
uses the RecoverPoint Image Access mode of Logged Access. This mode ensures the
snapshot resides on the replica LUN and not the journal.

Get-EmcConsistencyGroup
Retrieves consistency groups that are used to protect LUNs.

Get-EmcReplicaCopy
Gets the list of replica copies that specify the copies within a consistency group.

Get-EmcReplicaCopySnapshots
Gets the list of snapshots for the specified replica copy.

Get-EmcReplicaLink
Gets the list of replica links that specify the replication connection and direction
between two replica copies within a consistency group.

Get-EmcReplicaLun
Gets the replica LUNs for replication.

Get-EmcReplicaSet
Gets replica sets that contain the LUNs for the replication of source LUNs.
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Get-EmcReplicationService
Gets the list of replication services. The replication service is the primary object for
managing replication clusters, sites, and systems.

Get-EmcReplicationServiceCluster
Gets the list of replication clusters, which contains all the replication sites and
systems in a replication service.

Get-EmcReplicationServiceCredential
Gets the encrypted connection string or BLOB. You can use this cmdlet along with
the Connect-EmcSystem cmdlet to connect or add replication services to ESI.

Get-EmcReplicationServiceSite
Gets the list of replication sites, which contains all of the replication systems in the
site.

Get-EmcReplicationSystem
Gets the list of replication systems. A replication system is an individual replication
appliance that performs and facilitates replication.

Get-EmcXtremIOConsistencyGroup
Gets the list of consistency groups for the specified XtremIO system.

Move-EmcProductionReplicaCopy
Performs a permanent failover to the specified replica copy, after which the copy
becomes the new production copy.

New-EmcBookmark
Creates a RecoverPoint bookmark for the specified consistency group.

New-EmcConsistencyGroup
Creates a new consistency group, which is a group of one or more replica sets.

New-EmcParallelBookmark
Creates a parallel bookmark for multiple consistency groups.

New-EmcReplicaCopy
Creates a new replica copy for a consistency group.

New-EmcReplicaLink
Creates a new replica link between two replica copies.

New-EmcReplicaSet
Creates a new replica set for a consistency group.

New-EmcXtremIOConsistencyGroup
Creates a new consistency group on an XtremIO system.

Remove-EmcConsistencyGroup
Deletes a consistency group and removes all associated resources for that
consistency group.

Remove-EmcReplicaCopy
Deletes a replica copy from a consistency group and removes and masks LUNs for
that replica copy.

Remove-EmcReplicaSet
Deletes a replica set from a consistency group and removes and masks LUNs for that
replica set.

Remove-EmcXtremIOConsistencyGroup
Deletes a consistency group from a specified XtremIO array.

Remove-EmcXtremIOConsistencyGroupVolume
Removes an XtremIO volume from an existing consistency group.

Set-EmcRecoverProductionCopy
Recovers the production copy by using the specified replica copy. This recovers the
production to correct file or logical corruption by rolling the production back to a
previous point-in-time.

Powershell cmdlets ESI Service operations
Add-EmcSystem

Registers storage systems with the ESI Service.
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Add-EmcUser
Adds an authorized user to the ESI Service. The ESI Service can only be accessed by
authorized users. This command adds a Windows user or security group with the
specified role to the ESI Service.

Disable-EMCServerCertificateValidation
Disables the server certificate validation when using SSL to communicate with the
ESI Service.

Enable-EMCServerCertificateValidation
Enables the server certificate validation when using SSL to communicate with the ESI
Service.

Get-EmcEntity
Gets one or more Entity objects from the Entity Graph of an ESI Service instance.

Get-EmcEntityClass
Gets the class names of entity objects in the Entity Graph of an ESI Service instance.

Get-EmcEntityRelationship
Gets one or more Entity relationship objects from the Entity Graph of an ESI Service
instance. An Entity relationship represents a directional link between two Entity
objects in an Entity Graph, where one Entity is the source and the other a target. This
command returns entity relationship objects that satisfy the specified parameters.

Get-EmcSecurityRole
Gets the security roles for the ESI Service.

Get-EmcServiceConnectionOptions
Gets the current options for connecting to the ESI Service. Returns the current
Service URL and other options for the ESI Service connection.

Get-EmcSystem
Lists all of the registered storage systems for the ESI Service.

Get-EmcSystemType
Lists all system types that are available for registration with the ESI Service.

Get-EmcUser
Gets the authorized users of the ESI Service.

Remove-EmcSystem
Unregisters (removes the registration of) a specified storage system with the ESI
Service.

Remove-EmcUser
Removes an authorized user from the ESI Service. This command removes a
Windows user or security group that has been granted one or more roles in the ESI
Service. It can remove a single role or all roles for a user.

Set-EmcServicePolicy
Sets the system refresh interval service policy for the ESI Service.

Set-EmcServiceUrl
Sets the URL to the ESI Service for the current session. By default, the commands in
the ESI Service PowerShell Toolkit connect to an instance of the ESI Service running
on the local host. This command allows you to specify a URL to another ESI Service
instance.
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Troubleshooting EMC systems and hypervisors
This section describes known problems and limitations for storage systems and
hypervisors.

Symptom Prevention, resolution, or workaround

ESI does not provision LUNs in
oversubscribed storage pools.

The ESI GUI does not support oversubscribed storage
pools. Use ESI PowerShell Toolkit to provision LUNs in
oversubscribed storage pools.

When a valid description is typed in the

Storage Pool Description field, the
description might not appear in the column

on the Storage Pool tab.

This is a known problem. The description display is for
more information and is not critical for system
operations.

l ESI fails to connect to Windows clusters
or failover clusters.

l ESI cannot create, delete, or disconnect
a cluster disk.

l Confirm that the clusters are healthy, which is an
ESI requirement.

l Before deleting or disconnecting a cluster disk,
remove disk resource dependencies.

Ping system timeout fails. Set the timeout value according to your network status
in ESI.

You are unable to connect to a Windows
server.

l Check that firewall rules are enabled on both
controller and controllee hosts.

l Check that remote PowerShell is enabled on both
controller and controllee hosts.

l Check that DNS is configured correctly.

Rescan fails to find a LUN. l Check that the FC Zoning is configured correctly.

l Check that the iSCSI initiator is logged in to the
target port.

l Check that the multipath software is configured
correctly.

l Storage-related data does not display in
the host view, cluster view, or
SharePoint view.

l The Storage pools in the create disk
wizard do not load and the wizard is
blank.

l ESI shows storage related information for a disk or
shared folder only when the corresponding
storage systems are registered. Verify that the
corresponding storage systems are registered with
ESI (under Storage Systems). If not, register these
storage systems.

l The storage system might be taking longer than
the default time-out value of 60 seconds. Set a
higher time-out value (in seconds) in the following
Registry key:
Key: HKLM\SOFTWARE\EMC\WSI
\Config
DWORD Value Name:
DefaultOperationTimeout
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Symptom Prevention, resolution, or workaround

One of the following error messages occurs:

l Unable to get host system
with given parameters.

l EmcVdsProxyService is not
available. The operation
'RemoveHostSystem' is
unsuccessful.
 

This might occur when trying to connect ESI to a
Windows host by using ESI PowerShell cmdlets that
are running within a remote PowerShell session. ESI
does not support running the cmdlets within a remote
PowerShell session on the ESI controller host.

l When a storage system is added to ESI,
it is not listed in PowerShell.

l When a storage system is added in
PowerShell, it is not listed in ESI.

Log out of the other application and then reopen it to
refresh the list.

PowerShell scripts from earlier versions of
ESI that use the Connect-EmcSystem
PowerShell cmdlet fail with the "Parameter
ConnectionName is needed to create the
Host System Object" error.

For ConnectEmcSystem, use ConnectionName
instead of HostSystemName for the Creation

parameter.

l The Set-EmcLunAccess PowerShell
cmdlet fails.

l An unmasking operation fails.

Before unmasking a LUN or using the cmdlet, ESI
requires that you register all iSCSI and FC HBAs or host
initiators used to unmask LUNs on the storage system.

Retrieval of host disks
failed: Operation
RefreshDisks failed on VDS
proxy... error occurs.

When the VDS load operation uses the target host
FQDN, this name resolution error occurs. To resolve
this error, you must configure the Windows host file on
the ESI controller host system with both the short
(NETBIOS) and long (FQDN) host names.

For XtremIO systems, errors occur when using
the following cmdlets:

l Get-EmcStorageRegisteredHost
l Get-

EmcStorageRegisteredInitiator
l New-EmcStorageRegisteredHost
l New-

EmcStorageRegisteredInitiator
l Remove-

EmcStorageRegisteredHost
l Remove-

EmcStorageRegisteredInitiator

ESI does not support using the ESI PowerShell cmdlets
related to registering hosts for XtremIO.

In ESI, right-clicking a tree node does not
display all the menu options.

This is the default behavior of the MMC framework.
Select an item, and then right-click to display the
menu options.

When creating a disk, ESI fails or creates the
incorrect volume size.

If you create a host disk and ESI fails or creates the
incorrect volume size, you might need to increase the
disk size.
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Symptom Prevention, resolution, or workaround

If the file system type is FAT32, provisioning
a storage volume fails.

FAT32 file system type for volumes is no longer
supported in this release.

When you specify both the -ID and -
ConcreteLun parameters together with the

Get-EmcLun ESI PowerShell cmdlet, an

AmbiguousParameterSet exception error
occurs.

The -ConcreteLun switch parameter specifies the

Concrete LUN type as an optional parameter, through
which only Concrete LUNs can be filtered out. Do not
use this parameter with the -ID parameter. This

parameter supports only block storage systems.

When you create a virtual hard disk or pass-
through SCSI disk for a virtual machine, no
IDE controllers are listed.

ESI does not support IDE-based disks. Use hypervisors
to create IDE-based disks.

For hypervisors, you cannot create new SCSI
controllers for virtual machines.

ESI does not support creating new SCSI controllers for
creating disks for virtual machines. Use the hypervisor
to create new SCSI controllers. Then use ESI to create
and attach the disks for virtual machines with these
SCSI controllers.

For hypervisors, the Connect to Host action
leads to the following error message: Can't
retrieve IP from MAC
address:… or host name is
empty.

Confirm the following:

l The virtual machine is a part of a reachable
domain.

l The supported Windows operating system is
installed on that virtual machine.

l The IP of that virtual machine is configured
correctly.

l The ESI-mandatory firewall settings are configured
correctly if you want to manage the virtual
machine in ESI.

For VMware, you cannot expand RDM disks
that are attached with virtual compatibility
mode.

For VMware systems, ESI does not support RDM disks
that are created with virtual compatibility mode. Use
ESI to provision disks without the virtual compatibility
mode setting.

For a VMware ESX host that is connected with
ESI to a virtual machine, when expanding a
file-based disk on the virtual machine, the
operation fails with an Access to
resource settings on the
host is restricted to the
server that is managing it
error message.

This is a VMware restriction for expanding file-based
disks, which requires the operation to only succeed
when only the vCenter host is connected and the ESX
host is disconnected from ESI. Try removing the ESX
host and adding the vCenter hypervisor again in ESI.
Then try the expand operation again.

For VNX systems, the local administrator

account status appears as Offline.

This occurs when a VNX storage array is added with a
global account without administrator rights or a local
administrator account, and the status is shown as

Offline. VNX systems require administrator accounts
with a global scope.

For VNX systems, unable to connect a host
disk.

If the VNX storage array does not have Access Logix
enabled, the host disk connection fails. VNX block
storage systems must have Access Logix enabled on a
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Symptom Prevention, resolution, or workaround

storage array before you connect a host disk on a
Windows host.

For VNX systems, advanced snapshot LUNs
can be viewed on the LUNs tab in the ESI GUI,
but are not listed in ESI PowerShell.

You can view advanced snapshot LUNs in the ESI GUI.
Even though the snapshots exist, you cannot currently
view the list with the Get-EmcSnapshotLuns
cmdlet.

For VNXe and Hyper-V, when you use the
New-EmcLun cmdlet to create a LUN for

Hyper-V, a "LUN does not exist" error occurs.

Update your VNXe system to version 2.3.1.20364.

For Unity and VNXe, a snapshot cannot be
promoted.

If the resource has no access to the snapshot, a
snapshot cannot be promoted for a host. Set up host
access to the snapshot, and then the snapshot can be
promoted for that host.

When adding a Unity or VNXe system, the
System cannot find the file
specified error appears when you click

Test Connection.

The Unity or VNXe Unisphere CLI is not available on the
controller host where ESI is running. Download and
install Unisphere CLI from the EMC Online Support
website.
After installing Unisphere CLI on the controller host, try
adding the system again.

When creating volumes for XtremIO, the

Login Status is Unknown on the LUN
Masking Settings page in the Create Disk
wizard.

ESI cannot display the port addresses for all zoned
storage system ports for XtremIO systems in the ESI
GUI.

Troubleshooting the ESI VMAX Adapter
This section describes known problems and limitations for the ESI VMAX Adapter.

Symptom Prevention, resolution, or workaround

When creating disks with the Create Disk wizard for
VMAX, no appropriate storage system
found appears as the only option on the Storage

System page.

ESI does not support provisioning disks for
host systems (VMware, Windows, and so on)
with only iSCSI initiators (HBAs) on VMAX
storage systems.

A Symmetrix system with serial not
found: 123400688 error occurs when you are

adding VMAX systems.

l When adding VMAX systems to ESI, if
you did not include the initial zeroes at
the beginning of the serial number, an
error will occur.

l Ensure that you include all of the
required twelve digits, which might
include a prefix of zeroes. For example:
000123400688.

Unable to apply a FAST VP policy to an existing storage
group.

Try binding the existing LUN or storage pool
in the policy storage tier with the Unisphere
SYMCLI commands or SMC.
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Symptom Prevention, resolution, or workaround

Fails to add a LUN to an existing meta, meta volume, or
composite LUN.

l Confirm that the LUN is bound.

l Confirm that the specified meta volume
is striped  and the correct size is
specified for the LUN.

The Expand-EmcLun cmdlet fails. l Check that the specified capacity is the
exact number of bytes for LUN sizes.

l For striped meta volumes, check that the
specified capacity is the exact multiple
for the stripe size.

The following tasks are not available:

l Cannot create, view, or remove snapshot LUNs in
ESI.

l When using the following ESI PowerShell cmdlets,
results are incomplete or incorrect:

n Get-EmcSnapshotLun
n New-EmcCandidateSnapshotLun
n New-EmcSnapshotLun
n Remove-EmcSnapshotLun
n Restore-EmcSnapshotLun

These tasks and cmdlets are not available,
because snapshot LUNs for VMAX systems
are not supported in this release. Support for
snapshot LUNs for VMAX is planned for a
future release of ESI.

Troubleshooting the ESI SharePoint Adapter
This section describes known problems and limitations for troubleshooting the ESI
SharePoint Adapter.

Symptom Prevention, resolution, or workaround

SharePoint provisioning fails when
you create a web application or a
SQL Server database in ESI.

l Verify the SQL Server authentication method and
try again. Integrated Security may be used instead
of SQL Authentication, or vice versa.

l Verify the username and password and try again.

l The provisioning wizard lists all SQL instances
that are installed on the server. Ensure that the
correct SQL instance is selected and that the
authentication mechanism matches.

SharePoint cannot connect to the
named instance when the named
and default instances are on the
SQL server to which SharePoint
connects remotely.

In a multi-server deployment where ESI and SharePoint
Central Admin are on a computer that is distinct from
the SQL server computer, ESI and SharePoint connect
to SQL Server remotely. If the SQL Server computer has
a named instance in addition to the default one, the
connection to the named instance may fail. To validate
the deployment scenario, ensure that SQL
Management Studio can connect remotely to the target
SQL Server instance.
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Symptom Prevention, resolution, or workaround

The recommended setup is to have the remote SQL
Server computer with either the default instance or the
named instance, but not both. If the SQL Server
computer must have both the default and named
instances, then SharePoint access should be limited
to the default instance.

ESI cannot open a farm. l Ensure that the SharePoint Foundation 2010 SP1
or SharePoint Server 2010 SP1 API is installed on
the ESI host computer.

l Verify that the SQL Server or configuration
database name are spelled correctly and try again.

l If the ESI Server cannot join the farm domain
controller because of an authentication failure,
verify the domain settings and try again.

l Verify that the network connection to the farm is
available and functioning and try again.

l Verify the SQL Server authentication method that
is used and try again. Integrated Security may be
used instead of SQL Authentication, or vice versa.

l Verify that the correct SQL instance is used. If the
farm is remote, the full SQL Server and instance
name is required in the same format used by SQL
Server.

Troubleshooting the ESI Exchange Adapter
This section describes known problems and limitations for troubleshooting the Exchange
Adapter.

Symptom Prevention, resolution, or workaround

During discovery of Exchange DAGs,
mailbox servers, or mailbox
databases, the assignment
statements are not
allowed in a
restricted language
mode or data section
error appears.

On the Exchange mailbox server that  connects to ESI,
you might need to set an application setting for
Windows PowerShell.
On the Exchange mailbox server, open the Internet
Information Services (IIS) Manager for Windows
PowerShell and in the Application Settings, and set

the PSLanguageMode to FullLanguage.

After changing the IIS setting, restart IIS to apply the

change. To restart IIS on the server, click Start > Run >

IISReset > OK.

Cannot locate the EDB file disk ID or
log folder disk ID.

Confirm that ESI can discover the storage LUNs by
adding the mailbox server as a host system in ESI and
enumerating host volumes with mount points as EDB
file and log folders.
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Symptom Prevention, resolution, or workaround

If the storage LUN information is not discovered, then
the storage system may need to be reconnected or the
connection refreshed in ESI.

Troubleshooting the SQL Server Adapter
This section describes known problems and limitations for troubleshooting the ESI SQL
Server Adapter.

Symptom Prevention, resolution, or workaround

ESI sets the virtual machine state as

Unknown and displays the following
connection message: Failed to
connect to one or more SQL
Servers.

This connection message occurs if ESI scans a server
and the firewall is blocking the ESI connection or you
are not authenticated to access the SQL Server
instance. If you select to add the unknown instances,
the servers with no detected SQL Server instances are

listed as Unknown in ESI.

When you add a SQL Server database to an
availability group, the following error occurs:
Cannot drop the database
database ID, because it does
not exist or you do not have
permission."

l Confirm that the ESI host is connected with the
correct permissions.

l You might have specified a local path for the

Shared Network Location field. Shared Network
Location must be a Universal Naming Convention
(UNC) path.

When you modify auto-generated T-SQL for
bulk-create databases, ESI does not display
a successful completion message.

ESI might not display any messages when you modify
auto-generated T-SQL in ESI. This is a known issue that
does not require a workaround.

Troubleshooting the ESI RecoverPoint Adapter
This section describes known problems and limitations for troubleshooting the ESI
RecoverPoint Adapter.

Symptom Prevention, resolution, or workaround

When enabling image access to a replica
copy, the following error appears: The
specified replica copy has
no valid snapshot, which is
required to enable access to
the copy.

Check that the replica copy is enabled, and that the
link state is in an active state.

After failing over to a remote replica copy,
when enabling the replica copy that used to
be the local copy, the at least one
of the enabled replica
copies doesn't have a

Manually create a link from the new production copy to
the copy that used to be the local copy. You can do
this with the New-EmcReplicaLink PowerShell
cmdlet.
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Symptom Prevention, resolution, or workaround

defined link to the
production copy error appears.

When using VMAX with the Exchange
Integration, after adding a mailbox database
copy on the remote site and adding
subsequent copies, the device is
involved in a RecoverPoint
Rcopy session and cannot be
modified" or "a specified
device is involved in a
Remote Copy session and
cannot be modified errors might

appear.

The copies are in a RecoverPoint session, so the SMI-S
provider prevents all write operations. Do one of the
following:

l Use the ESI GUI or PowerShell Toolkit to disable
the replica copy manually, add the copies on the
remote site, and then enable the replica copy. For
other subsequent copies, repeat these steps.

l Alternatively, only add subsequent copies on the
local site and maintain only one remote copy on
the remote site.

Troubleshooting the ESI Service and ESI SCOM Management
Packs

This section describes known problems and limitations for troubleshooting the ESI
Service and ESI SCOM Management Packs.

Symptom Prevention, resolution, or workaround

When upgrading to the latest version of the
ESI SCOM Management Packs, reimporting
the management packs in SCOM fails.

When upgrading, SCOM requires that you delete the
existing ESI version 2.1 SCOM Management Packs
from SCOM before you can install and import the latest
version of the SCOM Management Packs. Installing the
ESI SCOM Management Packs on page 143 provides
instructions.

After upgrading ESI and importing the latest
version of the ESI SCOM Management Packs,
your override settings for the ESI SCOM
management packs no longer exist in SCOM.

The EMC.SI.Customization.xml management pack file
contains your SCOM overrides and customizations.
When importing the management packs into SCOM,
you might have overridden this file and lost your
settings.
You can reimport the latest backup copy of this file to
retrieve your customizations.

Note

This file is installed with version number 1.0.0.0. You
can increment the version number when you make
changes.

How to Import a Management Pack in Operations
Manager 2007 and How to Import an Operations
Manager Management Pack on Microsoft TechNet
provides instructions for importing the management
packs.

After upgrading ESI,
EMC.WinApps.Service.Director

If you are using AD or AD LDS, you might not have
unpublished all systems from the ESI Service before
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Symptom Prevention, resolution, or workaround

yServicesSystemDb.* errors occur in

your ESI Service event log.

upgrading. Clean up the AD container used for the ESI
Service, restart the service, and then republish the
systems to the ESI Service.

SCOM degrades the health state of the
snapshot pool for reserved LUN pools of VNX
block systems, regardless of the true health
state of the reserved LUN pool in Unisphere,
which causes a warning error and generates
an alert.

Unisphere does not provide an operational status for
reserved LUN pools, so SCOM defaults to "unknown"
for the health state of the snapshot pool. This
unknown state in SCOM degrades the health of the
system, which generates an incorrect warning error
and alert in SCOM.
Disable the health monitor for the snapshot pools in
SCOM to avoid this incorrect warning error and alert. 
How to Enable or Disable a Rule or Monitor on
Microsoft TechNet provides instructions.

l SCOM does not discover or monitor
some or all system components.

l Event 104 appears in the SCOM agent
event log, which includes basic
connection information and an HTTPS
link to EMC SI Service that cannot be
completed.

l EMC SI Service Discovery in SCOM
cannot connect to the ESI Service, or the
connection time is unacceptable.

l Workflow processes are timing out.

l Confirm that the firewall settings are correct for
both the SCOM agent and ESI Service.

l Enable and use EMC SI Windows Service
Monitoring to confirm that the ESI Service is
running on the ESI host.

l Open this link on the SCOM Agent machine:
https://ESI Service IP:https port/esi/console/
graph/Entities?class=StorageSystem, replacing
ESI Service IP and https port with the applicable
values. Then confirm that the load time displayed
at the bottom of the page is less than one second.
Repeat this step a few times for consistent results.

l Confirm that the SCOM agent connects
successfully with the ESI Service. The connection
information and link are provided in Event 104.
Use the credentials specified in
Setting up the EMC SI Monitoring Profiles for the
SCOM agent on page 145.

Open the HTTP link provided in the Event 104
description and confirm that the event completes
in less than two minutes. If the connection fails,
investigate the cause and update EMC SI
discovery overrides accordingly. Changing the
discovery interval overrides on page 156 provides
more details for changing the overrides.

l The list of physical or logical
components displayed in the views is
not current.

l SCOM does not discover new system
changes.

If the components do not appear after the set interval

refresh time has passed, clear and reset the Enabled
override properties setting for the EMC SI Service
Discovery in SCOM:

1. Open the EMC SI Service Discovery Overrides
Properties window.

2. Clear the check box for the Enabled override

setting and click Apply.

3. Select the Enabled check box again.

This override change triggers the discovery process.
Check the Operations Manager event log on the SCOM
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Symptom Prevention, resolution, or workaround

agent for two sequences: Event 1201 followed by

Event 1210. If these occurred, then the discoveries
should be current.

The Subscribed Capacity Presentation
view in SCOM does not display the system
serial numbers.

Create a group for each system and a favorite view for
the group:

1. In Operations Manager, go to Authoring >

Groups > Create a new Group, enter a name,

and select EMC Storage Integrator
Customizations management pack to save
changes.

2. Select Dynamic Members > Create/Edit rules
and select EMC SI Storage System > Add.

3. Select Serial Number Equals serial number and

click Create.

4. To create a view for the group, select My
Workspace > Favorite Views > New >

Performance View. Type a name for the view and

select collected by specify rules > Storage
Pool Available Capacity Performance
Collection and click Create.

Only the pools of the specified systems are displayed.

l Updates for the component health status
take more than 40 minutes to update in
the SCOM views.

l Long delays exist between changes in
health of components and the changes
being updated in SCOM views.

l Confirm that the related SCOM agent is running
without performance problems. If errors occur,
troubleshoot them as described in the previous
resolution.

l Reduce the ESI Service System Refresh Interval,
which is set to 30 minutes by default. Changing
the system refresh interval on page 156 has more
details.

l Reduce the Interval override for monitors that
experience latency, which by default is set to six
minutes.

l Changing discovery interval overrides on page 156
has more details.

One or more systems do not appear in the
SCOM view and are not discovered by SCOM.

l Confirm that the related SCOM Agent successfully
connects to the ESI Service.

l Confirm that the system is registered with the ESI
Service.

l Confirm that the System Filter file exists on the
related SCOM agent and has the correct list of ESI
Service Registered System Friendly Names.

l SCOM agent is experiencing
performance problems due to a large
number of monitored component
instances.

Increase the local data queue on the SCOM agent
machine by updating the Registry key:
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Symptom Prevention, resolution, or workaround

l List of discovered components is not
complete. Health state of components is
not current and other suggestions do not
work.

l Event 6022 from the Health Service
Script does not appear in the Operations
Manager event log on the SCOM agent
machine for more than 15 minutes.

l Performance counters related to the CPU
or memory usage are typically hitting the
maximum limits.

l Event 21411 from the Health Service
modules appears and includes the
"process will be dropped because it has
been waiting in the queue for more than
10 minutes" message.

l Event 1101 from the Health Service
appears multiple times in the Operations
Manager Event log on the SCOM agent
computer.

1. Replace <MG> with the SCOM management group
name and size, which can be between the default
15360 (15 MB) and 102400 (100 MB):
HKEY_LOCAL_MACHINE\SYSTEM\Current
ControlSet\Services\HealthService\Parameters\

Management Groups\<MG>
\MaximumQueueSizeKb

2. Restart the HealthService.

Try the Flush Health Service and Cache task. To do
this:

1. In Operations Manager, go to Monitoring >

Operations Manager > Agent-Details > Agent
Health State. In Agent State view,  click the
SCOM agent machine.

2. In the Health Service Tasks section of the

Actions pane, run the Flush Health Service and
Cache task.

Adding resources to share the monitoring can improve
data and I/O performance for large storage
environments. Add more SCOM agents or more ESI
Services to share the monitoring of multiple systems
with heavy traffic. With more than one SCOM agent to
monitor one or more ESI Services, you can assign
fewer systems to each SCOM agent or each ESI
Service. Use the System Filter file to assign systems to
different SCOM agents.

Sample event logs on page 193 can also provide
assistance with diagnosing issues.

l SCOM agent changes to a gray state or
the discovery is not complete within an
acceptable time.

l Too many LUN masking views are being
discovered.

l SCOM does not discover all of the
storage groups.

l The system has more storage groups
than SCOM discovers.

The discovery override for the EMC SI Storage Group
limits the number of discovered instances in SCOM.
Confirm that the override has the correct limit.
The maximum limit for this override is 5000. To
improve performance, change the discovery override
to a smaller number.

l The ESI Service or the SCOM agents have
connection problems.

l Time-out error message Event 104 or
Event 21402 occurs.

Check the Operations Manager event log for any
events and connect to ESI Service from a web browser
on the SCOM agent computer. Refer to Changing HTTP
connection defaults on page 136 for more details.
Sample event logs on page 193 include an Event
21402 log example.

Proxy Monitoring is not available (grayed out)
in Operations Console and Event 623 occurs
in Operations Manager.

If the Proxy Monitoring agent is monitoring systems
with a large number of components, distribute system
monitoring to more proxy agents . Alternatively, make
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the registry change as described in One or more
management servers and their managed devices are
dimmed in the Operations Manager Console of
Operations Manager.

SCOM does not discover a VPLEX system. Check event logs for ESI Service errors and also
confirm the following:

l SCOM Management Pack is set up with the correct
ESI Service host and SSL port 54501.

l ESI Service is running.

l The user is in an administrator group (if UAC is
enabled, the web browser must be launched with
Run As Administrator).

l The remote connection to ESI Service uses one of
the following:

n http://<host>:54500/esi/console

n https://<host>:54501/esi/console

l The firewall settings are correct for both the SCOM
agent and ESI Service.

l The SSL Certificate on the ESI Service host is set
up correctly: Get-ChildItem cert:\LocalMachine\My

l The latest service packs and cumulative updates
are deployed on the SCOM agents and clients.

l SCOM server and agent systems meet the
minimum system requirements.

Event 21114 occurs in the Operations
Manager event log.
 

Confirm that HKLM\System\CurrentControlSet
\Services\HealthService\Parameters
\Persistence Version Store Maximum has

been changed to 5120 (decimal).

A VPLEX system does not appear in SCOM for
the SCOM monitoring agent.

Check the event log for event 104 and confirm that the
ESI Service connection information is set up correctly
in SCOM.

VPLEX discovery times out. l The SCOM agent might be monitoring too many
systems. Check the event log for events: 6024,
2114, 21402.

l Use the System Filter file to assign systems to
specific SCOM agents.

Sample event logs
The key information is highlighted as bold text in the following event log examples. The
events generated from the monitoring agent Operation Manager event log and alerts are
also added to the Monitoring Delays, Errors and Timeouts view in the Diagnostics folder.

The following is an example of an event log with connection problems. In this example,
Event 21402 occurred because of a disk drive component problem. By locating the
problem component class, you can then decide which component monitor to
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troubleshoot and maybe change that specific time-out interval override while resolving
the problem:

Log Name:      Operations Manager
Source:        Health Service Modules
Date:          9/19/2012 1:24:59 PM
Event ID:      21402
Task Category: None
Level:         Warning
Keywords:      Classic
User:          N/A
Computer:      PATHENDGSCOM.PATHENDG.emc.com
Description:
Forced to terminate the following process started at 1:24:43 PM
because it ran past the configured time-out 600 seconds.
Command executed:    "C:\Windows\system32\cscript.exe" /nologo
"GetEntityStatus.js" 10.5.222.40 7001
c85793d1108ee9f4c30a970941593d7c966a2748 DiskDrive none none
True True false 0
Working Directory:   C:\Program Files\System Center Operations
Manager 2007\Health Service State\Monitoring Host Temporary
Files 1\126109\
One or more workflows were affected by this. 
Workflow name: many
Instance name: many
Instance ID: many
Management group: JerryAir
The following is an example of an event log that has overloaded resources:

Event 21411
Level Warning
Source Health Service Modules
The process will be dropped because it has been waiting in the
queue for more than 10 minutes.
Command executed:       "%windir%\system32\cscript.exe" /nologo
"DiscoverLunStorageServiceNode.js" {934DBB77-5CDA-4EF8-
E2D5-37DE605B11A9} {A86B6475-C74D-7AF0-1B69-AEA88050B9EF}
ZBSCOM2007.ZBEMC.dev 10.5.222.40 7001
3f08b7000dc65c9f29417af195d75cac12f5ea3e
6bec6ca7f35635f45d6d5f54c6e4d7996f3e37b8 none none True False 0
Working Directory:         
One or more workflows were affected by this. 
Workflow name: EMC.ESI.LunStorageServiceNodeDiscoveryRule
Instance name: Bus 1 Enclosure 1
Instance ID: {A86B6475-C74D-7AF0-1B69-AEA88050B9EF}
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Management group: ZBDEV

Troubleshooting Active Directory Services
This section describes known problems, limitations, or suggestions for troubleshooting
the use of Microsoft Active Directory Domain Services (AD DS) and Active Directory
Lightweight Directory Services (AD LDS) with applications supported by ESI.

Symptom Prevention, resolution, or workaround

The following error occurs when you add systems to
ESI Applications that use AD LDS:
ERROR:

EMC.WinApps.Fx.Common.Directory.EsiDirectoryExcep
tion: Protocol = 'Ldap', Result = 'NotExist'.
NoSuchAttribute 00000057: LdapErr: DSID-0C090D11,
comment: Error in attribute conversion operation, data
0, v23f0 -
System.DirectoryServices.Protocols.DirectoryOperatio
nException: The requested attribute does not exist.

Confirm that you configured the AD LDS
instance schema with msDS-App-
Configuration and msDS-Settings. If not, 
extend the AD LDS instance on page 28 to
get these, and retry the operation.

The following error occurs when you add systems to
ESI Applications that use AD DS:
ERROR:

EMC.WinApps.Fx.Common.Directory.EsiDirectoryExcep
tion: Protocol = 'Ldap', Result = 'NotExist'.
NoSuchObject 0000208D: NameErr: DSID-03100213,
problem 2001 (NO_OBJECT), data 0, best match of:
'DC=EMC,DC=Storage,DC=Integrator,DC=COM' --->
System.DirectoryServices.Protocols.DirectoryOperatio
nException: The object does not exist.

l For ESI, MMC, and the ESI PowerShell
Toolkit, confirm the container for the
user exists.

l For ESI Service, confirm a container
exists for each ESI Service machine
name.

l Confirm that ESI has read and write
permissions for the container and it is
accessible to ESI.
Setting up Directory Services integration
for ESI applications on page 28 provides
details.

ESI logs
ESI log details include the following:

l ESI Controller Default log location: C:\Users\administrator.ESIAD
\AppData\Local\EMC\ESI\Logs

l Default log level: Verbose (Valid log levels: Verbose, Information, Warning, Error,
Critical )

l Log level settings: C:\Program Files\EMC\EMC Storage Integrator\
EMC.WinApps.GUI.Mmc.dll.config

l To change the log level, edit the initializeData parameter as shown in the Log level
setting.
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Figure 4  Log level setting

EMC Sales and Customer Service contacts
EMC support, product, and licensing information can be obtained as follows:

l Product information: For documentation, release notes, and software updates, or for
information about EMC products, licensing, and service, go to EMC Online Support
(registration required).

l Technical support: Go to EMC Customer Service on the EMC Online Support website.
To open a service request through EMC Online Support, you must have a valid
support agreement. Contact your EMC sales representative for details about obtaining
a valid support agreement or to answer any questions about your account.
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